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Avertissement/Warning: 

Ce document électronique est soumis aux droits d'auteur et aux droits de la propriété intellectuelle, sous les 
conditions particulières suivantes : 
- La reproduction de ce document est libre, sans aucune modification ni altération du texte qui ne serait pas 
préalablement soumise et acceptée par l'auteur. La gratuité de la reproduction et de la distribution est 
intangible. 
- Il est interdit de publier ou distribuer ce document sous une forme différente. Seule la forme électronique est 
autorisée. 
- L'impression papier à titre privé est autorisée. 
- La traduction de ce document est autorisée, pour toutes les langues, sous les mêmes conditions, et sous la 
réserve de communiquer un exemplaire de la traduction à l'auteur. 
- Le nom de l'auteur doit être cité même pour un court extrait, quelle que soit la langue utilisée. 
- Ce document ne peut faire l'objet d'aucune transaction commerciale ni d'inclusion partielle dans un autre 
document qui ne suivrait pas les mêmes conditions particulières, et qui n'aurait pas l'approbation de l'auteur.  
- Ces conditions particulières doivent être reproduites in extenso en tête du document, sous la rubrique 
"Avertissement" en français et dans la langue où ce document est traduit. 
- Seul le texte français fait foi. 
- L'auteur, les correcteurs, les traducteurs, ne sauraient être liés aux dommages directs et indirects que 
pourrait, pour quelques raisons que ce soit, entraîner l'utilisation de ce Guide. L'utilisation de ce Guide se fait 
toujours aux risques et périls de celui qui suit les procédés décrits dans ce Guide. 
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Préambule 

Il existe mille et une façons de créer un aéroport pour Condor 2, nous vous proposons une méthode 
sûre et efficace, déduite de l'expérimentation, avec le modeleur Wings 3D, basée sur la réalisation 
d'un aéroport qui sera intégré dans la version 1.0 de AA2. 
 
Si vous n'avez jamais réalisé d'aéroports et que vous êtes tenté de vous lancer dans la construction 
d'un ou de plusieurs aéroports particuliers que vous connaissez bien, car vous avez décollé de ceux-
ci, pour effectuer, dans la vraie vie, des parcours en campagne, ce tutoriel est fait pour vous. Si vous 
n'y connaissez rien, mais que vous voulez aider la communauté Condor, ce tutoriel vous permettra 
de construire pas à pas votre premier aéroport. Si vous êtes déjà un expert dans ce domaine, vous 
trouverez certainement quelques bonnes idées pour améliorer votre expertise, car nous avons tenté 
d'être aussi exhaustifs que possible. 
 
Pour ceux qui ont la maîtrise d'un autre modeleur 3D comme, Blender ou 3DS Max, pour lesquels il a 
été démontré que la conversion en "Wavefront" était fiable pour créer les fichiers c3d d'un aéroport, 
ce tutoriel leur donnera toutes les informations nécessaires pour réaliser un aéroport pour Condor 2 
avec leur modeleur préféré. 
 
Le choix de l'aéroport s'est fixé sur "LOKL Lienz-Nikolsdorf" pour la scène AA2 (UTM 32 N) avec 
l'approbation de Michel Bernard, alias DGTFER, qui se chargera de l'intégration et des tests et qui a 
participé à la correction de ce tutoriel. 

Outils 

Bien évidemment, il faut être relié à Internet pour accéder aux différents logiciels gratuits et aux 
données sur l'aéroport que l'on souhaite modéliser. 
 
Il faut télécharger depuis le forum international le "Condor Landscape Toolkit" CLT 1 et le déployer 
sur votre ordinateur, dans un répertoire adéquat dont le nom ne doit comporter aucun espace ni 
caractère spéciaux (Ex. : Condor2Outils) : 
 
http://www.condorsoaring.com/downloads-2/ 
 
Nous utiliserons principalement "Landscape Editor" et "Object Editor". 
 
et pour la modélisation, nous utiliserons "Wings 3D", qui est téléchargeable ici : 
 
http://www.wings3d.com/?page_id=84 
 
Où, nous choisirons la dernière version stable. Ce tutoriel a été réalisé avec "Wings 3D 2.2.4". 
 
Il faut aussi un logiciel de dessin 2D comme "Photoshop" (dès la version CS2), ou "The Gimp", ou 
"Paint.Net" de façon à pouvoir appliquer des textures ou des couleurs sur les cartes des Textures.  
Nous avons utilisé Photoshop CS6, mais les autres choix gratuits sont tout aussi performants, et 
permettent d'effectuer toutes les tâches requises. 
 

http://www.condorsoaring.com/downloads-2/
http://www.wings3d.com/?page_id=84
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Beaucoup de textures gratuites se trouvent sur Internet, il suffit de les chercher. Utilisez des textures 
sans couture ou appliquez des photos sur les façades des hangars de l'aéroport. Mais n'omettez pas 
de citer, ou de faire citer, vos sources dans le "Read me" de la scène. 
 
Enfin, un logiciel de capture d'images comme "Outil Capture" de "Windows" ou "Snagit" est aussi 
nécessaire pour enregistrer des images et des plans afin de pouvoir les intégrer dans la création de 
l'aéroport comme support ou décor. 
 
"Google Earth" est une source de documentation fondamentale pour réaliser un aéroport, pour 
Condor 2. 
 
En dernier lieu, l'utilisation de "Qgis 2.18.24" et "Qgis 3.6" peut s'avérer nécessaire pour adapter les 
plans à la projection UTM de la scène où sera inséré l'aéroport, et aussi pour accéder à des 
informations détaillées sur les bâtiments si elles ont déjà été enregistrées dans la base de données. 
Les versions de Qgis sont téléchargeables ici : 
 
https://www.qgis.org/fr/site/ 
 
Ce manuel ne comporte pas d'apprentissages sur ces différents logiciels, si ce n'est des généralités, 
sauf pour les débutants utilisant Wings 3D. Mais chaque phase de la construction sera suffisamment 
détaillée et illustrée pour vous permettre d'accomplir les tâches nécessaires à la réalisation d'un 
aéroport. 

Objectifs et Préalables 

L'objectif de ce tutoriel est de construire un aéroport suffisamment détaillé pour permettre aux 
habitués des lieux de reconnaître immédiatement leur aéroport, et de l'agrémenter de petites scènes 
avec des objets statiques (arbres, planeurs, engins, personnages) pour le rendre plus vivant. La seule 
limite du niveau de détail (LOD), une fois l'aéroport fini et intégré dans la scène, réside dans une 
simulation dans Condor 2 fluide et sans saccade. Le nombre de FPS que pourra supporter une 
configuration moyenne du type Intel I3 avec une carte graphique GTX 750 Ti reste le critère de base. 
Dans ce cas, en mode multijoueurs, le nombre de FPS devra impérativement être supérieur à 60 et 
de préférence au-dessus de 80. 
 
Comme le nombre de FPS dépend aussi de la Carte des Forêts, et que la configuration détaillée des 
zones forestières autour de l'aéroport est un élément important de la reconnaissance visuelle des 
lieux, il faudra nécessairement faire des compromis, malgré les excellentes performances graphiques 
de Condor 2, avec DirectX11. 
 
Voici les étapes à réaliser qui seront reprises en détail dans les chapitres suivants : 
 
1/réunir une documentation solide avec des plans corrects. 
2/créer l'aéroport dans Landscape Editor. 
3/disposer les Plans et les mettre à l'échelle, pour Wings 3D. 
4/créer les éléments de surface de l'aéroport, ils sont limités à ces 4 objets intégrés dans Condor2 : 
"Grass" (Herbe), "Asphalt" (Asphalte), "Asphaltpaint" (Signalisation sur l'asphalte), "Grasspaint" 
(Signalisation sur l'herbe), mais, cela, n'empêche pas d'intégrer dans "Asphaltpaint" des balises en 
3D. 
5/créer les bâtiments, les hangars, la tour de contrôle, etc. de l'aéroport. 

https://www.qgis.org/fr/site/
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6/exporter en Wavefront (.obj). 
7/transformer en C3d et lier les textures.  
8/intégrer l'aéroport dans la scène avec "Landscape Editor". 
9/les améliorations. 
 
Mais avant de commencer la construction de l'aéroport, il faut avoir une connaissance succincte : 
- des répertoires du simulateur de vol Condor 2, et ceux afférents à une scène.  
- des objets dans Condor2. 
- du fonctionnement de Condor 2 en matière d'aéroport et du ballet des remorqueurs. Cela vous 
aidera à faire les bons compromis, surtout pour des terrains situés dans des vallées étroites. 
- de Wings 3D avec la création de primitives structurées et de raccourcis clavier adaptés à la 
construction des aéroports. 

Dossiers de Condor 2 et dossiers afférents à une scène 

Voici un extrait de l'arborescence de Condor 2 : 
 

Deux dossiers intéressent la construction des aéroports : 
 

- Le dossier "World" (Le Monde) : regarder sans toucher ni modifier les sous-dossiers "Objects" et 
"Textures". Ce dossier "World" à la racine de Condor2 ne doit pas être confondu avec le dossier 
"World" se trouvant dans chaque scène.  
 
- Le dossier "Landscapes" où sont rassemblées toutes les scènes. 

 
Chaque scène a la même structure de répertoires et les mêmes fichiers : 
 
Voici le répertoire de la scène WildAlps2 en cours de construction : 
 
 

Figure 1 - Répertoire Condor2/Condor2 Folder. 
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Figure 2 - Répertoires d'une Scène/Scenery Folder. 

Figure 3 - Répertoire Airports/Airports Folder. 
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Deux répertoires et un fichier intéressent la création d'aéroports : 

- Le dossier "Airports" dont voici le détail : 
 

- Les 2 fichiers LSGR_Reichenbach G et O ouverts dans Object Editor. 
Cet aéroport est déjà intégré dans la scène AA2 version 0.5. 

 

"Object Editor" est un bon moyen de contrôler que les objets et les textures sont correctement liées, 
lorsqu'on charge un fichier C3D à partir du répertoire de la scène. 
 
 
 

Figure 4- Reichenbach : Fichier G/G File. 
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Figure 6 - Reichenbach dans AA2/Reichenbach in AA2. 

Figure 5 - Reichenbach : Fichier O/O File. 
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Reichenbach dans AA2 et dans WildAlps2. C'est exactement la même modélisation pour les 2 
aéroports. 
 

 
Figure 7 - Reichenbach dans WildAlps2/Reichenbach in WildAlps2. 

- Dans le dossier "World" de la scène, vous trouverez généralement deux dossiers : 
* Un dossier "Objects" où sont rassemblés tous les objets courants de la scène au format C3D. 
* Et un dossier "Textures" où sont rassemblées les textures des objets courants de la scène. 
 

Cette configuration et la dénomination de ces dossiers sont arbitraires, mais c'est devenu un 
standard de Condor 2. Bien évidemment, il ne faut pas les confondre avec le dossier "World" à la 
racine de Condor 2. 
 
Toutefois, on peut également mettre les textures des objets dans un sous répertoire de "Objects", 
afin d’avoir une indexation relative, qui simplifie le portage des objets d’une scène vers une autre. Il 
ne sera plus alors nécessaire de corriger les chemins d’accès. Pour autant, il faudra mettre les 
textures qui pourront remplacer les textures génériques de condor (les textures des forêts) dans un 
répertoire "Textures" situé dans le dossier "World" de la scène. 
 
Tous les objets en C3D peuvent être visualisés et édités dans Object Editor. Il est alors possible pour 
chaque ligne d'attribuer directement une texture à l'objet, liée à la carte du patron (UV Map) 
correspondante. On peut alors choisir le format (DDS, PNG, BMP, TGA) et les dimensions de la 
texture carrée de l'objet que l'on désire, par exemple 1000 x 1000 pixels sans être enfermé dans les 
dimensions multiples de 2n que propose Wings 3D. 
 
Ce petit tour dans les dossiers de Condor2, vous montre comment organiser votre travail lorsque 
vous allez réaliser un aéroport et le tester dans une scène, puis le partager : 
 

- Mettre les textures des bâtiments d'un aéroport dans un dossier dont le nom rappelle celui de 
l'aéroport, dans le dossier "Airports". 
 
- Pour les objets courants, créer un dossier "World" propre à la scène et créer deux sous-dossiers : 

* "Objects", pour les fichiers des objets en "C3D". 
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* "Textures", pour les textures des objets précédents. 

 
Ou choisir la formule "World/Objects/Textures" pour mettre les textures de l'objet. 
 
"Object Editor" vous permettra de créer rapidement les chemins d'accès vers les textures de l'objet. 
Examiner en détail la colonne "Texture" dans l'exemple ci-dessus. 
 
Enfin, l'accès au fichier de la liste des aéroports (Nom_Scene.apt) se fait simplement dans Landscape 
Editor, nous y reviendrons plus loin, bien que des utilitaires aient été créés à cet effet. 

Objets avec Condor 2 

Les objets de toute nature se construisent dans un modeleur 3 D avec des textures appropriés, issues 
des cartes du patron (UV Map). Ils peuvent être orientés et mis à l'échelle pour chaque instance de 
l'objet dans Landscape Editor. Tous les objets courants d'une scène font l'objet d'une base de 
données qui correspond au fichier "Nom_Scene.obj" de la Scène. 
 
Il existe deux types d'objets utilisables avec Condor 2, après exportation et transformation au format 
C3D : 
 
- l'Objet Standard, dénommé "Scene Object" (objet de scène), est composé d’un seul objet 
pouvant regrouper plusieurs objets qui ont été combinés en un seul objet dans le modeleur 3D. En 
fin de compte, une seule texture par objet standard est acceptée par Condor 2. Cette texture unique 
regroupe toutes les cartes de textures de chaque objet précédemment combiné. Il est souvent 
nécessaire d’effectuer une réorganisation des éléments (îlots) de la carte du patron pour qu’ils ne se 
chevauchent pas sur la carte de texture finale. Les cartes de textures peuvent comprendre aussi 
d’éventuelles parties semi-transparentes, si l'on utilise des fichiers "TGA", "PNG" ou "DDS". Dans 
"Object Editor", l’éditeur d’objet C3d de Condor 2, il n’y aura qu’une seule ligne. 
 

 
Voici un Objet Standard plus complexe avec des parties transparentes intégrées à la texture : 
 

Figure 8- Objet Standard/Scene Object. 
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C'est toujours un objet standard avec une seule texture. 
 
- l'Objet de Scène, dénommé "Landscape Object" (objet de paysage), est une collection d’Objets 
Standards ou de Scène qui est exportée en "Wavefront" sans que les objets qui le composent soient 
combinés en un seul objet. Le nombre de textures de l’Objet de Scène est donc la somme de toutes 
les textures des Objets Standards et des Objets de Scène qui le compose. Dans "Object Editor", 
l’éditeur d’objet C3d, il y aura pour un Objet de Scène autant de lignes que de textures nécessaires à 
sa visualisation, dans la simulation.  
 
Les Objets de Scène permettent donc de regrouper des objets pour former des petites scènes. 
 
Les Objets de Scène servent de conteneur à des Objets Standards et/ou à des Objets des Scènes. 
Dans un Objet de Scène, le positionnement (coordonnées et orientation) des objets est fixé de façon 
permanente pour faire une petite scène. Il est donc alors possible de manipuler ceux-ci globalement. 

 
 

Figure 9- Objet Standard avec Transparences/Scene Object with Transparencies 

Figure 10 - Objet de Scène/Landscape Object. 
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Figure 11 - Image épinglée/Snaped Image. 

Toutefois, lors de la création d'un Objet de Scène dans le modeleur, lorsqu'on va fusionner un autre 
Objet de Scène, il faudra prendre des précautions lors de l'orientation de l'objet de scène inclus qui 
devra être préalablement combiné par un "Combine" et une fois orienté, divisé par un "Separate". 
Des recombinaisons partielles devront probablement être effectuées pour ne pas tomber dans le 
travers décrit ci-dessous. 
 
Un défaut que l'on voit souvent dans les Objets de Scène, c'est la multiplication des appels à la même 
texture pour différentes parties d'un même objet. Ces différentes parties dont nous comprenons la 
présence pour démultiplier le même objet en plusieurs moutures (positionnement de sous 
ensembles) et en plusieurs livrées (textures) devraient avant leur intégration dans une scène être 
combinées afin qu'il n'y ait plus qu'un seul appel par textures. 
 
Les deux fichiers d’un aéroport, dénommés, G et O, ne sont que des Objets de Scène particuliers, 
qui répondent aux mêmes critères qu’un Objet de Scène courant. Sauf que l'on ne peut pas ajuster 
leur échelle dans Landscape Editor. D'où la nécessité de faire un modelage aussi parfait que 
possible. 
 
Il existe de nombreux objets libres de droits en C3D qui sont disponibles sur les forums de Condor 2. 
Certains créateurs mettent librement à disposition les objets qu'ils ont créés. Mais tous les objets 
n'ont pas ce statut. Ne résistez pas à l'envie de créer votre propre collection d'objets, que vous 
pourrez éventuellement échanger avec d'autres créateurs d'objets ou de scène. Ouvrez Object 
Editor, et allez dans tous les répertoires "World/Objects" de chaque scène et ouvrez les fichiers C3D. 
Vous y trouverez, de très beaux objets, bien conçus avec un nombre de Sommets aussi faible que 
possible. Vous en trouverez d'autres beaucoup moins bien. Dans la fenêtre de visualisation, avec un 
L/G maintenu, un clic gauche maintenu de la souris, vous pouvez en déplaçant la souris changer la 
position de l'axe de visée ou si vous préférez faire tourner l'objet ; et avec un R/D maintenu, un clic 
droit maintenu, vous pouvez en déplaçant la souris, zoomer sur l'objet. Examinez tous ces objets 
avec attention, pour vous faire une idée de ce qu'il faudra ajouter pour rendre votre aéroport plus 
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vivant, et surtout demander au concepteur de l'objet, par l'intermédiaire du créateur de la scène, si 
vous pouvez l'utiliser. 

Condor 2, et le fonctionnement des Aéroports  

Condor 2 reprend le fonctionnement des aéroports de Condor 1 avec quelques variantes. 
 
Mais la dualité fonctionnelle reste la même avec : 
 
- Le regroupement des données techniques afférentes a l'aéroport dans Landscape Editor : 

* la dénomination du nom de l'aéroport, "Nom_Aero", 
* la position du centre de l'aéroport (latitude et longitude en degrés. décimaux et altitude en 
mètres) qui n'est ni plus ni moins qu'un Point Tournant classique, 
* l'orientation de la piste en degrés, 
* La longueur et la largeur de la piste définies dans Landscape Editor n'interviennent que pour 
régler le ballet des remorqueurs et le positionnement du départ du planeur (voir schémas plus 
loin). 

 
Ces données sont créées dans Landscape Editor et elles sont regroupées pour tous les aéroports dans 
le fichier "Nom_Scene.apt" éditable dans Landscape Editor. Le départ du planeur se fait dans l'axe de 
la piste avec Condor 2, à 200 m du seuil de piste. Les dernières options permettent d'adapter 
l'aéroport à l'environnement immédiat pour régler des priorités dans l'orientation de l'aéroport et la 
position du ballet des remorqueurs, à droite ou gauche, suivant la direction de la piste. 
 
- Le regroupement des données physiques, c'est-à-dire l'aspect visuel de l'aéroport, dans deux 
fichiers issus de la modélisation dans un modeleur 3D : 

* Le fichier G regroupe les objets au sol qui ne provoquent pas de crashs lorsqu’un planeur roule 
dessus ou le traverse. Le crash sur une piste d’atterrissage, durant la simulation, est le résultat de 
l’évaluation de l’accélération verticale du planeur lors de la prise de contact avec le sol.  
 
Les objets de ce fichier sont généralement plans, en deux dimensions (2D) dans la plupart des cas, 
mais on peut également intégrer des balises frangibles en 3 dimensions ou même tout autre 
objet. 
 
Ce fichier des objets au sol est nommé : 
 
"Nom_AeroG.c3d" 
 
Le suffixe "G" dans le nom du fichier correspond à "Ground", le Sol en anglais.  
 
Quatre types d’objets plans, prédéfinis sont disponibles dans Condor 2. Ce sont des textures 
particulières sans coutures, qui composent les objets habituels se trouvant au sol : 
- l’herbe : "Grass", pour réaliser le fond de tout aéroport. 
- le bitume : "Asphalt", pour réaliser les pistes en dur, les taxiways, les parkings, les sols des 
hangars ouverts, etc. 
- les signes peints sur l’herbe : "Grasspaint", pour les signalisations des pistes en herbes. 
- les signes peints sur le bitume : "Asphaltpaint" pour les signes conventionnels et les balises 
frangibles se trouvant sur les pistes en dur et leurs dépendances. Ces derniers peuvent être 
également utilisés sur l’herbe "Grass".  
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Il est également possible de modifier la couleur blanche d'une partie des signes peints sur la piste, 
et la couleur et/ou la texture d'une partie de la piste ou des taxiways, en utilisant des 
dénominations particulières pour des textures personnalisées, construites par le créateur de 
l'aéroport. 
 
 
* Le fichier O regroupe tous les autres objets 3D qui provoquent un crash lorsque le planeur entre 
en collision avec ceux-ci.  
 
Ces objets 3D sont soit des objets standards soit des objets de scène. Ils sont regroupés dans un 
fichier nommé : 
 
"Nom_AeroO.c3d" 
 
Le suffixe "O" dans le nom du fichier correspond à "Objects", les Objets en anglais.  
 
Dans ce fichier seront regroupés les bunkers, les hangars, la tour de contrôle, les baraquements, 
les immeubles significatifs se trouvant aux abords, la ou les manches à air, les postes 
d’avitaillement, etc.. 
S'ils n'entraînent pas des temps de chargement à 24 km trop importants, des avions et planeurs 
statiques, formant ou non des petites scènes, des barrières, des personnages, des arbres, des 
remorques de planeur, des automobiles, et des engins spéciaux, peuvent être ajoutés au fichier O, 
afin de rendre vivant et réaliste, l’aéroport modélisé. 
 

C'est à partir de la modélisation de l'aéroport complet, créé avec Wings 3D, que ces deux fichiers 
vont être exportés au format "Wavefront". Après transformation au format C3D, ils seront placés 
dans le dossier "Airports" de la scène pour être utilisés dans la simulation. 

 
Les seuls éléments communs à ces deux entités techniques et physiques sont : 

- Le "Nom_Aero" qui doit être identique dans Landscape Editor et dans les fichiers O et G,  
- Le centre de l'aéroport, défini dans Landscape Editor par ces coordonnées (Longitude, Latitude 
et Altitude), correspond au centre de la scène (avec les coordonnées X = Y = Z =0) dans Wings 3D. 
- La direction de la piste suivant l'axe des X de Wings 3D. 

 
Cette dualité voulue par le concepteur de Condor est très efficace, car elle permet de corriger 
facilement la position, l'altitude et l'orientation de l'aéroport dans la scène. En effet, toutes les 
scènes sont entachées par construction d'erreurs matérielles par exemple un glissement de quelques 
mètres entre la carte des hauteurs et le canevas des tuiles Terragen, ou structurelles, comme par 
exemple, le Nord UTM qui n'est jamais le Nord vrai sauf pour le méridien de référence, etc. 
 
Elle comporte deux contraintes :  

- Rendre la surface des aéroports rigoureusement plate pour tout ce qui concerne le fichier G. Il 
faudra donc dans Landscape Editor, le moment venu, aplanir ou mettre à la même altitude 
l'emprise de l'aéroport et sauvegarder ce nouvel état de la carte des hauteurs. Bien évidemment, 
cette altitude définitive devra aussi être corrigée dans la définition de l'aéroport dans Landscape 
Editor pour que ses deux altitudes soient identiques.  
- La deuxième contrainte réside dans le fait qu'il n'y a qu'une seule piste principale active, celle se 
trouvant le long de l'axe des X dans Wings 3D. 

 
Ces deux contraintes peuvent être contournées partiellement, avec un peu d’imagination pour 
s’adapter à des différences d’altitude dans le positionnement des hangars ou d’autres objets, mais 
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aussi aux altiports qui ont des pistes unidirectionnelles en pente et aux aéroports possédant des 
pistes multiples, en faisant quelques concessions. 

Conseils importants : 

Lorsque le planeur arrive à 24/25 km environ d'un aéroport, les fichiers de l'aéroport se chargent 
dans la simulation. Il y a donc un risque de manque de fluidité à ce moment si l'aéroport est trop 
détaillé ou si les textures sont trop lourdes. 
 
Mais c'est seulement lorsque le planeur arrive à 5 km environ d'un objet non intégré au fichier O de 
l'aéroport que les fichiers de cet objet se chargent dans la simulation. Cela peut être intéressant, car 
cela permet de diluer dans le temps, la durée du chargement de ces objets au fur et à mesure que le 
planeur s'approche de l'aéroport. 
 
Il sera donc peut-être utile de séparer les objets statiques communs à plusieurs aéroports et de ne 
garder pour le fichier O que les objets spécifiques à un aéroport comme les hangars, les bâtiments 
administratifs, les ateliers, les stations de carburant, la tour de contrôle et les manches à air. En 
principe, il faut d'abord modéliser tous les objets qui sont immobiliers par destination. 
 
À notre avis, il faudrait toujours intégrer les objets complémentaires des aéroports (arbres isolés, 
planeurs statiques, engins divers, camionnettes de piste, remorques de planeurs, automobiles 
personnages) une fois l'aéroport parfaitement intégré dans la scène et uniquement après que les 
tests principaux aient été validés, et que le temps de chargement à 24 km soit faible pour une 
configuration de PC moyenne. Ne mettez jamais un objet dans l'axe de la piste et évitez qu'ils soient 
traversés par les remorqueurs, lors du roulage. 
 
Sinon il est préférable de mettre tous les objets complémentaires dans le dossier "World/Objects/" 
de la scène et leurs textures correspondantes dans "World/Textures/". Cela a l'avantage en plus de 
l'étalement des chargements de n'avoir qu'un seul fichier C3d par objet qui ne sera donc pas 
dupliqué pour chaque aéroport dans lequel il sera intégré. 

Le ballet des remorqueurs 

Les remorqueurs sont des avions spéciaux, puisque ces objets volants n'entraînent aucune collision 
et passent à travers tout sans dommage : les montagnes, les bâtiments, les objets de toutes natures, 
sauf qu'ils peuvent entraîner le planeur en remorque dans des situations délicates. 
 
Nous nous sommes livrés à plusieurs expérimentations en l'absence de chiffres communiqués par le 
concepteur du logiciel, non exhaustives, mais suffisantes pour encadrer les trajectoires des 
remorqueurs autour de l'aéroport, sur la piste et dans les airs. 

Décollage des remorqueurs tractant un planeur, dans Condor 2 : 

Nous avons utilisé une Duo Discus au poids maximum de 750 kg avec deux pilotes et les ballasts 
pleins tracté avec une corde de 50 m, sans vent ni activité thermique, et le train reste sorti dans 
toute l'expérimentation. 
 
Dans ses conditions, le remorqueur va suivre une trajectoire fixe, dans un plan perpendiculaire au sol 
sur l'axe de la piste jusqu'à 100 m au-dessus de l'altitude de l'aéroport (AGL). La distance parcourue 
sera donnée par l'intégration de toutes les forces résultantes de l'ensemble planeur plus 
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remorqueur. La trajectoire ne pourra être allongée que par des manœuvres intempestives du pilote 
du planeur qui crée des traînées parasites. 
 
Pour le réglage de l'aéroport, 3 éléments sont intéressants à connaître : 
- La distance SA parcourue par le planeur pour qu'il arrive à sa vitesse de décollage, l'indice jaune sur 
le badin. 
- La distance SB parcourue par le planeur au moment où le remorqueur décolle, avec la disparition de 
la poussière soulevée par les roues sur une piste en herbe. 
- La distance SC parcourue par le planeur au moment où le remorqueur atteint l'altitude de 100 m 
au-dessus de l'altitude de l'aéroport (AGL, Above Ground Level), et, où le remorqueur va amorcer son 
premier virage guidé par l'intelligence artificielle. 
 
Si le remorqueur est trop près d'une paroi d'une montagne au point C et qu'il tourne dans la 
mauvaise direction, il pénétra dans la montagne sans difficulté tout en entraînant le planeur dans un 
crash probable si aucune manœuvre d'évitement n'est faite. 
Voici un schéma qui résume la situation : 

Figure 12 - Schéma du Décollage/Take-off Chart 

Voici les résultats de l'expérimentation en mètres à ± 10 m : 

Remorqueur SA SB SC 

DR400 190 390 1600 

Dynamic 260 450 1690 

Super Cub 370 670 2000 

Wilga 150 330 1450 

Z-226 250 390 1500 
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C'est en jouant sur la longueur de la piste, dans Landscape Editor, que l'on pourra adapter le 
fonctionnement de l'aéroport aux impératifs de la topographie, et ce plus particulièrement en 
montagne. 

Atterrissage et roulage du remorqueur sur l'aéroport jusqu'à son point de stationnement. 

Pour une configuration figée de la largeur de l'aéroport dans Landscape Editor, il peut être facilement 
constaté les éléments factuels suivants, quel que soit le type de remorqueur : 
 
- Le touché des roues du remorqueur se fait sur la ligne prolongeant le seuil de la piste définie dans 
Landscape Editor, mais toujours à l'extérieur de la piste délimitée par Landscape Editor en deux 
points d'impact distincts espacés de 5 m environ suivant que le remorqueur a fait son approche en 
branche arrière gauche ou droite par rapport à l'axe de piste utilisée au décollage, nommé Al/g et 
Ar/d. Sauf indications particulières dans Landscape Editor, le ballet des remorqueurs s'effectue à 
droite de l'axe de la piste, quelle que soit la direction du décollage du planeur. 
 
- Le remorqueur roule sur 350 m environ, et amorce un début de virage. 
 
- Après avoir terminé son virage de 180°, il se trouve sur un axe de roulement de retour unique à la 
distance R de l'axe de piste. 
 
- Il fait ensuite un virage de 90° pour se retrouver sur la ligne de départ du planeur à une distance St 
de l'axe de la piste et toujours à 200 m du seuil de piste défini dans Landscape Editor. 
 
Il n'y a donc, qu'une variable principale, c'est la largeur de la piste dans Landscape Editor et qu'une 
variable secondaire pour le point d'impact. 
 
Il faut ajouter, comme on peut le constater lorsque le planeur se trouve dans l'axe de la piste au 
décollage, qu'il y a une variabilité voulue autour de la valeur vraie de ± 2 m que nous retrouverons 
dans tous les résultats. 
 
Voici un schéma qui résume la situation : 
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Figure 13 - Schéma du roulage/Landing Chart. 

Et voici le résultat de l'expérimentation pour quelques largeurs de piste, dans Landscape Editor : 
 

Largeur de piste 
dans LE 

0 à 25 m 50 m 75 m 100 m 

Al/g|Ar/d 28|23 m 35|29 m 42|47 m 60|55 m 

R 69 m 75 86 98 m 
St 41 m 50 60 72 m 

 
Les chiffres indiqués ont une variabilité aléatoire de ± 2 m, voulue par le concepteur du logiciel. 
 
Toutes ces données doivent vous permettre de savoir où il sera impératif de mettre à la même 
altitude les hauteurs dans la topographie. En mode multijoueurs, où plusieurs remorqueurs peuvent 
être prévus, ils s'alignent tous le long d'une ligne parallèle à l'axe de piste à la distance St, et 
s'étendent jusqu'à la boucle de retour du remorqueur. 
 
Toutes ces données vous permettront aussi d'adapter le ballet des remorqueurs aux usages de la 
piste en jouant sur la largeur et la longueur de la piste dans Landscape Editor. 
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Wings 3D :  

Bases du fonctionnement 

Une interface en français de bonne facture est disponible bien que parfois des pans entiers du 
logiciel ou des fenêtres spécifiques ne soient pas traduits de l'anglais. L'interface est également 
disponible dans de nombreuses autres langues. Cette interface en français ou dans un autre langage 
est accessible à partir du menu "Edit" (Edition) en suivant la séquence suivante par des clics gauches 
ou en cliquant sur l'icône engrenage de la Barre d'Outils.  
 
"Edit -> Preferences -> Onglet 'User Interface' -> Cadre 'language' -> Clic sur la flèche de la fenêtre 
déroulante et clic sur 'Français' (ou une autre langue) -> OK". 
Pour profiter pleinement du choix linguistique, il faut arrêter, puis redémarrer Wings 3D. 
 
Ce sera bien utile pour débuter et lire les petits chapitres succincts de l'Aide ("Help") ou pour tester 
des fonctionnalités complexes. 
 
Toutefois, nous utiliserons dans ce qui suit la version anglaise de l'interface, qui est donc universelle 
et adaptée à toutes les fenêtres du logiciel, mais qui permet aussi de se déconnecter de la charge 
affective des mots en français, ou dans votre langue maternelle, pour se concentrer sur la seule 
fonctionnalité des actions proposées. Ou, comme le répètent les archéologues, il faut "savoir sortir 
de tout l'univers associé au mot qui est choisi". Néanmoins, nous proposerons à chaque fois une 
traduction adaptée entre parenthèses et réciproquement pour les termes français, sauf pour la 
version anglaise de ce guide. C'est aussi un bon moyen de se familiariser avec les termes anglo-
saxons utilisés en 3D sans être nécessairement bilingue. 
 
Tous les objets du monde réel en 3 dimensions sont décomposés dans un modeleur 3D en Sommets 
ou Points ("Vertex", "Vertices"). Ces Points sont alors reliés entre eux par des lignes droites plus ou 
moins longues ou Arêtes ("Edges") et une ligne d'arêtes fermée forme une Face pas nécessairement 
plane. L'ensemble des Faces reliées par des Arêtes communes forme un Objet ("Object"). Les objets 
sont des ensembles clos composés de faces, donc impossibles à déplier sans coupures ou 
segmentations. Un ensemble d'Objets disposés et orientés dans l'espace forme une Scène. Ce sont 
les éléments fondamentaux qui composent le fichier d'une Scène dans un modeleur comme 
Wings 3D. 
 
C'est à partir de sélections sur l'un des 4 modes évoqués ci-dessus - Sommets, Arêtes, Faces, Objets - 
sur lesquelles on va appliquer des transformations, que la primitive initiale va se métamorphoser en 
l'objet que l'on veut réaliser. Tout l'art de la construction d'un objet 3D réside dans l'application 
ordonnée de transformations successives pour obtenir le résultat souhaité. 
 
La particularité de Wings 3D c'est de définir un repère orthonormé O [x, y, z] suivant les normes 
anglo-saxonnes avec un axe vertical Oy au lieu de l’axe Oz habituel des continentaux. Comme il n'est 
pas possible de redéfinir l'appellation des axes, il faut s'y habituer. Pour les exportations vers d'autres 
modeleurs ou des jeux, l'option permettant de remplacer l'axe Oy par Oz existe : "Swap Y and Z 
Axes". Il n'y aura donc pas de difficulté particulière, le cas échéant. 
 
Voici un extrait commenté de l'interface de la version 2.2.4, qui vous permettra de débuter presque 
immédiatement, car vous êtes informé en permanence par la ligne d'information et la barre d'état, 
sur ce que vous êtes en train de réaliser et sur quoi va s'appliquer la transformation. 
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Le raccourci clavier le plus important concerne la désélection de toutes les sélections en cours par 
l'appui sur la touche "barre espace". Il est noté par S/E dans ce qui suit. 
 
Pour charger une primitive, après une désélection totale avec la barre espace, S/E, un R/D, clic droit 
dans un emplacement vide de la fenêtre "Geometry", fait apparaître une fenêtre flottante dans 
laquelle vous faites votre choix. 
 
Interface 2.2.4 
 

Figure 14 - Interface Wings 3D 2.2.4. 

Pour ceux qui utilisent Wings 3D, pour la première fois, il est préférable de noter les divers procédés 
utilisés dans ce guide sur un document à part qui servira de résumé. 

Les conventions de la ligne d'information, étendues à ce document : 

Il apparaît systématiquement dans la ligne d'information, au bas de la fenêtre "Geometry" (2.X.X), 
après une sélection et même lorsque rien n'est sélectionné, les lettres L:, M:, R: ou, G, C, D avec le 
menu en français. Ces intitulés sont suivis d'une courte explication qui vous indique ce que vous 
pouvez faire dans le modeleur Wings 3D, là où se trouve le curseur de la souris. 
 
Ces intitulés correspondent pour Wings 3D à : 
L ("Left" en anglais, pour Gauche en français). Pour valider l'option affichée après "L:", il faut 
effectuer un clic avec le bouton gauche de la souris, là où se trouve le curseur de la souris. 
M ("Middle" en anglais, pour Central en français). Pour valider l'option affichée après "M:", il faut 
effectuer un clic avec la molette de la souris, là où se trouve le curseur de la souris. 
R ("Right" en anglais, pour Droit en français). Pour valider l'option affichée après "R:", il faut 
effectuer un clic avec le bouton droit de la souris, là où se trouve le curseur de la souris. 
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Après un de ces 3 clics sur les boutons de la souris, si une action est requise, l'action s'effectue en 
faisant glisser la souris, sauf cas particulier, jusqu'à obtenir l'amplitude désirée. La fin du glissement 
de la souris se termine par un clic gauche, L/G si l'action est acceptée, ou par un clic droit, R/D pour 
revenir au statut antérieur.  
 
Dans certain cas, il est aussi fait mention du double clic gauche LL et s'il est nécessaire de maintenir 
le bouton de la souris maintenu enfoncé pendant la réalisation de la transformation soit un 
L maintenu. 
 
Ces clics de souris se font sur un emplacement vide de l'écran, sur un objet ou un élément de l'objet 
ou sur l'item d'un menu ou après une sélection et l'appel des transformations possibles dans la 
fenêtre flottante sur l'item sélectionné. À chaque fois, la ligne d'information indiquera une marche à 
suivre pertinente, lors du survol par le curseur de la souris d'un élément.  
 
Il ne faut pas confondre l'action de faire tourner la molette de la souris "Scroll" (Molette) avec le clic 
central. La Molette n'est dédiée qu'au déplacement de la caméra (Zoom et panoramique). 
 
Dans les dernières versions, des "Infos-bulles" tendent à dupliquer durant quelques secondes les 
informations de la ligne d'information. 
 
Pour ne pas confondre les clics et l'action sur la molette de la souris avec les touches du clavier, les 
conventions suivantes sont adoptées dans ce document pour tous les logiciels utilisés : 
 
L/G, M/C et R/D, LL/GG, L/G maintenu, R/D maintenu et S/M seront les indications bilingues 
(Left/Gauche, etc..) des clics à effectuer avec la souris pour valider les options correspondantes. En 
l'absence d'une indication du type de clic à effectuer, c'est un L/G qu'il faut faire pour réaliser 
l'action. Les touches complémentaires Maj, Ctrl, et Alt avec la souris sont parfois nécessaires pour 
étendre les actions possibles. Elles seront notées : Maj+R/D, par exemple, pour effectuer un clic droit 
avec la touche-majuscules enfoncée. 
 
Les touches sur lesquelles il faudra appuyer seront simplement nommées par leur valeur en 
majuscule, par exemple, V pour passer en Mode Sommet, E pour passer en Mode Arête, F pour 
passer en Mode Face, O pour passer en Mode Objet, etc.. Tous les raccourcis clavier seront appelés 
de la même manière et la barre espace par S/E. Cela allégera considérablement les séquences des 
techniques expliquées dans la suite du texte. La séparation entre 2 actions sera notée par : " -> ". Si 
l'affectation d'un clic droit, R/D, n'est pas précisée, le clic droit sera toujours exécuté dans un 
emplacement vide de la fenêtre "Geometry" pour appeler le menu contextuel des actions possibles 
sur la sélection au vu du mode choisi. S’il n'y a pas d'affectation pour déclencher l'action, c'est un L/G 
qu'il faut effectuer. 
 
Où que vous soyez dans la construction de votre objet, vous ne serez jamais seul ! Il suffit de lire 
les instructions de la ligne d'information pour pouvoir continuer. 
 
C'est extrêmement pratique et c'est cela qui rend l'apprentissage de Wings 3D si aisé. 
 
Avec Condor 2, une Unité Wings "Wings Unit" (WU) est égale à 1 m. 
 
De plus, le point décimal est adopté pour séparer la partie entière de la partie décimale d'un nombre 
au lieu de la virgule. 
 
Pour le reste, exercez-vous, car c'est par la pratique que l'on progresse. 
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Pour la construction des aéroports, nous vous guiderons pas à pas avec les conventions que nous 
venons d'expliciter. Ce sera aussi un apprentissage de Wings 3D. 

Primitives adaptées à la création d'aéroports 

Pour éviter d'avoir à refaire chaque fois la même chose, nous allons créer quelques primitives pour 
gagner en efficacité. 
 
Au strict minimum, il faut créer les primitives suivantes : 
 
- Un carré de 50 m x 50 m, sans épaisseur, soit 2 faces et 4 Sommets, avec en face inférieure un trou 
pour optimiser les FPS, appelé "EPiste" Élément de Piste et qui pourra être utilisé pour tous les objets 
"Grass" et "Asphalt" du fichier G. 
De cette première primitive, on créera, au fur et à mesure des besoins, tous les éléments 
"Grasspaint" et "Asphaltpaint", conformes à l'Annexe A, de l'OACI (Annexe 14, livre I en anglais). 
Finalement, on construira toute une collection d'objets, sous forme de primitives prêtes à être 
fusionnées comme des chiffres, des flèches, etc.. 
 
- Une ébauche de hangar de 15 x 8 x 7.5 m avec un trou en face inférieure pour optimiser les FPS. 
 
Éventuellement, on pourra créer aussi un cercle de 15 m de diamètre d'épaisseur nulle en 32 ou 64 
sections. 
 
Il y a au moins 4 manières de créer des primitives carrées sans épaisseur à partir d'une primitive 3D 
 
- Partir d'un cube et souder ("Weld") un par un les sommets d'une face à la face opposée. 
- Partir d'un cube et extraire ("Extract") une face. 
- Partir d'un cube, sélectionner les 5 faces inférieures -> R/D -> L/G sur "Hole". 
- Choisir les bonnes options lors de la définition de la primitive. 

Création de la primitive "EPiste" (Élément de Piste) 

Ouvrir Wings 3D, puis amarrer ou non les fenêtres, "Geometry Graph" et "Outliner", au bord droit de 
la fenêtre "Geometry". Pour cela, ouvrir ces fenêtres en partant du Menu  : L/G sur "Window" -> L/G 
sur "Geometry Graph", puis L/G sur "Outliner". Pour déplacer ces fenêtres, L/G sur la barre de titre 
de chaque fenêtre, jusqu'à ce que l'amarrage désiré soit visualisé en violet, ou utiliser la touche Maj 
pour les déplacer sans les recadrer dans tout l'espace de la fenêtre "Geometry" et même en dehors, 
sur un autre écran par exemple. 
 
Effectuer les séquences suivantes dans l'ordre : 
 
S/E -> R/D -> R/D sur Cube -> Entrer les valeurs X= 50, Y = 0, Z= 50 et cocher "Put on the Ground" 
dans "Cube Options" -> L/G sur OK. 
 
Pour cette première séquence d'actions, voici le détail des opérations : 
 
- S/E : désélectionne tout, 
- R/D : un clic droit dans la fenêtre "Geometry" fait apparaître la fenêtre des primitives. 
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- R/D sur Cube : un clic droit sur l'item "Cube" de la fenêtre des primitives ouvre la fenêtre "Cube 
Options". 
- Dans cette fenêtre, entrez les valeurs et cochez la case "Put on the Ground" (Mettre au Sol). 
- L/G sur OK : un clic gauche sur OK ferme la fenêtre "Cube Options", et termine la séquence. La 
primitive est affichée dans la fenêtre "Geometry" avec les options choisies. 
 
La notation adoptée est bien plus efficace pour indiquer la séquence à effectuer pour réaliser la 
transformation voulue. Ci-dessous, un schéma vous indique ce qui a été réalisé. 

Figure 15 - Création d'une primitive plate/Creating a flat primitive. 

À ce stade, vous devez avoir un carré plat sans dimension, 
mais pas exactement ce que l'on souhaite, car c'est un 
parallélépipède rectangle d'épaisseur nulle avec des 
Sommets et des Arêtes superflus. 
 
Vérifier votre travail en partant du Menu : 
"Tools -> Scene Info" 
(Outils -> Information sur la scène) 
qui fait apparaître la fenêtre "Scene Info" qui liste tous les 
objets de la scène : 
 
Pour terminer cette nouvelle primitive, il faut réaliser les 
actions suivantes : 
 
- Nettoyer la géométrie pour éliminer les Sommets 
superflus, les Arêtes et Faces de dimensions nulles. 
- Rendre les Arêtes dures pour qu'il n'y ait pas 
d'interférence lors de l'application du "Shader" de lissage, 
qui peut créer des artefacts indésirables dans Condor 2. 

Figure 16 - Scene Info. 
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- Supprimer la face inférieure. 
- Changer le Nom "Cube1". 
- Effectuer un UV Map standard pour obtenir une Carte du Patron puis une Carte de Texture 
versatile. 
- Sauvegarder la primitive sous un nom approprié dans un dossier spécifique. 
 
Tout au long de ces procédés, la ligne d'information (en bas de la fenêtre "Geometry") vous guidera. 

1 - Nettoyage de la géométrie : 

Sélectionnez votre objet par un L/G et passez en mode Objet (Taper O ou L/G sur l'icône pleine à 
droite). 
R/D dans la fenêtre, fait apparaître la fenêtre flottante des transformations en mode Objet 
L/G sur "Cleanup" (Nettoyage). 
La barre d'état en haut change et vous indique que la sélection "Cube1" comprend : 
2 polygones, 4 Arêtes (Edges) et 4 Sommets (Vertices). C'est ce que l'on souhaite. 
 

2 - Rendre les arêtes dures : 

Passez en mode Arêtes, taper E (Edges), ou L/G sur l'icône comportant une arête le deuxième en 
partant de la gauche. 
Les 4 arêtes du carré sont alors sélectionnées. 
Un R/D dans la fenêtre fait apparaître la fenêtre flottante des transformations en mode Arêtes 
L/G sur "Hardness" (Dureté). Un sous-menu s'ouvre : L/G sur "Hard" (Dur). 
Désélectionner tout par S/E (appui sur la barre espace) Les arêtes ont changé de couleur (jaune-
orangé). 

3 - Éliminer la face inférieure 

Changer la position de la caméra : M/C, puis, déplacer la souris pour obtenir une vue de la face 
arrière, confirmation de la nouvelle position par un L/G ou annulation par un R/D. Pratique et intuitif. 
 
S/E. 
Passer en Mode Face (taper sur F ou L/G sur la 3ème icône). 
Sélectionner la Face arrière par un L/G sur cette face. 
Un R/D dans la fenêtre fait apparaître la fenêtre flottante des transformations en mode Face. 
L/G sur "Hole" (Trou). 
Désélectionner tout par S/E et vérifier que la face arrière est manquante par un L/G qui ne peut plus 
sélectionner que la face avant, faire basculer la caméra pour vérifier la sélection et lire la barre 
d'état. 

4 - Changer de Nom 

R/D sur "Cube1" dans la fenêtre "Geometry Graph", puis, L/G sur "Rename" (Renommer) ou F2. 
Dans la fenêtre "Rename", taper un nom approprié, par exemple "EPiste" pour Élément de Piste. 

5 - Carte du Patron standard : "UV Mapping" 

Dans 80% des cas un "UV mapping" standard sera suffisant pour obtenir une carte du patron presque 
définitive et une carte de texture utilisable s'il l'on choisit les bonnes options. 
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Passer en Mode "Objet" et sélectionner "EPiste". 
 
R/D dans la fenêtre "Geometry", puis L/G sur "UV Mapping" (ou R/D si l'on souhaite recommencer 
l'"UV Mapping" depuis le départ). 
Une fenêtre "AutoUV Segmenting: EPiste" apparaît. 
Dans cette fenêtre, R/D, puis, L/G sur l'option "Segment by" (Segmenter par) puis L/G sur 
"Projection". 
La face change de couleur. 
Nouveau R/D dans la fenêtre "UV Segmenting", puis L/G sur l'option "Continue", puis L/G sur 
"Projection Normal" (Projection selon la Normale de chaque face). 
La fenêtre "AutoUV Segmenting: EPiste" disparaît et elle est remplacée par la fenêtre 
"AutoUV: EPiste". C'est la Carte du Patron dans laquelle est sélectionnée la face de notre carré qui 
occupe toute la surface de la carte sur un fond à damier lettré. 
Dans la fenêtre "Outliner", un nouveau matériau est apparu sous le nom de "Episte_auv" auquel est 
associée une image standard "auvBG" (BG pour "Back Ground" (Arrière-plan)). 
 
Il ne nous reste plus qu'à transformer la Carte du Patron en Carte de Texture avec les bonnes 
options. 
 
Garder tout sélectionné ; au besoin, passer en mode "Objet", puis tracer un rectangle de sélection 
englobant toute la Carte du Patron avec un L/G maintenu. 
R/D dans la fenêtre "AutoUV: EPiste", afin de faire apparaître les options, puis, L/G sur "Create 
Texture" (Créer la Texture). 
Une boîte de dialogue "Draw Options" (Options de Dessin) s'ouvre. 
La Carte de Texture toujours carrée a une taille en pixel qui doit être définie : choisir 512x512 pixel. 
Puis, lors de la création de la Carte de Texture, une suite de passes dans le cadre "Render" (Rendu) 
sont exécutées selon l'ordre affiché de haut en bas dans la boîte d'option, la passe de rendu suivante 
recouvrant la passe précédente. L'empilement des passes est donc sur la texture du bas vers le haut. 
Mais pour l'instant mettre toutes les options sur "None" - aucun tracé demandé sur la Carte de 
Texture de "EPiste". 
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Figure 17 - Options de Dessin de "EPiste"/"EPiste" Draw Options. 

L/G sur OK pour terminer l'élaboration de la Carte de Texture à partir du modèle, la Carte du Patron. 
 
Il est préférable, mais ce n'est pas obligatoire de changer le nom du matériau et de la texture en 
"EPiste" et donc éliminer "_auv" 
Pour réaliser ceci, L/G sur le Matériau "Episte_auv" dans la fenêtre "Outliner", puis F2 pour accéder 
directement à la fenêtre "Rename". Refaire la même chose avec l'Image "EPiste_auv". Fermer la 
fenêtre "AuoUV: EPiste" avec un L/G sur la croix en haut à droite. 

6 - Sauvegarde et création d'un dossier des primitives pour les aéroports. 

Par le menu : 
"File -> Save" (Fichier -> Sauvegarder), une boîte de dialogue s'ouvre et permet de créer un "Nouveau 
Dossier" que l'on a nommé "Aeroprimitive" et nous avons sauvé cette primitive sous le nom "EPiste". 
 
Voilà, c'est terminé pour cette première primitive dédiée aux aéroports, et des bases importantes de 
Wings 3D ont été abordées pas à pas. Par la suite, nous serons moins prolixe et nous nous 
contenterons le plus souvent d'indiquer les séquences suivant les conventions que nous avons fixées. 

Création de la primitive, hangar 

"File -> New" (Fichier -> Nouveau) permet de passer à une nouvelle construction 
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R/D affiche les primitives. R/D sur cube affiche la fenêtre "Cube Options". Entrer la taille du Cube et 
cocher la mise au sol. 

Figure 18 - Création de la primitive Hangar/Creating hangar primitive. 

L/G sur OK pour finaliser l'opération. 
 
Il ne reste plus qu'à rendre les Arêtes dures, éliminer par un "Hole" la face inférieure et donner un 
nom approprié à Cube1, dans la fenêtre "Geometry Graph" avant de sauvegarder le fichier. 
Ces techniques ayant été vues en détail lors de la création de la primitive "EPiste", nous n'y 
reviendrons pas. Il n'est pas nécessaire de faire un "UV mapping". 
Le Nom retenu est "HLn" pour Hangar Lienz Nikoldorf. Il faudra donc adopter un nom correspondant 
à l'aéroport que vous allez modéliser. Pour chaque hangar créé, il suffira d'ajouter le suffixe 01, 02, 
03, etc., pour identifier sans erreurs tous les hangars que vous serez amené à créer, sur les nombreux 
aéroports que vous allez créer. 
 
Voici le résultat final : 
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Figure 19 - Primitive Hangar. 

Sauvegardez cette nouvelle primitive dans le répertoire "Aeroprimitive" sous le nom Hn ou tout 
autre nom a votre convenance. 

Raccourcis clavier adaptés à la création d'aéroports 

La liste de tous les raccourcis clavier se trouve dans la rubrique d'aide du menu : 
"Help -> Defined Hotkeys". 
(Aide -> Raccourcis clavier prédéfinis). 
 
La manière de créer un raccourci clavier est expliquée ici : 
"Help -> How To Define Hotkeys". 
(Aide -> Comment définir un Raccourci clavier). 
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Figure 20 - Comment Définir un Raccourci clavier/How to Define a Hotkey. 

 
Parfois, CTRL+Inser ou CTRL+8 et CTRL+Suppr ou CTRL+9 ne fonctionnent pas toujours correctement, 
si votre clavier est un peu fatigué. Il faut souvent répéter l'action et intervertir les commandes 
d'initialisation jusqu'à obtenir la mention suivante sur la ligne d'information : 
"Select a Menu item to bind/unbind a hotkey". 
(Sélectionnez un item d'un Menu pour le lier ou le délier d'une touche de raccourci clavier). 
 
Lors de la construction d'un aéroport particulièrement avec les Éléments de Piste, il faudra 
principalement déplacer des Sommets pour les positionner de façon adéquate sur le plan de 
l'aéroport, et même aussi superposer des sommets de manière absolue entre les éléments "Asphalt" 
et "Grass". Ces séquences sont très souvent répétitives et parfois longues. 
 
Les seules touches non affectées et pratiques sont : 
 
H : Cette touche sera affectée au déplacement horizontal selon X sur une sélection de Sommets. 
N : Cette touche sera affectée au déplacement selon Z (Vertical ou Nord/Sud) sur une sélection de 
Sommets. 
K : Cette touche sera affectée au soudage de 2 Sommets liés par une Arête. 
J  : Cette touche sera affectée à la superposition de deux points. Ce raccourci clavier évite d'effectuer 
3 clics avec la souris. 

Création du raccourci clavier H 

Dans Wings 3D, ouvrir une primitive Cube et sélectionner un sommet. 
Appuyez sur "CTRL+8" ou "CTRL+Inser" pour initialiser le processus d'enregistrement du raccourci 
clavier. 
La ligne d'information indique alors "Select a Menu item to bind/unbind a hotkey". 
(Sélectionnez un item du Menu pour le lier ou le délier à une touche de raccourci clavier). 
R/D pour faire apparaître le menu des transformations des Sommets. 
L/G sur Move. 
L/G sur X. 
La ligne d'information vous demande alors de choisir le raccourci clavier : 
"Press the key to bind "XXX" command to" (Appuyer sur la touche désirée pour la lier à la commande 
"XXX"). 
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Appuyez sur la touche H. 

Création du raccourci clavier N 

Dans Wings 3D, ouvrir une primitive Cube et sélectionner un sommet. 
Appuyez sur les touches "CTRL+8" ou "CTRL+Inser" pour initialiser le processus d'enregistrement du 
raccourci clavier. 
La ligne d'information indique alors "Select a Menu item to bind/unbind a hotkey". 
(Sélectionnez un item du Menu pour le lier ou le délier à une touche de raccourci clavier). 
R/D pour faire apparaître le menu des transformations des Sommets. 
L/G sur Move. 
L/G sur Z. 
la ligne d'information vous demande de choisir le raccourci clavier : 
"Press the key to bind "XXX" command to" (Appuyer sur la touche désirée pour la lier à la commande 
"XXX"). 
Appuyez sur la touche N. 
 
Maintenant, ces 2 raccourcis clavier sont affichés en face des commandes correspondantes sur le 
menu "Move" (Déplacer) pour les Sommets. 

 
Figure 21 - Affichage des nouveaux raccourcis clavier/New Hotkeys display. 

 
Utilisation des touches H et N 
Sélectionnez des sommets, appuyez sur H ou N, ils passent en surbrillance et déplacer la souris pour 
déplacer les sommets horizontalement (X) ou verticalement (Z) dans le plan perpendiculaire à Y. H et 
N peuvent être appuyés l'un après l'autre dans le même déplacement, sans avoir à fixer la position 
par un L/G. Fixer le déplacement par un L/G, revenir à l'état antérieur par un R/D. 

Création du raccourci clavier K 

Dans Wings 3D, ouvrir une primitive Cube et sélectionner un sommet. 
Appuyez sur "CTRL+8" ou "CTRL+Inser" pour initialiser le processus d'enregistrement du raccourci 
clavier. 
La ligne d'information doit indiquer alors "Select a Menu item to bind/unbind a hotkey" 
(Sélectionnez un item du Menu pour le lier ou le délier à une touche de raccourci clavier). 
R/D pour faire apparaître le menu des transformations des Sommets. 
L/G sur Weld. 
La ligne d'information vous demande de choisir le raccourci clavier : 
"Press the key to bind "XXX" command to" (Appuyer sur la touche désirée pour la lier à la commande 
"XXX"). 
Appuyer sur la touche K. 
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Utilisation de la touche K :  
Sélectionner un Sommet 
Appuyer sur K, le Sommet est alors en surbrillance. 
R/D sur le sommet sur lequel doit être soudé le premier Sommet, les 2 sommets doivent être reliés 
par une Arête. Il ne reste plus qu'un seul Sommet. Le Sommet déplacé est soudé et éliminé. 

Création du raccourci clavier J 

Dans Wings 3D, ouvrir une primitive Cube et sélectionner un sommet. 
Appuyez sur les touches "CTRL+8" ou "CTRL+Inser" pour initialiser le processus d'enregistrement du 
raccourci clavier. 
La ligne d'information doit indiquer alors "Select a Menu item to bind/unbind a hotkey". 
(Sélectionnez un item du Menu pour le lier ou le délier à une touche de raccourci clavier). 
R/D pour faire apparaître le menu des transformations des Sommets. 
L/G sur "Absolute Commands". 
L/G sur ".Snap" du sous-menu. 
M/C pour choisir le mode souhaité. 
la ligne d'information vous demande de choisir le raccourci clavier : 
"Press the key to bind "XXX" command to" (Appuyer sur la touche désirée pour la lier à la commande 
"XXX") 
Appuyez sur J 
 
Utilisation de la touche J 
Sur un cube, sélectionnez un Sommet. 
Appuyer sur J, le Sommet passe en surbrillance. 
R/D sur un autre Sommet du cube ou d'un autre objet. 
Le premier Sommet se positionne sur le second. Les deux Sommets ont exactement les mêmes 
coordonnées X, Y, Z. 

En dernier recours : 

Parfois, la version 2.X.X ne supporte pas bien la mise en place de raccourci clavier complexe comme 
la touche J. Heureusement, la version 1.5.4 supporte très bien ce type de raccourci clavier et comme 
les raccourcis clavier sont communs à toutes les versions, le raccourci clavier J, créé avec Wings 3D 
1.5.4 sera utilisable avec les versions 2.X.X donc 2.2.4. Il est même possible alors de définir un 
deuxième raccourci clavier ayant la même fonctionnalité de J pour une sélection de Sommets. 
Toutes les versions de Wings 3D sont compatibles entre elles. 
 
Voici le procédé complet pour créer le raccourci clavier J 
Télécharger la version 1.5.4 sur le site de Wings 3D, si cela n'a pas déjà été fait. 
Aller dans la page des téléchargements "Downloads". 
En bas de cette page se trouve l'accès aux anciennes versions "Old releases". 
L/G sur "All release". 
 
Une page de chargement chez SOURCEFORGE s'ouvre, il faut accepter les Cookies. 
L/G sur 1.5.4. 
Une nouvelle page s'ouvre avec toutes les versions de 1.5.4. 
Choisissez la version qui vous convient (Mac, Linux, ou Windows 32 ou 64 bits). 
Télécharger et installer cette version. 
Assurez-vous d'avoir fermé Wings 3D 2.2.4. 
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Ouvrez Wings 3D 1.5.4. Il fonctionne presque de façon identique à la version 2.2.4. seul l'aspect 
extérieur change et les fenêtres sont prisonnières de la fenêtre principale de l'application. 
Par un R/D dans la fenêtre "Geometry" accéder aux primitives et charger un cube et afficher l'aide 
sur la manière de définir les raccourcis clavier par "Help -> How to define Hotkeys". 
Sélectionnez un Sommet. 
R/D affiche le menu des transformations des Sommets. 
L/G sur "Absolute Command". 
Dans le sous-menu positionnez le curseur sur ".Snap", celui-ci se met en surbrillance. 
Appuyez sur la touche "Inser" et gardez le curseur sur ".Snap". 
La ligne d'information vous permet de choisir 3 commandes différentes. Choisissez la commande 
centrale par un M/C. 
Appuyez ensuite sur J. 
Fermez Wings 3D 1.5.4 et ouvrez à nouveau Wings 3D 2.2.4. 
 
 
 

La liste des raccourcis clavier  

Pour information, tous les raccourcis clavier ajoutés sont en fin de liste de : 
 
"Help -> Defined Hotkeys" 
(Aide -> Raccourcis clavier prédéfinis) 
 

Figure 22 - Les nouveaux Raccourcis clavier dans la liste des Raccourcis clavier/New Hotkeys in the Defined Hotkeys List. 

 
Ce qui indique bien, même en l'absence de J en face de la commande "Snap", qu'ils sont tous pris en 
charge par la dernière version 2.2.4. Cette liste est mise à jour automatiquement pour toutes les 
versions de Wings 3D se trouvant sur le même ordinateur. 
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Modélisation de l'aéroport LOKL Lienz-Nikolsdorf 

D'abord, il faut s'organiser et créer un dossier spécifique pour la création d'un aéroport, par exemple 
"Lienz" pour l'aéroport et un sous-répertoire, "doc" pour les photos et les plans, dans une partition 
différente de Condor 2. Une copie des 2 primitives créées serait également bienvenue. D'autres 
répertoires dans "Lienz" seront ajoutés ultérieurement.  

1/Réunir une documentation solide avec des plans en projection UTM. 

C'est une phase importante du processus : elle consiste à réunir des informations pour la 
construction des pistes et des hangars ainsi que leur habillage, pour pouvoir les modéliser et les 
texturer. 

Les photos 

Dans le meilleur des cas, vous habitez à proximité de l'aéroport et vous êtes membre du Club de vol à 
voile. 
Dans ce cas, n'hésitez pas avec votre Smartphone ou votre appareil photo numérique à faire des 
dizaines de photos. Il y en aura rarement trop.  
Commencez par des vues générales aériennes pour situer l'ensemble des pistes taxiways, aires de 
stationnement, bâtiments, hangars, et signalisations diverses, en prenant les précautions d'usage. 
Ensuite, photographiez, un à un, chaque élément avec, si possible, un repère d'échelle.  
Pour un bâtiment, en plus d'une vue générale en perspective du sol, essayez de prendre 4 photos, 
une par face, en se plaçant, debout dans l'axe de la face, le plus éloigné possible en utilisant 
uniquement le zoom optique au maximum pour éviter les distorsions. Ces photos pourront être 
facilement redressées dans Photoshop et l'on pourra facilement les plaquer comme texture sur 
chacune des faces du bâtiment. 
 
Un peu moins bien, c'est d'avoir un collègue vélivole qui peut effectuer ce travail. Vous pouvez aussi 
vous adresser à la communauté Condor. Le succès n'est pas garanti ! 
 
Mais dans 80% des cas, vous n'obtiendrez que des photos éparses, et ce sera juste suffisant. 
 
Toutefois, un certain nombre de possibilités doivent être explorées et il faut capturer les images au 
fur et à mesure avec un logiciel adéquat de capture : 
 
Google Earth: 
- Autour de l'aéroport, vous trouverez quelques photos que vous pouvez éventuellement exploiter. 
- Si les bâtiments sont dans la base de données Google Earth en 3D, vous aurez une vue d'ensemble 
plutôt satisfaisante et vous pourrez alors examiner les bâtiments de l'aéroport sous toutes les 
coutures en étant patient et capturer des vues intéressantes. 
- Et si vous pouvez actionner "Street View", aux abords de l'aéroport, certains détails vous seront 
peut-être révélés. 
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Internet : 
Bien évidemment, il faut aussi rechercher des photos sur Internet, mais également regarder des 
vidéos sur You Tube ou Daily Motion. Les vidéos sur les approches et prises de terrains vous seront 
utiles pour appréhender des détails qui autrement vous auront échappé, comme des bâtiments 
proches de la piste, mais non inclus dans l'emprise de l'aéroport et qu'il sera souhaitable d'ajouter au 
fichier O. 
 
Pour Lienz-Nikolsdorf 
 
Nous avons simplement fait une recherche avec Google en tapant 
 
"Lienz Nikolsdorf Airport" 

Figure 23 - Recherche de documents sur Internet/Searching documents on the Internet. 

 
Il faut bien évidemment trier, entre, les hors-sujets et les autres simulateurs de vol, mais vous avez 
accès à des informations intéressantes ! 
 
Tout cela fini par une collection de photos que l'on exploitera le moment venu pour modéliser et 
texturer les bâtiments de l'aéroport. 
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Note : les photos XP 1 à 13 sont tirées de l'aéroport de Lienz-Nikolsdorf modélisé dans Xplane. 

Figure 24 -- Liste des documents/Documents List. 
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Les Plans 

Dans AA2, la tuilette où se trouve Lienz-Nikolsdorf porte le numéro t4570 
dont voici la copie. Elle a pour dimension 2048 x 2048 pixels, soit le standard de Condor 2. 
 

 
Figure 25 - Tuilette t4570/Patch t4570. 

L'aéroport se trouve en bas à gauche, voici un agrandissement 
 
Bien que ce plan soit en UTM 32 N, la projection de AA2, le crénelage est important ce qui donne une 
imprécision dans le positionnement des divers éléments de l'aéroport, mais permet d'apprécier les 
diverses emprises liées à la texture photo dans AA2 et qui devront être modélisées. 
 
Vous rencontrerez les mêmes difficultés avec une texture synthétique où ont intégrées des données 
OSM. 
 
Il faut donc trouver des plans plus détaillés ! 
 



Version 1.0 fr - 2019-09-16  Page 40/134 

Aéroports pour Condor 2 - Guide de Construction  Xavier Delaborde © 2019 

 
Figure 26 - Lienz-Nikolsdorf de/from t4570. 

Il existe plusieurs solutions que nous allons explorer. 

Une photo-satellite avec Google Earth 

 
Figure 27 - Lienz-Nikolsdorf de/from GE. 
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Le plan est plus net et la résolution des photos est bien plus grande que celle affichée en valeur 
standard, mais c'est une projection proche de l'ellipsoïde de référence WGS 84. Vous pouvez noter 
qu'il y a de légères différences entre ces deux photos, sur les surfaces bétonnées. 
 
Toutefois pour ces grandeurs de l'ordre du kilomètre la superposition des deux images de l'aéroport 
de Lienz-Nikolsdorf, l'une de Google Earth et l'autre de la tuile t4570, la distorsion est infime comme 
le montre ce photomontage : 
 

Figure 28 - Photomontage GE/t4570. 

Sans erreur manifeste, il est donc possible d'utiliser directement une image Google Earth pour 
construire l'aéroport Lienz-Nikolsdorf. 
 
Toutefois, cela pose un problème de distorsion pour les grandes scènes, disposées Est Ouest, comme 
AA2, lorsque l'emplacement de l'aéroport est éloigné du Méridien de référence de la zone UTM. 
 
Pour illustrer notre propos de façon un peu caricaturale, voici l'Europe en UTM 32 et en WGS 84. 
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Le choix de la modélisation de l'aéroport en partant d'une image Google Earth ou en partant d'une 
image UTM pourrait se poser pour les aéroports les plus éloignés du méridien de référence. 
Il vous appartiendra de gérer cette difficulté en faisant éventuellement une reprojection de l'image 
Google Earth dans la zone UTM de la scène, avec QGis. 
Lienz-Nikolsdorf se trouve à la longitude 12,87°, dépassant de presque 1° la zone UTM 32 pour un 
méridien de référence sis à 9°. 
 
Sauvegardez l'image Google Earth de Lienz-Nikolsdorf à la résolution maximale. Commencez par un 
cadrage précis avec une marge, appuyer sur R pour redresser l'image. Réitérez ces deux opérations si 
nécessaire. Puis par CTRL+Alt+S, sauvegardez l'image et choisissez dans la fenêtre déroulante la 
qualité maximale. L/G sur "Save Image" (Enregistrer l'image). Donnez un nom par exemple : 
"LienzGEMax" puis L/G sur "Save" (Enregistrer). 

QGis 2.18 Las Palmas 

Pour éviter toutes mauvaises surprises, nous allons 
récupérer les éléments de l'aéroport et son environnement 
dans OpenStreetMap et les projeter en UTM 32. 
- Ouvrir QGis 2.18. 
- "Projet -> Nouveau Projet". 
- "Vecteur -> OpenStreetMap -> Télécharger des données 
OSM". 
Dans la fenêtre de téléchargement, passer en manuel et 
entrer la zone englobant l'aéroport largement en degrés 

décimaux. Il faut donner un nom et 
un emplacement au fichier de sortie 
avec un L/G sur "Parcourir". Puis L/G Figure 30 - Ajout d'une Couche Vecteur/Adding a Vector Layer. 

Figure 31 - Téléchargement de données OSM/Download 

OSM data. 

Figure 29 - l'Europe en projection UTM 32 et WGS84. 
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sur OK. Au bout de quelques secondes, le téléchargement démarre et vous avez l'indication en bas et 
à gauche de la quantité de données téléchargées. 
Appuyer sur "Fermer" et non sur "OK" pour quitter le téléchargement. 
 
- "Couche -> Ajouter une Couche -> Ajouter une couche vecteur". 
L/G sur "Parcourir" pour indiquer la source du jeu de données, l'emplacement du fichier OSM qui 
vient d'être téléchargé. 
Dans la fenêtre suivante, choisissez "Lines" & "Multipolygons" ou plus facilement "Sélectionner tout", 
puis OK. 
 

 
Normalement, une carte doit s'afficher dans la 
fenêtre principale. Si ce n'est pas le cas, poursuivez, rien n'est perdu. 
 
L/G sur ESPG4326 en bas à droite, et la fenêtre "Propriété du projet |SCR" s'ouvre. 
Cocher : "Activer la projection à la volée sur SCR (ALV)". 
Et chercher et sélectionner WGS 84/UTM zone 32N, l'ID certifié est celui-ci : EPSG:32632 ou le SCR 
correspondant à la scène où se trouve l'aéroport. 
L/G sur OK. 
À présent, le SCR du projet est "EPSG:32632 (ALV)". 
 
Dans le cadre, couche, "R/D sur la couche Multipolygons -> L/G sur Filtrer". 
 
Le constructeur de requêtes s'ouvre. 
Dans le cadre "Champs", L/G sur "buildings" puis L/G sur "Tout" dans la cadre "Valeur", fera 
apparaître toutes les valeurs du champ "building". 
 
Création de l'expression de filtrage : 
 
LL/GG sur "building". Le champ "building" est chargé dans le cadre de filtrage. 
L/G sur le bouton "=" dans le cadre "Opérateurs". L'opérateur = est chargé le cadre de filtrage à la 
suite de "building". 
LL/GG sur "yes" dans le cadre "Valeurs" 
La Requête est finie, elle apparaît dans l'expression de filtrage : 

Figure 32 - Sélection des couches vecteurs/Vector Layers Selection. 

Figure 33 - Choix d'un SCR/CRS Choice. 
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"Building" = 'yes'. 
En ajoutant l'opérateur "OR" et en 
répétant toute la séquence précédente, 
vous pouvez ajouter d'autres valeurs de 
filtrage comme "hangar" ou "cabin". 
L/G sur "Tester" (100 lignes ont été 
trouvées).  
L/G sur OK pour fermer la fenêtre 
d'information. 
L/G sur OK. 
R/D sur la couche "Multipolygons" ainsi 
filtrée. Choisir "Enregistrer Sous". 
 
La fenêtre "Enregistrer la couche 
vectorielle sous.." s'ouvre : 
- Choisir un format. 
- Choisir un emplacement et un nom 
pour le fichier de la couche. 
- Modifier le SCR pour celui du projet 
- L/G sur OK. 
 
Confirmez le SCR du projet dans la 
fenêtre 
"Sélectionneur de systèmes de 
coordonnées de référence" : L/G sur 
WGS/UTM 32, 
Puis L/G sur OK. 
Une nouvelle ligne apparaît dans le cadre des couches nommée "Building Entities Polygons" en 
surbrillance. 

"Vue -> Zoom sur la couche" fait apparaître la 
carte, si la fenêtre principale était restée vide. 
 
Pour terminer cette opération : 
R/D sur "multipolygons" -> L/G sur "Filtrer". 
Le constructeur de requêtes apparaît à nouveau. 
L/G sur "Effacer", L/G sur "OK". 
Toutes les données se trouvant dans la couche 
"multipolygons" sont alors à nouveau 
accessibles. 
 
En appliquant plusieurs filtres sur les couches 
"multipolygons" et "lines", en suivant le procédé 
décrit ci-dessus, on obtient le résultat suivant 
pour la carte de l'aéroport : 
 
- Contour de l'emprise de l'aéroport. 
- Tous les bâtiments de l'aéroport. 
- La piste (son étiquette 630 x 30 m) en noir 2 
pixels. 
- Les parkings. 
- Les taxiways et les routes ont été laissés sous 
forme de lignes. 

Figure 34 - Construction d'une Requête/Making a Request. 

Figure 35 - Enregistrement d'une couche vectorielle/Vector Layer 
Saving. 
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Les ID de chaque bâtiment ont été consultés, les hauteurs des bâtiments ne sont pas indiquées. 

 

QGIS 3.6 

Si cela vous paraît trop compliqué, avec 
Qgis 3.6 vous pouvez extraire une carte 
standard de l'aéroport assez facilement : 
 
Ouvrir Qgis 3.6: 
"Fichier -> Nouveau Projet". Dans le 
"Browser". L/G sur "XYZ Tiles". LL/GG sur 
OpenStreetMap. Zoomer sur l'aéroport. 
Changer le SCR pour UTM 32. L/G sur 
EPSG:3852 
Dans "Project Properties" : 
Rechercher le SCR UTM 32N. L/G sur 
Minna/UTM zone 32N, L/G sur OK. 
 
Le SCR en bas à droite devient : EPSG 
26332 
 
La carte vectorielle a été projetée en UTM 

32 N. 
 
 

Figure 37 - Propriétés du Projet, SCR/Project Properties, CRS. 

Figure 36 - Plan OSM de Lienz Nikolsdorf UTM 32 N/Lienz-Nikolsdorf OSM Map UTM 32N. 
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Figure 38 - Lienz-Nikolsdorf de/from QGis 3.6, OSM, UTM 32N. 

 
C'est un peu moins précis, mais largement suffisant. Faire une capture d'écran de l'Aéroport de 
QG3.6. 
 
À présent, nous avons comme plan les captures suivantes pour l'aéroport de Lienz-Nikolsdorf : 
 
- Un extrait de la tuilette t4570 en UTM32. 
- Un plan de Google Earth en WGS 84. 
- Un plan détaillé extrait des données OSM avec Qgis 2.8 ou Qgis 3.6 en UTM32. 
 
Bien que les systèmes de projection ou de références soient différents, n'oubliez pas que ces plans 
ou photos représentent des états différents et 
successifs de l'aéroport Lienz-Nikolsdorf. 
Comme on doit se rattacher à la tuilette de 
AA2, c'est en finalité sur celle-ci que reposera 
la modélisation. 
 
Ces 3 plans peuvent être chargés et mis à 
l'échelle dans Wings 3D afin de commencer la 
modélisation de l'aéroport. 

Données Officielles sur la piste 

Il est aussi nécessaire de consulter des tables 
OACI sur l'aéroport que l'on va modéliser. 
 Figure 39 - Lienz-Nikolsdorf - Données/Data. 



Version 1.0 fr - 2019-09-16  Page 47/134 

Aéroports pour Condor 2 - Guide de Construction  Xavier Delaborde © 2019 

voici un extrait de : 
 
https://www.openaip.net/ 
 
Concernant les caractéristiques officielles de l'aéroport Lienz-Nikolsdorf. 

2/Créer un aéroport dans Lanscape Editor. 

Fonctionnement de Landscape Editor pour les aéroports 

Figure 40 - Reichenbach dans/in Landscape Editor. 

 
Dans Landscape Editor : 
 
Charger une scène : ouvrir la liste déroulante et faire un L/G sur la scène choisie. 
 
Avec l'outil "Main": 
Se déplacer sur la carte avec un L/G maintenu en déplaçant la souris, dans la fenêtre principale. 
Zoomer avec un L/G. 
Dézoomer avec un R/D. 
 
Toutes les modifications effectuées dans Landscape Editor seront perdues si aucune sauvegarde n'est 
réalisée. Sauvegardez par : 
"File -> Save Landscape", et attendre le message de fin et acquitter par un L/G. 
(Fichier -> Sauvegarder la Scène) 

https://www.openaip.net/
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La liste des aéroports n'est visible que lorsqu’"Airports" est en surbrillance. 
 
Un R/D sur un aéroport fait apparaître un menu contextuel permettant de : 
 

 
Figure 41 - Menu Contextuel des Aéroports/Airports Popup Menu. 

Le niveau de zoom de 1.33 permet d'accéder à la haute définition des textures, et de l'affichage de 
données altimétriques sommaires. Le niveau de zoom de 10.67 permet d'afficher la totalité des 
données altimétriques avec un maillage de 30 m. Avec Landscape Editor pour Condor 2, l'altimétrie 
est affichée sur le point du maillage ou tout près, ce qui rend les modifications d'altitudes bien plus 
faciles à réaliser. 
 
Nous ne saurions trop vous recommander de greffer un Patch sur Landscape Editor, vous permettant 
d'utiliser en 32 bits les 4 Go de la mémoire de votre ordinateur. 
 
https://ntcore.com/?page_id=371 
 
Mais, ce sera insuffisant pour charger les textures noires et blanches de AA2 

Création d'un nouvel aéroport dans Landscape Editor 

Bien que l'Aéroport de Lienz-Nikolsdorf soit déjà créé dans AA2 0.5, nous allons réexaminer chacune 
des propriétés de l'aéroport. 
 

 
Figure 42 - Ajout d'un aéroport/Adding an Airport. 

https://ntcore.com/?page_id=371
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Pour créer un nouvel aéroport, R/D dans la fenêtre de la liste des aéroports, un R/D fait apparaître un 
menu contextuel et un L/G sur "Add" (Ajouter) une fenêtre "Airport properties" vierge. Lors de la 
création initiale d'un nouvel aéroport, utilisez les données OACI, ou un standard prédéfini. 
 
1 - Name (Nom) : Donner un nom à l'aéroport sinon ce sera "New" (Nouveau). Il ne faut jamais laisser 
cet item vierge, car trouver un aéroport inexistant en fin de liste n'est pas évident et peut entraîner 
des erreurs lors du chargement de la scène. 
De plus, pour éviter des problèmes de compatibilité avec d'autres alphabets, voici les règles 
typographiques qu'il faut respecter : 
- Le nom de l’aéroport ne doit pas avoir de caractères accentués, ni d’espaces, ni de caractères 
spéciaux, bien que ceux-ci soient le plus souvent acceptés.  
- Il faut donc remplacer les "espaces" par des caractères de soulignement "_" ou des traits d’union "-" 
ou les supprimer. 
- Pour éviter tous soucis, il faut se cantonner aux caractères suivants : 
{a,b,c, ….,z} et {A,B,C,…. ,Z} {0,1,2,3…,9} et {-,_ } 
 
2 - LON/LAT (Longitude Latitude) : Inscrire les coordonnées, Longitude et Latitudes, de l'aéroport en 
degrés décimaux. 
La précision de 6 chiffres après la virgule est illusoire. Des arrondis seront effectués 
automatiquement par Landscape Editor sur un canevas que l'on examinera lors du réglage final de 
l'aéroport. 
 
3 - Altitude : Inscrire l'altitude en mètres de l'aéroport. La précision est de ± 1 m. Les valeurs 
décimales ne sont pas acceptées. Vérifier lors du réglage final qu'elle correspond à la valeur définitive 
choisie et utilisée pour aplanir l'emprise de l'aéroport. 
 
4 - Direction : Inscrire la direction en degrés. La précision est de ± 1 degré. Les valeurs décimales ne 
sont pas acceptées. Cette précision est parfois insuffisante pour les scènes photo satellites ou avec 
des textures synthétiques comprenant des ajouts issus d’OpenStreetMap, lorsque la longueur de 
Piste dans le fichier G est importante. Cette précision sera améliorée dans le futur. 
 
5 - Length (Longueur): Inscrire la longueur de la piste en mètres. La précision est de ± 1 m. Les valeurs 
décimales ne sont pas acceptées. La longueur de la piste dans Landscape Editor gère le 
positionnement du planeur au départ et le ballet des remorqueurs comme montré dans le chapitre 
"Condor 2 et le fonctionnement des Aéroports", ou 400 m, pour une valeur prédéfinie minimale. 
 
6 - Width (Largeur): Inscrire la largeur de la piste en mètres. La précision est de ± 1 m. Les valeurs 
décimales ne sont pas acceptées. La largeur de la piste dans Landscape Editor gère le ballet des 
remorqueurs comme montré dans le chapitre "Condor 2 et le fonctionnement des Aéroports", ou 25 
m, pour une valeur prédéfinie minimale. 
 
7 - Asphalt: Cocher la case si la piste de décollage des planeurs n'est pas en herbe. Cela change le 
coefficient de frottement lors du roulage du planeur et il n'y a pas de soulèvement de poussière 
derrière les roues du remorqueur, lorsqu’il roule sur ce type de surface. 
 
8 - Frequency (fréquence radio): C'est la fréquence radio de l'aéroport. Elle est par défaut réglée à 
123.50. Cela règle automatiquement la fréquence radio pour les circuits démarrant de cet aéroport. 
 
9 - Les 3 cases à cocher du réglage de l'aéroport : Lorsque vous créez votre aéroport, l'axe des X dans 
Wings 3D donnera pour le sens positif la direction de la piste par vent nul, conformément à la 
direction inscrite ci-dessus, et réglera le ballet des remorqueurs qui se trouveront à droite du planeur 
au moment du départ du remorquage. Pour pallier les difficultés rencontrées avec certains aéroports 
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vous disposez des 3 cases à cocher suivantes, sans changer la disposition de l'aéroport issue des 
fichiers G et O : 

Primary reversed (Direction principale renversée): Cocher cette case si vous souhaitez pour 
des raisons techniques ou topographiques de changer l'axe de décollage du planeur par vent 
nul. 
Tow primary dir left side (Placement du remorqueur à gauche pour l'axe principal de 
décollage): Cocher cette case pour que le remorqueur soit placé à gauche du planeur lorsque 
l'axe de décollage par vent nul est utilisé.  
Tow secondary dir left side (Placement du remorqueur à gauche pour l'axe inverse de 
décollage): Cocher cette case pour que le remorqueur soit placé à gauche du planeur lorsque 
l'axe de décollage inverse est utilisé. Cela dépend de la direction et de l'intensité du vent par 
rapport à la direction principale de la piste. 

 
L/G sur OK pour finaliser la création de l'aéroport et sauvegarder la scène pour l'enregistrer 
définitivement par : "File -> Save Landscape". 

3/Disposer les Plans et les mettre à l'échelle dans Wings 3D. 

Avant d'ouvrir Wings 3D, et de charger les plans, il faudra choisir une dimension de référence étalon 
pour la mise à l'échelle des plans retenus. Pour minimiser les erreurs, il faut utiliser la plus grande 
longueur disponible, avec le maximum de contraste. Les pistes en asphalte ou en béton sont à 
privilégier. La longueur de la piste convient dans la plupart des cas. Mais entre ce qui a été inscrit 
suivant les données OACI dans Landscape Editor et la réalité, il peut y avoir des différences. En effet, 
la longueur de piste ne prend généralement pas en compte les extensions de piste, et la largeur de 
piste en béton n'est pas nécessairement la largeur retenue dans les dimensions officielles de la piste. 
 
Nous allons utiliser "Google Earth" et l'outil "Règle" pour l'aéroport de Lienz-Nikolsdorf, pour vérifier 
et finaliser les dimensions de notre "Etalon" pour la mise à l'échelle des plans. 
 
Pour la longueur des pistes, la règle permet d'évaluer la longueur de la piste à 623 m pour la piste en 
béton; très proche des 620 m annoncés. Les lignes jaunes dans les Figures suivantes. 
 

 
Figure 43 - Mesure de la Longueur de Piste/Runway Lenght Measurement. 
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Figure 44 - Mesure de la Largeur de Piste/Runway Width Measurement. 

Pour la largeur de la piste, les 30 mètres annoncés correspondent au marquage de début et de fin de 
piste en blanc avec des crochets et avec des marquages latéraux très effacés. Il y a également des 
balises 3D en extrémité de l'emprise de la piste utilisable. La piste en asphalte à une largeur de 
12.30 m. Nous retiendrons les valeurs 623 x 12.30 m, pour notre "Etalon" de mise à l'échelle des 
plans, et cet "Etalon" nous servira aussi pour la réalisation de la piste en béton. 

Création de l'étalon pour la mise à l'échelle 

Ouvrir Wings 3D 
 
Organisons-nous un peu ! 
Créons un répertoire dans "Geometry graph" par un R/D dans cette fenêtre et un L/G sur "Create 
Folder" et nommons-le : "Images". 
Passer en Mode de projection "Orthographic" pour toute la création de l'aéroport : L/G sur la 3éme 
Icône du groupe placé sur le côté droit. 
 
"File -> Merge..." 
(Fichier -> Fusionner). 
Dans la boîte de dialogue, sélectionner "EPiste" par un L/G qui se trouve dans le dossier 
"Aeroprimitive". 
Vérifier dans les options que le bouton radio est mis sur "All" (Tout). Puis L/G sur OK. 
Migrer cet objet dans le répertoire "Images" : L/G sur l'objet, L/G sur l'icône "Object", R/D sur le 
répertoire "Image" et L/G sur "Move to Folder" (Déplacer vers le Répertoire). 
 
Séquence : 
- S/E : Barre espace pour désélectionner tout. 
- Passer en Mode Arête E et L/G sur une arête latérale, parallèle à l'axe des X. 
- R/D dans la fenêtre -> L/G sur "Absolute Commands" puis L/G sur "Move" (Déplacer). 
- Dans la boîte de dialogue "Absolute move Options" dans Z, inscrire "6.15" (12.30/2 m). 
- L/G sur OK.  
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Réitérez la séquence pour la bordure opposée en tapant Z = -6.15. 
Réitérez 2 fois la séquence pour étalonner les longueurs de piste avec X = ± 311.5 (623/2 m). 
Vérifier votre travail en mode "Vertex" (Sommet) que la largeur de la piste étalon est de 12.3 m, et la 
longueur de 623 m en sélectionnant des Sommets opposés. 
Renommer "EPiste" en "Etalon" et verrouiller par un L/G sur le cadenas. 
Sauvegarder par "File -> Save" dans le répertoire de création de Lienz avec le nom "AeroLienz" 
 

 
Figure 46 - Étalon de Piste/Runway Scaling reference. 

Figure 45 - Création de l'Étalon/Creating the runway scaling element. 
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Insertion du Plan Google Earth "LienzGEMax" 

Assurez-vous que les textures soient visibles : l'item "Show Textures" doit être coché dans "View -> 
Show -> Show textures" (Vue -> Montrer -> Montrer les textures). 
 
R/D dans la fenêtre "Geometry" puis R/D sur "Image Plane". 
Sélectionner "Lienz GE Max" dans le répertoire Doc. 

Dans la boîte de Dialogue "Image Plane", sélectionner 
"Top" (vue de dessus). Puis L/G sur OK. 
 
Préparation de l'image pour la mise à l'échelle 
 
Comme l'image va être très fortement agrandie et que 
l'image n'est pas réellement sur un plan, mais sur un 
parallélépipède rectangle d'épaisseur faible, de mauvaises 
sélections peuvent entraîner des distorsions et des 
artefacts. 
Voici la méthode pour rendre "Image plane" réellement 
plan avec l'image superposée sur les deux faces : 
1/un L/G sur l'œil "Etalon" dans "Geometry Graph" va 
permettre de travailler uniquement sur l'image "Lienz GE 
Max". 

2/S/E : désélectionner tout avec la barre espace S/E, et 
passer en Mode Face F. 
3/sélectionner les 2 faces du plan, contenant les images par 

2 L/G. 
4/R/D -> L/G sur "Extract" -> L/G sur "Normal". Déplacer la souris pour écarter les faces extraites. L/G 
pour fixer l'écartement. S/E désélectionner tout. 
5/Dans "Geometry Graph" il y a maintenant 3 objets "Image" : Image2, Image2_extract3, 
Image2_extract4. Éliminer l'image initiale : R/D sur Image2 -> "Delete" (Effacer). 
6/Passer en Mode Face (appuyer sur F) et sélectionner les faces intérieures des images extraites et 
vérifier en changeant l'angle de vue de la Caméra que vous n'avez sélectionné que ces deux faces. 
7/R/D -> L/G sur "Bridge" (Ponter). 
8/A présent, il ne reste plus qu'à réduire ce parallélépipède à une épaisseur nulle. 

9/ Sélectionner un Sommet en Mode Sommet, 
Appuyer sur K -> R/D sur le sommet opposé et 
réitérer pour les 3 sommets restant, en partant du 
même plan.  
10/"Tools-> Center -> All" (Outils -> Centrer -> 
Tout) remettra le plan centré sur le centre O de 
Wings 3D. 
11/Renommer "Image2_extractx" restant en 
"LienzGEMax". Passez en mode Objet par O, L/G 

sur le plan. Vous constatez dans la ligne d'état que 
l'objet "Lienz GE Max" n'a plus que 2 Faces, 4 
Arêtes et 4 Sommets. 
 

 

Figure 47 - Options d'Image Plane/Image Plane 
Options. 

Figure 48 - Réduction du plan d'Image plane en une 
surface d'épaisseur nulle/Reducing the thickness of 
Image Plane Map to zero. 
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Mise à L'Échelle et Orientation 

1/Faites apparaître à nouveau la piste étalon : L/G sur l'œil, et passer en mode Fil de fer L/G sur 
l'icône à l'extrême droite. Le cadenas sur "Etalon" doit être fermé durant tout le procédé. 
2/Orientez sommairement l'Image : Image sélectionnée en mode Objet ou Face, R/D dans 
"Geometry", -> Rotate -> Y -> Faire tourner l'image jusqu'à l'orientation désirée, L/G pour fixer la 
nouvelle position. 
3/Mise à l'Échelle : L'image toujours sélectionnée, R/D -> Scale Uniform, déplacer la souris pour 
augmenter ou diminuer l'échelle, L/G pour fixer. Procédez en plusieurs étapes jusqu'à obtenir une 
longueur de piste sur l'image proche de la longueur de la piste étalon. 
4/Rester en Mode Face ou Objet. Avec "Move -> X" et "Move -> Z", positionnez la piste de l'image sur 
la piste étalon. Régler plus finement l'orientation avec "Rotate Y" et zoomer sur une extrémité de 
piste avec la molette de la souris. 

 
5/Pour effectuer le réglage final il faut procéder avec une méthode convergente : 
Séquence de réglage : 
a - Aligner l'extrémité de la piste de l'image "LienzGEMax" sur l'extrémité de l'étalon. 
b - Aller à l'autre bout de la piste, zoomer et faire un "Scale uniform" de la moitié de l'écart, entre la 
piste sur l'image et l'extrémité de l'étalon, en déplaçant la souris avec les touches CTRL+Alt 
enfoncées, pour bien maîtriser la mise à l'échelle uniforme. L/G pour fixer. 
c - Régler l'image, avec "Move X" et "Move Y", sur cette même extrémité de la piste, sur l'extrémité 
de "Etalon". Corriger l'orientation si nécessaire avec "Rotate Y".  
d - Retourner à la première extrémité pour voir si le réglage est correct. Sinon, faites un "Scale 
Uniform" de la moitié de l'écart entre la piste de l'image et l'étalon. 
 

Figure 49 - Technique de mise à l'échelle/Scaling Technique 
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Puis recommencer à partir de "a" la séquence de réglage. Au bout de 3 cycles, vous devez avoir un 
réglage parfait. 
N'oubliez pas de verrouiller l'image et de sauvegarder l'aéroport dans Wings 3D. 

Insertion des Plans OSM et de la tuilette 

Procéder exactement de la même manière que précédemment. 
Puis procéder à un contrôle général. Il y aura toujours de petits écarts, inférieurs au mètre entre la 
photo GE et le plan OSM, car ce n'est pas exactement les mêmes projections. 
 

 
Figure 50 - Les 3 Plans alignés et mis à l'échelle/The Three Maps scaled and lined up. 

4/ Les éléments de surface de l'aéroport 

Les éléments de surface sont limités à 4 objets intégrés dans Condor2 : "Asphalt" (Asphalte), "Grass" 
(Herbe), "Asphaltpaint" (Signalisation sur l'asphalte), "Grasspaint" (Signalisation sur l'herbe), dont 
voici les textures : 
 

 

 
Les conditions d'utilisation de ces 4 objets au sol sont les suivantes : 
- "Asphalt" et "Grass" ne doivent pas se chevaucher. 
- "Grasspaint" doit être réservé uniquement pour la signalisation sur l'herbe "Grass". 
- "Asphaltpaint" peut être utilisé indifféremment sur "Asphalt" et sur "Grass". 

Figure 51 - "Asphalt", "Grass", "Asphaltpaint", "Grasspaint", "Textures". 
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- Contrairement à "Asphalt", "Grass" n'est visible que lorsqu'on approche du sol au moment de 
l'atterrissage. Il faut donc s'assurer qu'il y a une couche sous-jacente adéquate sous l'emprise de 
"Grass" dans l'aéroport.  
- Si vous souhaitez intégrer des balises en 3D frangibles ou tout autre objet qui n'entraîne pas de 
collision, utiliser "Asphaltpaint". 
- Si, parmi ces 4 éléments, un ou plusieurs sont composé de plusieurs objets, ils doivent être 
combinés avant d'être exportés en "Wavefront" en un seul objet. 
- Il faut au moins 1 de ces 4 éléments pour créer un fichier G d'un aéroport.  

"Création des éléments "Asphalt" 

Les éléments "Asphalt" comprennent : les Pistes en dur, les Taxiways, les Parkings, les sols en dur, 
etc.. 
 
Ouvrir Wings 3D et charger le fichier "AeroLienz", passer en mode "Orthographic", taper Y, pour être 
en vue de dessus. 

Figure 52 - Construction de Taxiway1, 1ére étape/Building Taxiway1, 1st step. 

 
Comme l'étalon correspond à la piste en dur, la piste principale est déjà réalisée :. 
R/D dans "Geometry Graph", L/G sur "Create Folder". Nommer le nouveau répertoire "Asphalt". 
L/G sur Images, R/D sur "Etalon", L/G sur "Duplicate" (Dupliquer). Déverrouiller "Etalon_copy", L/G 
pour le sélectionner, R/D sur "Asphalt", L/G sur "Move to Folder" (Déplacer vers le répertoire). Le 
répertoire "Asphalt" contient 1 objet "Etalon_copy", Renommer-le "Piste", désélectionner tout et 
verrouiller l'élément "Piste" (L/G sur le cadenas). 
Revenez sur le répertoire Images. Masquer tout sauf "Lienz GEMax", par des L/G sur l'icône "Œil" des 
autres éléments. 
 
Sauf pour les cas très simples, de zones "Asphalt" il est rare d'utiliser qu'une seule primitive "EPiste". 
 
"File -> Merge -> EPiste dans "Aeroprimitive", puis déplacer cet élément dans "Asphalt". Renommer 
"EPiste" en Taxyway1.  
Passer en mode Sommet (Vertex), en appuyant sur le touche V. 
Puis tapez H pour déplacer vers la droite avec la souris ce nouvel élément, comme dans la figure 52. 
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Désélectionner tout S/E. 
Déverrouiller "Piste". 
Tapez V pour passer en mode Sommet et sélectionnez le coin supérieur gauche de Taxiway1 

Tapez le raccourci clavier J, le Sommet passe en 
surbrillance (figure 53). 
 
Mettre le curseur de la souris sur le sommet 
supérieur droit de la Piste. Celui-ci prend la couleur 

de présélection. R/D, et le premier Sommet vient 
se placer exactement sur le sommet supérieur 
droit de la Piste, avec les mêmes coordonnées 
(figure 54). 
Désélectionnez tout S/E. 
Réitérez ces opérations pour le sommet inférieur 
gauche du Taxiway1 pour le superposer sur le 

Figure 54 - 2éme étape/2nd step. 

Figure 53 - Préparation de la 2éme étape/Preparing the 2nd step. 

Figure 55 - 3éme étape/3rd step. 
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Sommet inférieur droit de la Piste. 
Verrouiller "Piste" et déplacer les Sommets gauches avec les raccourcis clavier H et N de part et 

d'autre du Taxiway (figure 55). 
Sélectionnez l'Arête supérieure et divisez-la en 10 
par : 
R/D -> Cut -> 10. 
Puis ajouter à la sélection le Sommet le plus à 
droite par un L/G. 
Déplacer par H et N cette sélection de façon que le 
Sommet le plus à gauche se trouve sur un Point 
représentatif du taxiway de l'image Google Earth. 
Une fois ce Sommet correctement positionné, 
désélectionner ce Sommet et réitérer les mêmes 
opérations pour placer le Sommet suivant, et ainsi 
de suite. Ne vous inquiétez pas des lignes noires 
qui représentent des chevauchements 
momentanés. Quand il ne vous reste plus que 2 
Sommets à placer, repositionner le sommet qui n'a 
pas été déplacé et recharger en Sommets la 
dernière arête. Cette ligne de 10 ou plus de 
sommets doit être utilisée comme un chargeur de 

Sommets prêt à l'emploi ou un réservoir qui suit le 
mouvement et reste près du dernier sommet aligné 
(figure 56). 

 
Continuer les mêmes opérations que 
précédemment en n'oubliant pas de 
sauvegarder votre fichier Wings 3D de temps 
en temps. Changer éventuellement d'Arête 
pour les diviser par 10. 
 
Un autre technique de modelage consiste à 
aligner le sommet de façon que l'arête, qui le joint au dernier sommet correctement positionné, 
tangente la courbe ou s'aligne avec le segment de droite, sans s'occuper de sa position. Ensuite, pour 
amener le sommet dans sa position définitive, un R/D pour faire apparaître les transformations en 

Figure 56 - Taxiway1 à moitié terminé/Taxiway1 half-finished. 

Figure 57 - Taxiway1 terminé/Finished. 

Figure 58 - Mise en place de Taxiway2/Positionning Taxiway2. 
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Mode Sommet, puis un R/D sur "Move" pour pouvoir sélectionner l'Arête tangente, ou alignée (tapez 
éventuellement E pour sélectionner le mode 
Arête). Puis, faire glisser le sommet le long de 
cette arête jusqu'à atteindre la position désirée 
en déplaçant la souris. Terminer par un L/G 
pour fixer la position et un L/G sur le Sommet 
pour le désélectionner, avant de passer au 
suivant. 
 
Pour éviter toute erreur, toujours positionner 
les sommets sur les limites de la zone "Asphalt" 
en cours de construction en tournant dans le 
même sens, sauf cas particulier évident. 
 
 
Pour faire les autres éléments "Asphalt", 
fusionnez un nouvel "EPiste", transférez-le dans 
le répertoire "Asphalt" et nommez le 
"Taxiway2". 
Placer ce nouvel élément le long de la bordure 
de la Piste : 
Sélectionner Taxiway2 en mode Objet : L/G sur 
Taxiway2 -> Tapez O. 
Déplacement : R/D pour le menu -> L/G sur 
"Absolute Commands" -> L/G sur "Snap". 
Passer en mode Arête, Tapez E. Puis L/G sur 
l'Arête supérieure de Taxyway2 et R/D pour 
confirmer la sélection. 
Déverrouiller "Piste" puis R/D sur l'Arête 
inférieure de la piste. Taxiway2 se trouve long 
de la piste et l'élément Piste est 
automatiquement verrouillé. 
Passer en mode Sommet, touche V, et déplacer 
taxiway2 le long de la piste avec H (figure 58). 

Ensuite, utiliser les techniques développées ci-dessus 
pour modéliser Taxiway2. 
 
La jonction avec taxiway1 se fait avec le raccourci 
clavier J de la manière suivante : 
S/E, désélectionne tout, et sélectionner le prochain 
point du contour. En Mode V, déverrouiller taxiway2, 
taper J, et, R/D sur le sommet du chemin haut. 
Désélectionnez tout, sélectionnez en Mode V le 
Sommet suivant de Tawxiway2, tapez J, R/D sur le 
sommet du chemin bas. Verrouillez Taxiway1. 
 
Continuer la modélisation de Taxiway2. Mais vous ne 
pourrez pas terminer cette partie sans ajouter un 
troisième "Élément de piste" à cause de la présence 
d'inclusions de surface herbeuse. 
 
Fusionnez un nouvel "EPiste", nommez le Taxiway3 et 

Figure 60 - Taxiway2 terminé/Taxiway2 finished. 

Figure 61 - Mise en place de Taxiway3/Positioning Taxiway3. 

Figure 59 - Taxiway2 en cours/Taxiway2 in progress. 
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déplacez-le dans le répertoire "Asphalt". 
En sélectionnant l'un après l'autre chacun des sommets de Taxiway3, avec, à chaque fois, J, et un 
R/D, positionner Taxiway3 comme indiqué sur la figure 61. 
 
Il ne reste plus qu'à ajouter et positionner quelques Sommets pour parfaire Taxiway3. 
 
Il reste une dernière partie à modéliser dans le bas à gauche, comprenant un chemin et une cour de 
ferme. 
 
Fusionnez un nouvel "EPiste", nommez-le Taxiway4 et déplacez-le dans le répertoire "Asphalt". 

 
Avec l'aide des techniques précédentes, modéliser taxiway4. Puis verrouiller tout. 
 
Pour terminer la partie "Asphalt",il faut reprendre l'élément "Piste" pour lui ajouter quelques 
Sommets et modéliser les 3 départs de chemin en dur : 
Déverrouiller "Piste" puis E (figure 62). 
L/G sur une arête longitudinale de la "Piste". 
R/D -> R/D sur Cut. Un nouveau Sommet est créé en extrémité de l'arête que l'on fait glisser le long 
de l'arête en déplaçant la souris, pour le positionner à l'endroit voulu. Avec cette technique, 
positionnez 8 sommets grossièrement autour des flèches jaunes de la figure 61. 

Figure 62 - Finition des éléments "Asphalt"/Finishing "Asphalt" Elements. 
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En premier lieu, il faut positionner les sommets techniques sur les sommets de taxiway2 qui sont 
reliés à la piste en utilisant le raccourci clavier J. 
 
Puis on sélectionne les 3 arêtes se trouvant entre les Sommets que l'on a positionnés grossièrement ; 
R/D -> L/G Cut -> 3. 
Ensuite, avec les raccourcis clavier H et N il faut positionner les sommets pour modéliser ces 3 
départs de chemin en béton. 
Si nécessaire, pour le départ du chemin en dessous de la piste, à gauche, insérez un ou deux 
Sommets pour parfaire la modélisation. 
 
"Asphalt" est terminé.  
 
Vérifier en détail votre travail. Ajuster la position de certains Sommets si nécessaire. Verrouiller tout 
et sauvegarder l'aéroport. Toutefois, si vous utilisez "Muck" pour créer des textures "Asphalt" 
présentant des couleurs ou textures différentes, et afin d'éviter des effets de bord, il faut réaliser les 
différents éléments "Asphalt" en prenant en compte les limites de ces différentes textures afin 
qu'elles soient autant d'îlots séparés dans la Carte du Patron. À une texture particulière sur une 
surface délimitée doit correspondre un élément "EPiste" particulier. 
 
Voici le résultat pour Lienz-Nikolsdorf avec les 3 plans T4570, UTM_OSM et GE: 
 
Vous pouvez constater que nous nous sommes avant tout référés à la tuilette de AA2, là où sera 
intégré l'aéroport. 

 
 

Création des éléments "Grass" 

Méthode traditionnelle : 

Créer un répertoire "Grass". 
Il faut procéder presque de la même manière que pour 
créer un élément "Asphalt", sauf qu'il faut superposer 
les sommets de "Grass" sur les Sommets de 
"Asphalt".grâce au raccourci clavier J. La plupart des 
sommets délimitant l'emprise de l'aéroport seront à 
placer avec les raccourcis clavier H et N. 
 
- Fusionner un "EPiste". 
- Renommer "EPiste" en "Grass1". 
- Déplacer "Grass 1" dans le répertoire "Grass". 
- Placer 2 sommets consécutifs sur 2 sommets 
consécutifs de "Piste" en utilisant la séquence : 

Figure 63 - Éléments "Asphalt" dans les 3 plans/"Asphalt" elements in the 3 maps. 

Figure 64 - Grass1 en cours d'élaboration/Making of 
Grass1. 
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V -> L/G pour sélectionner le sommet (suivant) de "Grass1" -> J -> R/D sur un sommet de "Asphalt" -> 
S/E. 
- Sélectionner une des 
branches adjacentes du 
quadrilatère: R/D -> Cut -> 10 -
> L/G. 
- En utilisant H et N placer un 
ou 2 sommets en périphérie. 
- Continuer la superposition 
des sommets avec la séquence 
J. 
 
En fusionnant un nouvel 
"EPiste" et en suivant le même 
procédé, "Grass2" est créé. 

En réitérant les mêmes opérations, pour chacun des éléments "Grass" restants, "Grass3", "Grass4" et 
"Grass5" seront créés. 

 
 

Vous noterez qu'il faut autant de sommets "Grass" que de sommets "Asphalt" si "Asphalt" est 
totalement inclus dans "Grass". Il faut ajouter les Sommets périphériques délimitant l'emprise de 
l'aéroport. 
En l'état, les zones "Grass" 1 à 5 sont terminées. 

Méthode par différence booléenne 

Bien que la méthode traditionnelle soit parfaitement sûre, il existe une méthode par différence 
booléenne, bien plus élégante et souvent plus rapide, mais plus délicate à mettre en œuvre. 
 
Il y a deux choses que ne supportent pas les fonctions booléennes de Wings 3D : 
- Les éléments d'épaisseur nulle. 
- La coplanarité de 2 surfaces. 
Bien que l'algèbre de Boole admette facilement ces 2 cas, ces incompatibilités surviennent souvent 
lorsque l'on passe de la théorie à la mise en place d'un calcul informatique qui fonctionne toujours 
avec des valeurs finies. 
 

Figure 65 - Grass1 terminé/Grass1 finished. 

Figure 66 - Tous les éléments "Grass" 1 à 5 terminés/All "Grass" elements 1 to 5 finished. 
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Si l'une de ces deux conditions est rencontrée au cours du calcul booléen, Wings 3D signale cette 
anomalie en indiquant que : 
- des plans coplanaires ont été rencontrés. 
- une erreur interne s'est produite. 
Ou le programme tourne en boucle indéfiniment, sans aucun avertissement. 
 
La différence booléenne avec Wings 3D fonctionne de la manière suivante entre deux objets qui ont 
des volumes communs : 
- Sélection en mode Objet de l'objet principal, sur lequel les parties communes avec le deuxième 
objet vont être détruites, puis : 
R/D -> L/G sur "BOOLEAN Test" -> L/G sur "Difference" -> Apparition de la fenêtre : "Select the Object 
to subtract from" (sélectionner l'objet à soustraire de...) -> L/G sur l'objet à soustraire. 
Au bout de quelques dizaines de secondes, le résultat apparaît. L'objet qui a été soustrait a 
totalement disparu. Il faudra seulement sur la surface supérieure que l'on va extraire, pour faire le 
nouvel élément "Grass", éliminer de nombreuses Arêtes superflues et en garder quelques-unes. Il y 
aura aussi quelques trous à faire, pour obtenir une nouvelle zone "Grass" parfaite. 
 
Voici la méthode détaillée pour Lienz-Nikolsdorf. 
 
- Sauvegarder le fichier de l'aéroport "AeroLienz", puis créer une copie de l'aéroport par "File -> Save 
As" en lui donnant un nouveau nom, par exemple : "AeroLienzTestBool". 
 
Cette copie est déjà chargée, car la fonction "Save As" change le nom du fichier en cours pour le 
nouveau nom choisi. Il est alors loisible de travailler directement sur celui-ci, tout en gardant intact le 
travail déjà effectué lors de la dernière sauvegarde du fichier original. 
 
Préparation de l'élément "Grass" : 
 

 

Figure 67 - Création de l'élément "GrassB"/Creating "GrassB" element. 
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- Fusionner un nouvel "EPiste". Transférez-le dans le répertoire "Grass" et nommez le "GrassB". 
 
- Modéliser l'emprise de l'aéroport. On peut s'inspirer du contour extérieur des éléments "Grass" 
déjà modélisés, mais pour un nouvel aéroport c'est la méthode standard déjà développée pour les 
éléments "Asphalt" et "Grass". 
Cet élément de 15 Sommets se construit en quelques minutes alors que pour créer "Grass" 1 à 5 il 
faut plus d'une heure pour placer les 210 Sommets, malgré les raccourcis clavier. 
 

- Rendre invisibles les autres éléments "Grass", "Asphalt" et les images par des R/D sur l'œil. 
- Sélectionner en Mode Face la face supérieure de GrassB 
R/D -> Extract - Y -> Tab -> 30 -> OK -> S/E. Réitérer avec 20 pour le "Numeric Input" (Entrée 
Numérique) sans S/E. 
- Sélectionner la face inférieure du premier Extract -> Bridge 
- Renommer cet objet en "GassBV". 
- Verrouiller et rendre invisible les 2 objets. 
- Sauvegarder le fichier.  
 
L'objet "Grass" est prêt. 
 
Préparation de l'élément "Asphalt" : 
 
- Rendre visibles les 5 éléments "Aspahlt" (L/G et R/D sur l'œil) 
 
 
 

Figure 68 - Création du volume GrassBV/Creating "GrassBV" volume. 
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Figure 69 - Reconnaissance des Arêtes coplanaires/Spotting coplanar Edges. 

 

Figure 70 - Arêtes coplanaires déplacées/Moved coplanar Edges. 
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- Une petite réflexion s'impose sur les coplanarités : 
 
* Elles sont soit une interférence avec l'élément GrassBV. Mais nous avons construit GrassB pour que 
cela ne se produise pas, car il n'y a pas de Sommets et d'Arêtes communs avec les éléments 
"Asphalt". 
* Soit, elles sont dues aux liaisons entre les différents éléments "Asphalt" qui deviendront des plans 
coplanaires lorsqu'on passera du plan au volume, en utilisant la technique exécutée pour créer 
GrassB. 
Pour éviter ce genre d'ennui, il suffit d'écarter légèrement une des Arêtes communes de quelques 
décimètres (1/10 unité Wings), en notant le sens, car il sera facile en fin de processus de refaire la 
géométrie initiale par soudage de Sommets. 

 
 
 
- Séparer les Arêtes superposées de chaque 
élément "Asphalt", afin d'éviter la coplanarité 
lorsqu’on passera en volume : R/D sur l'Arête 
superposée de l'élément déverrouillé 
"Asphalt" -> R/D sur "Move" -> L/G sur une 
des Arêtes adjacentes -> Déplacer la souris 
pour créer l'écart -> L/G pour fixer. 
 
- Sélectionner en Mode Face, les 5 faces 
supérieures des 5 éléments "Asphalt" 
R/D -> Extract - Y -> Tab -> 50 -> OK -> S/E 
réitérer la séquence avec 10 pour le "Numeric 
Input". 
- Ponter élément par élément, les "Extracts" 
inférieurs (à 10 m) avec les "Extract" 
supérieurs (à 50 m), en sélectionnant les faces 

opposées : R/D -> "Bridge". 
 
- Passer en mode Objet, sélectionner les 5 éléments Extract (Piste_extract, etc.) puis R/D  
-> "Combine". 
- Renommer le résultat en "AsphaltBV" et verrouiller. 
- Rendre invisibles tous les éléments "Asphalt", sauf "AsphaltBV". 
- Sauvegarder votre fichier. 
- Faire une copie de "AsphaltBV" : R/D sur "AsphaltBV" dans "Geometry Graph" -> "Duplicate". 
 
L'objet "AsphaltBV" est prêt. 
 
Exécution de la différence booléenne : 
 
- Déverrouiller "AsphaltBV". 
- Rendre visible et déverrouiller GrassBV. 
- En mode Objet, sélectionner : GrassBV. 
 

Figure 71 - Création du volume "AsphaltBV"/Creating 
"AsphaltBV" volume. 
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Figure 72 - "GrassBV" sélectionné et "AsphaltBv" en place/"GrassBV" selected and "AsphaltBV" displayed. 

R/D -> L/G sur "Boolean Test" -> L/G sur "Différence" -> L/G sur "AsphaltBV" -> R/D pour exécuter. 
 
Attendre et espérer (ou prier) pendant quelques dizaines de secondes si les objets sont complexes ! 
 

 
Figure 73 - Résultat de la différence booléenne sur "GrassBV"/Result of the boolean difference upon "GrassBV". 

Ce nouvel objet s'appelle toujours "GrassBV" et se trouve dans "Object". L'objet "AsphaltBV" a 
disparu. 
 
De nombreuses Arêtes ont été créées pendant le processus booléen. 
La plupart de ces Arêtes sont superflues, bien qu'elles soient recréées lors de la triangulation lors de 
l'exportation en "Wavefront". Pour éviter des erreurs, sauf pour des cas simples, il faut les éliminer 
avec précaution sur la seule surface supérieure. 
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Voici un exemple très grossi où il est évident 
qu’entre 3 sommets consécutifs, une Arête a été 
créée lors du processus, sinon le processus crée 
des zones quadrangulaires. 
Lors de l'élimination des arêtes, méfiez-vous des 
angles. 
Méfiez-vous des sélections intempestives. 
Si à un moment vous constatez que des arêtes 
sont automatiquement créées, c'est qu'une Arête 
de bordure a été par erreur effacée. Revenez en 
arrière par plusieurs "Undo" et vérifiez la 
géométrie de l'objet. 
 
Les 7 ponts entre les 5 éléments doivent être 
gardés avec leurs 2 arêtes de fermeture. 
 

Dans le contrôle final, examinez chaque angle avec un fort zoom et en perspective orthographique, 
pour vérifier l'intégrité de votre géométrie et éliminer les Arêtes de la surface qui auraient pu vous 
échapper. 
 
 
 

Figure 74 - Arêtes superflues/Unecessary Edges. 

Figure 75 - Arêtes nécessaires à la fermeture des ponts/Necessary Edges to close the bridges. 
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- Sélectionner les 5 parties de la surface en mode Face. Les Ponts ne doivent pas être sélectionnés. 
C'est pour cela que l'on a conservé les arêtes d'extrémités. 

 
R/D -> Extract -> Y. 
Tools -> Put on the Ground. 
Déplacer "GrassBV" en dessous du sol et 
verrouiller, puis Y puis passer en Mode 
Sommet. Les Ponts sur GrassBV vous 
permettent d'identifier les sommets sur la 
partie extraite et qui ont été déplacés pour 
éviter les problèmes de coplanarités. 
Sur la partie extraite, au-dessus des 7 
ponts de "GrassBV" il faut remettre les 14 
sommets déplacés dans leurs positions 
initiales par un soudage sur le sommet 
resté fixe. C'est l'inverse du déplacement 
précédent pour éviter la coplanarité qu'il 
faut effectuer à présent pour retrouver la 
géométrie d'origine. 
Pour chaque sommet : 
V -> L/G pour sélectionner le sommet -> K 
-> R/D sur le sommet resté fixe (figure 77). 
 
Ensuite, sélectionnez les 5 éléments, 
passez en mode Objet et combinez-les 
avec "Combine". 
Renommer la partie extraite combinée en 
"Grass". 
 
Passer en Mode Face. Sélectionner les 5 

Faces inférieures de l'élément "Grass". 
R/D -> "Hole". 
 
Sélectionner "Grass" en mode O, puis passer en Mode E. 
R/D -> Hardness -> Hard. 
Toutes les Arêtes de "Grass" sont dures. 

Figure 76 - "GrassBV" prêt pour l'extraction/"GrassBV" ready for extract. 

Figure 77 - Élimination des sommets superflus sur l'élément "Grass" extrait de 
"GrassBV" pour revenir à la géométrie initiale/Eliminating the unnecessary 
vertices upon "Grass" elements, extract from "GrassBV", in order to come 
back to the initial geometry. 
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Sauvegarder votre fichier par : 
File -> Save 
 
L'élément "Grass" est terminé. 
 
Mais les éléments "Asphalts" ont été modifiés. 
Pour transférer "Grass" dans le fichier original, il faut procéder de cette manière : 
 
O -> L/G sur "Grass" -> File -> Save selected -> Nom : "GrassBol" -> L/G sur Save. 
File -> Save. 
File -> Open -> "GrassBol". 
Ensuite, il faut procéder au nettoyage des éléments superflus se trouvant dans "Outliner" dans 
"GrassBol", tout en gardant et assignant un seul matériau à "Grass" et une seule texture et en 
éliminant tout le reste : 
- Assignation du matériau : O -> L/G sur "Grass" -> R/D sur "EPiste_auv" dans "Outliner" -> L/G sur 
"Assign to selection". 
 
- Élimination des autres matériaux : R/D sur "Episte_Auv2", etc.. -> L/G sur "Delete" 
- Élimination des images. Seule l'image liée au matériau ne sera pas effaçable : R/D sur une image -> 
L/G sur "Delete" ou "Delete texture". Réitérer ces opérations pour éliminer les images restantes. 
- Renommer le matériau et la texture restant en "Grass". 
- Éditer le matériau : R/D sur "Grass" dans "Outliner" -> L/G sur "Edit material" -> L/G sur "Base 
Color" -> L/G sur un vert -> L/G sur OK -> File -> Save. La couleur verte n'est là que pour teinter 
"Grass" en vert dans Wings 3D pour ce tutoriel. 
 
Sauvegarder le fichier "GrassBol". 
 

Figure 78 - Préparation de l'élément "Grass" pour la fusion/Preparing the"Grass" element for merging. 
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Le fichier "GrassBol" doit être identique à l'extrait ci-dessus pour pouvoir être fusionné dans le fichier 
principal. Examiner attentivement les fenêtres "Geometry Graph" et "Outliner". 
 
 
Ouvrir "AeroLienz", et fusionner "GrassBol" 
Vérifier en détail que tout est correct, puis sauvegarder 

Figure 79 - L'élément "Grass" booléen dans "Aerolienz"/Boolean "Grass" element in "Aerolienz". 

Corrections sur "Grass" et "Asphalt" 

Plusieurs difficultés peuvent surgir lors de la création des éléments "Grass" et "Asphalt". 

Planéités des éléments. 

Pour corriger ou s'assurer de la planéité, voici une méthode : 
O pour passer en Mode Objet. 
L/G pour sélectionner l'élément "Grass" ou "Asphalt". 
V pour passer en mode Sommet. 
R/D -> Flatten -> Y pour mettre tous les sommets sur un plan perpendiculaire à l'axe Y 
R/D -> Absolute Commands -> Move -> Absolute Move Option -> Y=0, pour mettre ou vérifier que 
tous les sommets sont sur le sol. 

Correction des contours de "Asphalt" et "Grass" 

Il est toujours possible de changer les contours de "Grass" et "Asphalt", d'ajouter ou de supprimer 
des sommets à tout moment de la création de l'aéroport.  
 
La seule difficulté se trouve sur les contours communs de "Grass" et "Asphalt", là où les sommets de 
"Asphalt" sont superposés aux sommets de "Grass". Il suffit de procéder avec méthode. 
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Il faut d'abord identifier l'élément "Grass" ou "Asphalt" dont la surface va diminuer. Ensuite, il faut 
commencer les corrections sur cet élément en le déverrouillant, puis en déplaçant les sommets sur 
des positions plus adéquates. Il vous faudra peut-être ajouter des sommets complémentaires. 
Normalement, un espace vide va se créer entre les deux éléments, surtout si vous ajoutez des 
sommets. Pour le combler et éviter tout chevauchement, déverrouillez l'élément adjacent, ajoutez le 
même nombre de sommets que sur le premier élément le long de l'espace vide et utilisez le raccourci 
clavier J pour remettre tous les sommets les uns au-dessus des autres. Une méthode plus périlleuse 
consiste à effectuer sur les 2 contours une sélection des sommets en traçant un cadre de sélection 
avec la souris, puis à déplacer les Sommets. 

Chevauchement ou vide entre des contours de "Asphalt" et "Grass" 

Dans Wings 3D, les chevauchements sont difficiles à trouver, mais ils ont des répercussions sur le 
rendu final de l'aéroport. Ils se produisent souvent lorsqu'on a oublié de désélectionner le sommet 
que l'on vient de placer sur le sommet d'un autre élément et que l'on passe au suivant, ou lorsqu'on 
saute par oubli un sommet dans un contour entre deux éléments. Il faut donc examiner avec soin la 
géométrie puis procéder aux corrections comme indiqué ci-dessus. 
Si vous utilisez la méthode booléenne, les risques de chevauchement sont faibles, par contre vous 
risquez plus d'avoir des espaces vides si le nettoyage des Arêtes n'est pas fait correctement. 

Création des Éléments "Asphaltpaint" et "Grasspaint" 

Les éléments "Asphaltpaint" et "Grasspaint", comme les chiffres, les flèches, les barres, les chevrons 
sont tous normalisés, conformément à l'Annexe A de l'OACI (ou l'Annexe 14, livre I en Anglais). Ce 
document de 77 pages ou sa version anglaise de 352 pages (Démarrez au chapitre 5) peuvent être 

Figure 80 - Extraits de l'Annexe A/Samples from Annexe 14, book 1. 
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trouvés et téléchargés gratuitement sur Internet. Il suffit de chercher.  
Voici 2 extraits significatifs, qui ne vous dispenseront pas d'une lecture approfondie, et de la création 
d'éléments particuliers, à construire au fur et à mesure des besoins, sous la forme de primitives à 
fusionner dans Wings 3D. 
 
L'examen de toute la documentation glanée sur Internet pour Lienz-Nikolsdorf montre de grandes 
disparités dans l'état des lieux, suivant la date de la prise de vue, avec des parties effacées ou très 
dégradées. 
 
Toutefois, il ressort de l'examen des photos qu'il y a une piste balisée par des marques au sol sur 
l'herbe à ± 15 m et un marquage par des balises 3D correspondant à l'emprise de la piste des avions 
et planeurs et à l'emprise des aires d'atterrissage des hélicoptères et enfin des marquages standards 
pour la piste en béton. 
 
La tuilette t4570 montre également la présence d'un cercle avec au centre une manche à air et de 
deux carrés blancs avec un H. 
 
 
Création des primitives spécifiques : 

 
Pour créer la primitive "cercle", partir d'un 
tube (R/D sur la primitive "Cylinder") en 32, 
ou 64 sections, diamètre 15, épaisseur 1.2, 
extraire la face supérieure, la mettre au sol, 
durcir les arrêtes externes, etc.. 
 
Pour le carré, idem à partir d'un tube à 
4sections. 
 
À partir de "EPiste", vous pouvez créer tous 
les signes que vous souhaitez. 
 
Charger "AeroLienz" dans Wings 3D et créer 
un répertoire "Asphaltpaint" et "Grasspaint" 
dans "Geometry Graph" 
Fusionner le carré, déplacer et adapter au 

1er emplacement, dupliquer, déplacer et 
adapter au 2ème emplacement. Fusionner le 
cercle, déplacer et adapter à l'emplacement. 

 
Ensuite, on va s'occuper des marquages de la Piste. 
 
Pour cela on va fusionner des objets déjà préparés et conformes aux prescriptions de l'Annexe A de 
l'OACI (ou Annexe 14, livre I en Anglais). 
 
Il faut d'abord tracer un support rectangulaire autour de la piste, pour servir de repère aux bandes 
latérales de signalisation sur l'herbe. Cet objet appelé "Piste Herbe" sera transféré dans le répertoire 
"Images" et il sera mis en fil de fer (L/G sur l'Icône à droite dans "Geometry Graph") et verrouillé. 
 
Puis on va fusionner les éléments suivants déjà prêts dans notre banque de signes : 
 

Figure 81 - Cercle et Carrés Asphaltpaint/"Asphaltpaint" 
Squares and Circle. 
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- Un seuil de piste que l'on va un peu modifier en forme de crochet, dupliquer, retourner et placer le 
deuxième seuil. 
- 4 Bandes de seuils que l'on va également dupliquer et placer 
- Une orientation de piste 12- 30 que l'on va réduire pour être adaptée aux dimensions de la piste en 
béton. 
- un axe de piste que l'on va dupliquer pour couvrir la longueur de piste. 
Ces éléments seront regroupés dans "Asphaltpaint". 
 
Puis on va finir les éléments "Asphaltpaint" en marquant les extrémités de l'emprise de la piste 
d'atterrissage des avions et des hélicoptères avec des balises pyramidales frangibles (3D) et en 
posant des bandes d'arrêts sur les taxiways. 
 
Pour les éléments "Grasspaint", les marquages latéraux sur la piste en herbe sont présents, bien que 
souvent très effacés. Nous procédons de manière semblable à celle utilisée pour la construction des 
éléments "Asphaltpaint".  
 
Voici le résultat final : 

Figure 82 - Disposition des éléments "Asphaltpaint" et "Grasspaint" sur la piste/General lay out of "Asphaltpaint" and 
"Grasspaint" elements upon the runway. 

5/ Créer les bâtiments, hangars, tour de contrôle, etc.., de l'aéroport. 

Il faut créer une quinzaine de bâtiments pour Lienz-Nikolsdorf. 
Au vu des photos, il y a, semble-t-il, 3 tours de contrôle, dont 2 inutilisées et 3 manches à air. 
 
Tous les bâtiments seront d'abord modélisés, avant d'être dépliés et texturés, afin de séparer et 
analyser ses 2 étapes de ce processus de création, mais rien ne vous empêche de faire ces 2 étapes 
au fur et à mesure de la création des bâtiments 
 
Les objets de ce type sont tous des objets qui vont entraîner des crashs lors d'une collision. 
Comme indiqué précédemment, nous n'allons créer que les objets qui sont immobiliers par 
destination. 
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Créons un répertoire que nous appelons "Hangar", où tous les bâtiments du fichier O de l'aéroport 
seront rassemblés. 
 

Modélisation des Bâtiments 

Hangar HLn01 
1/Fusionner un Hn, migrer HLn vers Hangar, renommer 
en HLn01 et déplacer-le vers le hangar à toit plat à 
l'extrême droit en bas. Vérifier que vous êtes en vue de 
dessus et en projection orthographique. Examinez les 
photos de ce hangar dans le dossier Doc créé au 
chapitre 1 de la modélisation. 
 
2/Orienter la primitive de façon à ce que les Arêtes du 
bâtiment soient parallèles aux bordures du plan de ce 
hangar :  
S/E -> L/G sur HLn01 -> O -> R/D -> Rotate -> Y -> 
Déplacer la souris -> L/G pour fixer la position. 
 
3/Sélectionnez une face latérale et déplacez-la sur la 
bordure du plan de ce hangar : 
S/E -> F -> Sélection d'une face -> R/D -> Move -> 
Normal  
-> Déplacer la souris -> L/G pour fixer. 
 
4/Sélectionner une face adjacente et réitérer 

l'opération. 
 
5/Si nécessaire finaliser l'orientation. 
 
6/Réitérer l'opération 3 pour les 2 autres faces restantes. 
 
7/Pour le moment on ne retouche pas la hauteur du hangar. Lors de la réalisation des autres 
bâtiments, pour respecter les proportions, la hauteur sera abaissée à 6.2 m. 
 
Hangar HLn02  
On choisit de modéliser le hangar adjacent. 
L'examen des photos montre que nous sommes en présence de plusieurs bâtiments accolés. 
voici les seules photos à notre disposition : 
 

 
Figure 84 - HLn02 Photos/Pictures. 

Figure 83 - Positionnement de HLN01 sur la carte 
OSM/Positioning HLn01 upon OSM Map. 
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1/ Réitérer les opérations 1 à 6 précédentes pour HLn02, sans vous occuper de la distorsion générale. 
 
2/Procéder au découpage des différentes parties du bâtiment en créant des lignes aux 1/5 selon l'axe 
X et 1/3 selon l'axe Z 
 
3/Puis, extruder le toit légèrement et une deuxième fois pour la partie légèrement surélevée 
 

4/Créer les pans de toitures en sélectionnant 
les 4 Arêtes perpendiculaires puis C. 
Par "Move Y", soulevez légèrement le faîtage, 
pour donner de la pente aux toitures. Aidez-
vous des photos et passez en mode 
perspective pour apprécier les pentes 
relatives. Abaisser l'arête de l'appentis. 
Attention, le bord de la toiture doit être 
compris entre 2.7 et 3 m. 
À partir de cette référence, vous pouvez 
pratiquement retrouver toutes les positions 
relatives des hauteurs du bâtiment en vous 
aidant des photos. C'est bien plus précis que 
vous pouvez le penser, car l'œil humain est 
finalement très efficace. 
 
5/En sélectionnant les bonnes Arêtes du 
bâtiment, on va déplacer l'arrière du 
bâtiment en 3 étapes, de façon qu'il soit 

conforme au plan OSM.  
- Le premier déplacement, le long de l'axe X, concerne le positionnement de la séparation entre 
hangar et bureaux sur la limite du bâtiment. 
- Le deuxième déplacement, toujours le long de l'axe X, après avoir désélectionné les arêtes 
correctement placées, consiste à aligner la face latérale des bureaux sur la limite du bâtiment, afin 

que tout soit aligné correctement, en particulier 
le faîtage de la toiture. Vous constaterez que tout 
est alors correctement positionné, sauf 2 arêtes 
verticales et la face arrière du bâtiment. 
- Le troisième déplacement, le long de l'axe Z, 
après avoir sélectionné les arêtes verticales 
arrière des bureaux consiste en deux 
mouvements comme précédemment à les 
aligner sur les limites du bâtiment selon le plan 
OSM. Il ne reste plus qu'à aligner le Sommet 

arrière du faîtage sur la limite, et à vérifier la 
planéité des faces du bâtiment. Quelques 

retouches seront peut-être nécessaires. 
 
6/Pour terminer, il faut greffer les 2 appentis sur les parties latérales par extrusion le long de la 
normale, après avoir créé les découpages des parois verticales correspondantes. Puis abaisser l'Arête 
supérieure externe, pour adapter la pente de la toiture. 
 
7/Il faut ensuite éliminer les Arêtes et les Sommets superflus et rendre dures les arêtes, pour 
terminer l'un des hangars les plus complexes de la modélisation. 

Figure 85 - Modelage de HLn02/Modeling HLn02. 

Figure 86 - HLn02, 03, 04 terminés/finished. 
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Hangar HLn03 
Il s'agit de la supposée tour de contrôle à l'arrière du hangar HLn02. 
 
1/Fusionner un Hn, déplacer, faire pivoter, adapter la géométrie, régler la hauteur. 
 
2/Sélectionner les 2 arêtes supérieures, couper et soulever pour faire la toiture. 
 
3/Exceptionnellement pour le rendu visuel, il faut créer les grandes dépassées de toiture. 
Procédez de la manière suivante : 
S/E -> F -> Sélectionner les 2 pans de toiture -> R/D -> "Extrude" léger -> S/E -> F -> Sélectionner la 
surface des bandeaux de toitures -> R/D -> "Extrude" -> Déplacer la souris jusqu'à obtenir l'effet 
désiré. 
 
4/Eliminer les Arêtes superflues générées. Rendre toutes les Arêtes dures. 
 
3/Retoucher le tout en vous aidant des photos. Et déplacer HLn dans Hangar et renommer-le HLn03. 
 
Hangar HLn04  
Il s'agit de la tour de contrôle demi-octogonale plaquée contre l'appentis du hangar HLN02. 
 
1/Il faut d'abord créer une primitive adéquate. 

Lancer une nouvelle instance de Wings 3D. 
R/D -> R/D sur "Cylinder"-> Remplir les options "Sections" 8 et cochez 
"Put on Ground". 
S/E -> O -> L/G sur l'octogone -> R/D -> Rotate -> Tab -> 22.5° -> OK. 
S/E -> V -> Sélectionner les 4 premiers points dans les Z positifs à 
0.382 -> C. 
S/E -> E -> Sélectionner une des 2 arêtes parallèles à X -> L -> R/D -> 
L/G sur "Loop Cut" -> Eliminer la petite partie en surbrillance -> R/D 
sur "Cylinder1_cut2" dans "Geometry Graph" -> L/G sur "Delete". 
S/E -> V -> Sélectionner 2 sommets opposés de l'octogone sur la face 
supérieure -> C. 
S/E -> E -> Sélectionner l'Arête diamétrale qui vient d'être créée -> 

R/D -> L/G sur "Cut" -> L/G sur 2. 
S/E -> V -> Sélectionner le sommet central et un des 4 sommets -> C. 

Réitérer avec les 3 sommets restants. 
S/E -> E -> Sélectionner l'Arête//X sur la face supérieure -> R/D -> L/G sur "Cut" -> L/G sur 2. 
S/E -> V -> Sélectionner ce nouveau Sommet et le sommet Central -> C. 
S/E -> F -> Sélectionner la face inférieure et la face arrière -> R/D -> L/G sur "Hole". Répéter si 
nécessaire. 
S/E -> O -> L/G sur Cylinder1 -> E -> R/D -> Hardness -> L/G sur Hard. 
 
La nouvelle primitive est prête. Renommez la HLn et sauvegardez-la dans "Aeroprimitive" sous le 
nom "OctogT". Fermer cette instance de Wings 3D. 
 
2/Fusionner une instance de cette primitive dans "AeoLienz". 
Renommez-la HLn04 et faites-la migrer dans Hangar. 
Déplacez-la contre le hangar HLn02 de la manière suivante : 

Figure 87 - Primitive "OctogT". 
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S/E -> O -> L/G pour sélectionner Hln04-> R/D -> L/G sur "Absolute Commands" -> L/G sur Snap -> 
L/G pour sélectionner une Arête verticale d'extrémité -> R/D pour confirmer -> Déverrouiller HLn02 -
> L/G sur l'Arête verticale de l'appentis -> R/D pour exécuter l'action. 
 
Par des "Scale Uniform", des déplacements sur et le long de la façade, et des contrôles successifs, 
positionner et mettre à l'échelle hangar HLn04, jusqu'à obtenir quelque chose de satisfaisant par 
rapport aux photos. 
 
Réaliser le "redan" au bas des fenêtres : 
S/E -> E -> Sélectionner une Arête verticale -> G -> C -> S/E -> E -> Sélectionner une arête verticale 
supérieure -> G -> C -> Move Y -> positionner le haut du redan -> E -> R/D sur "Scale Uniform" -> M/C 
-> L/G sur le sommet arrière central supérieur -> R/D pour exécuter -> Déplacer la souris pour former 
le redan -> L/G pour fixer. 
En déplaçant les lignes horizontales, ajuster le redan pour obtenir quelque chose de satisfaisant par 
rapport aux photos. 
 
Hangar HLn05 : 
Il s'agit d'un muret entourant au 3/4 une zone 
contenant des appareils météo. 
Fusionnez une nouvelle primitive Hn : S/E -> File 
-> Merge -> Hn 
Renommez-la HLn05. 
Ramener les dimensions à : largeur 0.3 m et 
hauteur 0.90 m. 
Sélectionnez l'extrémité à droite en mode Face 
par un L/G. 
R/D -> Sweep -> Sweep -> Y -> Tab -> D =5,  
A= 45° 
Réitérez avec les mêmes valeurs. 
À partir de cet élément, déplacer, faire tourner, 
diminuer, etc., pour adapter le muret aux plans. Il n'est pas tout à fait rectangulaire. 
 

Hangar HLn06 :  
il s'agit de la nouvelle tour de contrôle dans 
un bâtiment préfabriqué, avec un escalier 
extérieur, posé sur une structure métallique à 
2.5 m du sol et un toit largement débordant. 
Les dimensions estimées sont de 2.4 x 6.2 m 
hauteur 2.5 (soit celle d'un module Standard). 
 
En l'absence de primitive on part d'un cube 
aux dimensions évoquées que l'on renomme 
HLn06 et que l'on déplace dans le répertoire 
"Hangar". 
 
Puis on le positionne au-dessus du muret. Le 
toit se réalise comme pour HLn03. les 4 pieds 
et l'escalier ne sont qu'une suite de 
découpage des faces concernées, suivies 
d'extrusion. On ne met pas de marches. Mais 

Figure 88 - HLn05 Option de Sweep/Sweep Options. 

 Figure 89 - Tour de Contrôle HLn06/HLn06 Control Tower. 
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il faut créer les rambardes de l'escalier avec un élément particulier en partant d'une primitive cube 
de 1 x 0.1 x 0.1 m que l'on duplique après avoir fait un dépliage, autant de fois que nécessaire. Cet 
objet est appelé "Barre". 
 
La modélisation du premier groupe de bâtiments est terminée. Quelques retouches ont été faites sur 
"Grass" et "Asphalt". 
 
Hangar HLn07 
Il s'agit d'un bâtiment technique en forme de parallélépipédique simple qui se modélise en quelques 
minutes en suivant les techniques développées ci-dessus. 
 
Hangar HLn08 
Il s'agit des bureaux accolés au hangar précédent, avec une avancée vitrée en demi-lune à l'avant. 
Il n'y a aucune difficulté pour réaliser ce bâtiment. Méfiez-vous des projections dans les plans OSM. 
Les bâtiments sont rectangles. Les petites déformations visibles sur le plan OSM sont dues à la 
projection UTM 32N éloignée du méridien de référence. 
 
Hangar HLn09 
Hangar standard qui se crée en moins d'une minute à partir de la primitive Hn. 
Pour créer la toiture à double pente : 
Sélectionner les Arêtes perpendiculaires au faîtage et taper C. Puis les soulever avec "Move Y". 
Adapter la géométrie. 
 
Hangar HLn10 
Hangar presque identique au précédent. Il est facile d'ajouter l'appentis par découpage et extrusion. 
 
Hangar HLn11 
Hangar standard créé en moins de 5 minutes à partir de la primitive Hn. Seule la hauteur doit être 
réglée au vu des photos. 
 
Hangar HLn12 
Il s'agit du poste de délivrance du combustible. Les photos montrent qu'il y a 5 postes, qui sont 
protégés sous un abri léger. Pour des raisons de sécurité, les postes sont toujours sur un massif en 
béton de 20 cm au-dessus du sol. 
À partir de la primitive Hn, on crée le socle de 20 cm aux dimensions externes de l'emprise sur la 
carte OSM. Ensuite, il faut en faire deux "Extract" selon Y et un "Bridge" pour créer la toiture légère 
que l'on place à 2.5 m de haut puis on la rend invisible. 
Le socle est légèrement réduit par un "Scale uniform" puis remis au sol. 
La création des pompes se fait de la manière suivante sur la face supérieure du socle : diviser en 3 les 

arêtes latérales et connecter. Puis diviser en 
11 ces nouvelles arêtes et les connecter. 
Extruder les 5 corps. de pompe à la hauteur 
de 1.8 m absolue. Adapter les tailles et 
emprises des pompes si nécessaire. 
Revenir sur la toiture, réduire l'épaisseur à 
2.5 cm environ. Sur la face inférieure de la 
toiture, créez 4 départs de pilier excentré 
des bordures. Extruder les piliers et mettre 
au sol les faces d'extrémités. 

Figure 90 - Le poste de combustible/Skid fuel. 
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Sélectionner l'objet toiture en mode Objet, passer en mode F. Avec des L/G désélectionner les 10 
faces des piliers avant. Puis R/D -> R/D sur Rotate -> E pour choisir un axe de rotation avec un L/G, la 
bordure inférieure de la toiture à l'avant -> R/D pour exécuter -> L/G pour fixer l'amplitude (10° 
environ). S/E -> Sélectionner les faces inférieures des piliers arrières -> R/D -> Flatten -> Y -> Absolute 
Commands -> Move -> Y=0 -> L/G sur OK. Combinez la toiture avec les pompes. 

Le poste de combustible est terminé. 
 
Hangar HLn13 à HLn17 
Ces bâtiments font partie d'une ferme et de ces 
dépendances dont la modélisation est très simple à 
partir de la primitive Hn. 
Procédez toujours de la même manière : 
- Fusionner Hn 
- Renommer Hn en HLn13, etc. 
- V -> H et N pour positionner grossièrement le bâtiment 
sur l'image OSM. 
- Rotate Y pour l'orienter puis H et N pour positionner 

une ou deux arêtes correctement. 
- Sélectionner une Face -> R/D -> Move-> Normal -> Y -> Ajuster la position de la face -> L/G pour 
fixer. Passer à la face suivante, etc. 
- Sélectionner les arêtes opposées pour faire le faîtage de la toiture -> C -> Move Y -> Déplacer la 
souris -> L/G pour fixer -> R/D -> Hardness -> L/G sur Hard. 
- Adapter la hauteur du bâtiment en fonction des photos 
- Déplacer l'objet dans le répertoire Hangar -> Verrouiller. 
 
Mâts et Manches à Air 
Le forum international propose une manche à air avec son mât que vous pouvez utiliser, appelé 
"Windsock Pole" parmi d'autres objets statiques. 
 
http://www.condorsoaring.com/assets-library/ 
 
Toutefois, nous considérons que la définition du mât est trop détaillée et nous avons donc créé un 
objet particulier hexagonal plus simple que nous allons fusionner avec sa texture. 
 
Les manches à air sont constituées d'un "Mât" et d'un objet générant automatiquement une manche 
à air flottant au gré du vent, appelées "Windsack" (Manche à Air), qui est un triangle isocèle plat. La 
longueur de la manche à air est égale à 100 fois le rayon du cercle circonscrit du triangle. Elle a une 
longueur minimale normalisée de 4.5 m au vu des Annexes A ou 14. Trois Manches à Air peuvent être 
fusionnées dans un même aéroport avec les noms "Windsack1", "Windsack2", "Windsack3". 
 

Pour Lienz-Nikoldorf, il faut créer 3 
manches à air et un mât météo simple. 
Ce mât météo supporte une girouette 
et un moulinet pour mesurer la vitesse 
du vent. Ces deux objets sont trop 
petits et complexes, et ils ne seront pas 
modélisés. 
 
Fusionner une manche à air : 
Il y a deux objets : comme le montrent 
les fenêtres "Geometry" et "Geometry 
Graph". 

Figure 91 - Les bâtiments agricoles/Farm buildings. 

Figure 92 - Mât et Manche à Air/Pole and Windsack. 

http://www.condorsoaring.com/assets-library/
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Ces deux objets doivent être déplacés simultanément en Mode Objet dans la fenêtre "Geometry", 
pour être positionnés sur le centre du cercle. 
Déplacer les 2 objets dans le répertoire Hangar par "Move to Folder" et verrouiller. 
 
Fusionner une deuxième manche à air. Renommer "Winsack1" en "Winsack2". Déplacer et 
positionner simultanément les deux objets dans l'enclos météo (HLn05). 
Dupliquer l'objet "pole" et déplacer et positionner la copie dans l'enclos pour le mât météo. 
Combiner les deux objets "Pole" et "Pole_Copyx". 
Déplacer les 2 objets dans le répertoire Hangar par "Move to Folder". 
Fusionner une troisième manche à air. Renommez-la en "Windsack3" si cela est nécessaire. 
Positionner cette manche à air sur le bâtiment HLn08, contre le mur du bâtiment Hln07, un peu en 
hauteur. Déplacer ces deux objets dans le répertoire Hangar. 
Combiner les trois objets "Pole". 
Sauvegarder le fichier "AeroLienz". 
 

Figure 93 - État de "Aerolienz" en fin de modélisation/"Aerolienz" at the end of modeling. 

 
Tout en se limitant aux objets immobiliers par destination, il est toujours possible d'ajouter, à ce 
stade beaucoup d'autres objets afin de compléter la modélisation d'un aéroport, comme des 
barrières, des bancs des parasols, etc.. 

Épinglage, Dépliage, Textures 

La modélisation étant terminée, il est temps de passer en revue les principales façons de rendre les 
bâtiments plus attrayants dans la simulation en les recouvrant de textures réalistes. Les règles 
générales, permettant de réaliser une texturation complète pour seulement, un ou deux bâtiments 
de Lienz-Nikolsdorf, seront abordés dans ce Guide. 
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Épinglage 

Le meilleur moyen de recouvrir les bâtiments d'une texture réaliste, c'est de disposer d'une photo 
pour chaque face du bâtiment, comme expliqué dans le chapitre sur les documents à réunir pour 
réaliser un aéroport. Comme notre appel à la communauté est resté sans réponse, nous ne 
disposons pas de photos adéquates pour les hangars de Lienz-Nikolsdorf. 
Nous allons donc montrer comment réaliser cet épinglage avec une autre photo de hangar. Mais 
nous ne retiendrons pas ce montage dans la finalisation de l'aéroport. 
 
Les photos utilisées peuvent être préalablement redressées dans un logiciel de retouche de photo et 
les éléments indésirables effacés. Mais Wings 3D avec son application "Snap Image" dispose de 
suffisamment d'outils pour que le redressement de la photo dans un logiciel tiers soit évité. 
Sur les anciennes versions de Wings 3 D, "Snap Image" était un outil, à présent il est devenu une 
application à part entière et possède sa propre fenêtre accessible par le menu Fenêtre : 
"Window -> Snap Image". 
(Fenêtre -> Epingler/Appliquer une Image). 
 
Toutefois, il faut avoir préalablement chargé les images à appliquer sur les faces pour pouvoir les 
sélectionner. Attention, il faut toujours travailler sur des copies de vos images. 
Pour notre exemple, nous avons chargé une photo d'une face avant d'un hangar, très peu adaptée au 
hangar HLn09. Cela se fait par le menu : 
"File -> Import Image..." (Fichier -> Importer une Image..), qui ouvre une Boîte de Dialogue vous 
permettant de choisir l'image désirée. 
L'image apparaît dans la fenêtre "Outliner" dans le répertoire "Images". 

 
Figure 94 - Image de départ/Starting Image. 

Il est alors temps d'ouvrir "Snap Images" et de positionner correctement la ou les faces où doit être 
appliquée l'image. L'axe de la caméra doit être au départ perpendiculaire au plan moyen de la face 
en mode orthographique. 
 
Les options de la fenêtre comprennent 3 boutons pour les 3 étapes principales de "Snap Image" et 2 
options et 4 outils pour déplacer et mettre à l'échelle l'image. 
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Figure 95 - Snap Image. 

 
Les différences d'aspects entre l'image et la face avant de HLn09 sont importantes. 
 
Après diverses utilisations des outils de "Snap Image", Déplacement et mises à l'échelle 
principalement verticale. Les alignements finaux se font en réorientant la face du hangar habilement 
en mode orthographique ou en mode perspectif dans la fenêtre "Geometry", pour obtenir ceci : 
 

 
Figure 96 - Adaptation réciproque de l'image et de la face du hangar/Reciprocal adaptation of Image and Hangar's face. 
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C'est un exemple extrême, presque caricatural, mais représentatif de ce que l'on peut faire avec 
"Snap Image". Voici le résultat final, une fois la face sélectionnée, l'épinglage est finalisé par un L/G 
sur le bouton "Snap Image" et un L/G sur la croix de la fenêtre de Snap Image, pour sortir de ce 
mode. 
Notez qu'il a été créé un matériau par défaut appelé "Default_Nom de l'image" surligné en jaune 
dans la figure 95, auquel est associée l'image. 
 

 
Figure 97 - Le résultat de "Snap Image" dans Wings 3D/Result of "Snap Image" in Wings 3D. 

 
Si, seulement une partie des faces d'un objet est épinglée sur des Images, le dépliage général (UV 
Map) doit se faire uniquement après la sélection des faces non concernées par ce procédé. Sinon 
tout le procédé d'épinglage sera à refaire. 

Dépliage, création de la Carte du Patron 

Le dépliage consiste à créer la Carte du 
Patron ou "UV Map", qui permettra en fin 
de processus de créer la Carte des 
Textures. 
 
Comme presque tous les hangars sont de 
simples parallélépipèdes rectangles 
auxquels on a parfois ajouté une toiture à 
simple ou double pente et que la plupart 
sont sans face inférieure, le dépliage 
standard et automatique de Wings 3D 
s'impose et sera largement suffisant : 
 
Déverrouiller le hangar HLn10. 
O -> L/G sur HLn10 -> R/D -> L/G sur 
UVmapping. 

 Figure 98 - Segmentation standard dans "AutoUV Segmenting". 
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La fenêtre "AutoUV Segmenting: HLn10" s'ouvre. C'est la fenêtre où l'on pratique la segmentation de 
l'objet HLn10. Comme cette fenêtre est centrée sur le centre de la scène, généralement rien n'est 
visible, car l'objet HLn10 est très loin du centre. Pour observer ce qui va se passer par la suite, réduire 
le niveau de zoom avec la molette jusqu'à l'apparition de HLn10. L/G sur Hln10 pour faire une 
sélection, puis A pour recentrer la caméra sur HLn10. Zoomer avec la molette pour examiner de prés 
l'objet. Si le travail préparatoire a été correctement effectué, toutes les Arêtes sont dures et le 
découpage par faces se fera donc automatiquement. La face inférieure est absente. Si ce n'est pas le 
cas, fermer la fenêtre "AutoUV Segmentting" et corriger la géométrie, sauvegarder et recommencer 
le dépliage avec un R/D au lieu d'un L/G sur l'item "UV Mapping" pour repartir sur un nouveau 
dépliage. 
 
Ensuite, faire un R/D dans la fenêtre " AutoUV Segmenting" pour faire apparaître le menu contextuel. 
L/G sur "Segment by" -> L/G sur "Projection". 
 
Les faces de HLn10 se colorent en fonction des Îlots qui vont être dessinés sur la Carte du Patron. 
Notez que la toiture à double pente ne forme qu'un seul îlot, car l'angle entre les 2 pans est proche 
de 180° et qu'il n'y aura donc que de faibles déformations lors de la projection. 
 
Ensuite, nouveau R/D dans la fenêtre "AutoUV Segmenting: HLn10" pour faire apparaître le menu 
contextuel. 
L/G sur "Continue" -> L/G -> "Projection Normal" (Projection selon la Normale de chaque face). 
 
La fenêtre "AutoUV Segmenting" disparaît, elle est remplacée par la fenêtre "AutoUV: HLn10". C'est 
dans cette fenêtre que l'on va procéder à l'arrangement des îlots sur la carte du Patron. Pour 
exécuter l'arrangement de la Carte du Patron, il existe de nombreux outils qui sont appelés par un  

Figure 99- Fenêtre "AutoUV"/"AutoUV" Window. 

 
R/D dans la fenêtre "AutoUV" en fonction du Mode de sélection. 
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Nous vous laissons le soin de les examiner en détail, la ligne d'information vous renseigne en 
permanence lorsqu'un item du menu contextuel est survolé par la souris. 
 
La figure 99 montre ce qu'il apparaît lorsque la fenêtre "AutoUV" s'ouvre et remplace la fenêtre 
"AutoUV Segmenting". 
 
Tous les îlots de la carte du Patron et toutes les faces de l'objet dans la fenêtre "Geometry" sont 
sélectionnés. Un S/E désélectionne tout et un L/G sur un îlot sélectionne la face de l'objet 
correspondant dans la fenêtre "Geometry" et réciproquement. 
C'est très pratique pour identifier les faces de l'objet, d'autant plus que cette fenêtre peut être 
rappelée à tout moment par le menu : "Window -> UV Editor Window". 
 
Pour tout sélectionner, tracez un rectangle de sélection avec un L/G maintenu en Mode Face ou 
Objet qui englobe toute la Carte du patron. Notez que le Mode Objet sélectionne les îlots entiers, 
mais pas l'objet complet dans la fenêtre Auto UV. 
 
Toutes les faces de l'objet sont présentées à l'intérieur du carré central de la fenêtre entouré d'un 
liseré bleu épais. Le fond de ce carré central est composé de lettres qui sont en réalité un motif 
répétitif carré qui se répète 8 fois en U (Horizontalement ou X) et V (Verticalement ou Y). 
 

Cette disposition permet de savants calculs sur les coordonnées canoniques UV 
comprises entre 0 et 1 et auxquelles on va attacher une carte de texture le plus 
souvent en multiple de 2.  
Le dernier élément intéressant c'est le carroyage en liseré bleu qui prolonge le 
carré central. Il vous indique seulement que le motif central de la Carte du Patron 

se répète à l'infini dans toutes les directions dans chaque case carrée entourée d'un liseré bleu, ce 
qui peut être intéressant si l'on crée des objets modulaires avec une seule texture comportant des 
motifs horizontaux ou verticaux répétitifs.  
 
Les seuls défauts de cette Carte du Patron créée automatiquement sans aucune intervention de 
notre part résident dans les constats suivants : 
- Les îlots sont jointifs et commencent juste en bordure de la carte du Patron. 
- L'îlot de la toiture est incliné, alors que les motifs de textures que l'on va appliquer sont soit 
horizontaux, soit verticaux. L'inclinaison provient de l'angle que fait le bâtiment dans Wings 3D avec 
l'axe X. 
 
Tous ces petits défauts peuvent être très facilement corrigés. 
 
Correction de l'inclinaison de l'îlot de la toiture sur la Carte du Patron : 
S/E -> E -> Sélectionner une Arête presque horizontale de l'îlot toiture par un L/G -> R/D -> L/G sur 
"Rotate" -> L/G sur "Chart to X". L'îlot de la toiture se redresse et les bordures sont parfaitement 
alignées verticalement et horizontalement. Si vous sélectionnez une Arête presque verticale, faites 
un L/G sur "Chart To Y". 
 
Redéploiement des îlots sur la Carte du Patron :  
Il est préférable, mais ce n'est pas obligatoire et systématique, de se ménager des marges autour des 
îlots et des bordures de la Carte du Patron, afin d'avoir environ 2 pixels sur les bords et 4 pixels entre 
les îlots pour une Carte de Texture finale de 1024x 1024 pixels. Ceci est souvent nécessaire pour 
éviter des effets de bord. Lors de la transposition d'une Carte du Patron en coordonnées UV sur une 
Carte de texture, il y a une très faible probabilité pour que chaque sommet soit sur les coordonnées 
exactes d'un pixel. Et si votre Carte du Patron présente des arêtes inclinées, c'est encore pire. On 

A B C D 
E G H J 

K L M O 
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obtiendra très souvent des pixels en demi-teinte lors de la texturation des îlots, si l'on ne prend pas 
ces marges. 
 
Voici comment l'on procède : 
Passer en mode Objet et tout sélectionner -> R/D -> L/G sur "Move" -> L/G sur "Free" -> déplacer la 
souris pour créer une marge de bordure autour de l'îlot de la toiture -> L/G pour fixer ou R/D pour 
revenir à la position de départ. 
 
S/E -> O -> Sélectionner l'îlot supérieur à gauche par un L/G -> R/D -> L/G sur Move -> L/G sur 
"Vertical" -> Déplacer la souris pour séparer l'îlot se trouvant en dessous -> L/G pour Fixer. 

 
S/E -> O -> Sélectionner les 5 
îlots se trouvant les plus à droite 
par des L/G ou un cadre de 
sélection -> R/D -> L/G sur 
"Move To" -> L/G sur "Right".  
Tous les îlots sélectionnés se 
trouvent avec leurs Arêtes de 
droite contre la bordure droite. 
Ils sont donc tous alignés sur 
leur bordure droite. 
Gardez ces 5 îlots sélectionnés -
> R/D -> Move -> Horizontal -> 
Déplacer la souris pour créer 
une marge à droite sans 
chevauchement avec les îlots se 
trouvant à gauche de la 
sélection -> L/G pour fixer. 
Puis désélectionner par un L/G 
l'îlot se trouvant en bas de la 
sélection -> R/D -> L/G sur 
"Move" -> L/G sur "Vertical" -> 
Déplacer la souris pour séparer 
la sélection de l'îlot le plus bas -> 
L/G pour fixer. 

Réitérer la dernière séquence autant de fois qu'il le faudra pour étager les îlots, un par un, en les 
gardant alignés sur leur bordure droite. 
 
De bout en bout, le dépliage et les corrections s'effectuent en moins de 5 minutes. 
 
La carte du Patron définitive est terminée. 

Carte de Texture 

Pour créer la carte de Texture à partir de la Carte du patron, il faut procéder de la manière suivante : 
 
Passer en Mode Objet et Sélectionner tous les îlots -> R/D -> L/G sur "Create Texture" -> la fenêtre 
"Draw Options" apparaît. 
La figure 101 montre les options les plus couramment utilisées. 
La carte de texture toujours carrée a une taille en pixel qui doit être définie : choisir 1024 x 1024 
pixels. 

Figure 100 - Carte du Patron/UV Map. 
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Puis, lors de la création de la Carte de Texture, une suite de passes dans le cadre "Render" (Rendu) 
sont exécutées selon l'ordre affiché de haut en bas dans la boîte d'option, la passe suivante 
recouvrant la passe précédente. L'empilement des passes est donc sur la texture du bas vers le haut. 

Figure 101 - Options de la Carte de Texture/Texture Map Draw Options. 

Configurer "Draw Options" comme sur la figure 101, un standard pour dessiner la carte de texture. 
Un L/G sur OK dessine une carte de texture brute et crée un matériau HLn10_auv associé à une 
image du même nom. 
 

 
Figure 102 - Carte de textures Brute/Rough textures Map. 
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Il ne reste plus qu'à appliquer ces mêmes procédés aux 16 autres bâtiments de Lienz-Nikolsdorf. 

Texturation 

La texturation des objets dans Wings 3D avec "Snap Image" a été examinée précédemment. Nous 
allons maintenant examiner la texturation des objets avec un logiciel 2D externe à Wings 3D à partir 
de la Carte de Texture brute qui vient d'être créée. 
 
Dans la plupart des cas, pour pouvoir modifier la Carte de Texture, il faut rendre la Carte de Texture 
externe. Une fois texturée, la carte de texture pourra être facilement mise à jour dans Wings 3D. 
 
Rendre externe une carte de texture se fait facilement. 
 
Un R/D sur l'image de Hln10 dans "Outliner" permet d'accéder au menu contextuel. Un L/G sur 
"Make External" ouvre une boîte de dialogue Windows. Créer un nouveau répertoire "Textures" dans 
lequel vous sauvegardez la Carte de Texture HLn10 au format PNG. Ce format est aussi performant 
que le format DDS, et bien meilleur que le format BMP ou TGA. 
 
Sachez toutefois que vous pouvez à tout instant changer le type et les dimensions d'une Carte de 
Texture. Cet aspect sera évoqué dans le chapitre 9, dans la finalisation de l'aéroport. 
 
Ouvrez votre logiciel 2D et chargez la Carte de texture. 
 
La première chose à réaliser, consiste à créer un tracé général autour de chaque îlot à la plume, de 2  
pixels en retrait des bords. Puis verrouiller l'image, ajouter un calque, et sauvegarder au format du 
logiciel 2D. 
 

Figure 103 - Travail de base sur la Texture HLn10/Basic work upon HLn10 textures. 

Ensuite, il faut pour un rendu correct, utiliser des textures sauf éventuellement pour les fenêtres, les 
encadrements de portes et fenêtres, les ombres des dépassées de toitures. 
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De nombreuses textures sont disponibles 
gratuitement sur Internet. Préférez les 
textures carrées sans couture. Il suffit de 
chercher ; mais n'oubliez pas de citer vos 
sources en les incluant dans le "Read me" 
de la scène. Vous pouvez également les 
créer en partant d'une de vos photos. 
 
par exemple : 
 
http://www.museumtextures.com/ 
 
http://soundimage.org/ 
 
https://www.google.cz/search?q=tileable+
desert+texture&newwindow=1&source=ln
ms&tbm=isch&sa=X&ved=0ahUKEwj-
9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB
&biw=1920&bih=940#imgrc=DSOUhXbeV5
-55M: 
 
Et il en existe bien d'autres. 
 
L'objectif est de créer une bibliothèque de 
textures ou de motifs en plusieurs nuances 
et deux directions, de façon que la 
texturation devienne juste un choix rapide 
et efficace d'une texture. 
 
La création de motifs doit être une 
technique bien encadrée si l'on souhaite un 
minimum de souplesse pour pouvoir les 
modifier à sa guise. Pour les toitures de 
bâtiments, vous devez pouvoir compter sur 
une dizaine de motifs, horizontaux et 
verticaux à des tailles différentes. De 
même pour les murs, qu'ils soient sous 
forme de crépis de différentes couleurs, de 
moellons, de briques ou de bardages 
métalliques ou en bois. 
Les rideaux et portails de fermetures 

industriels sont également bienvenus. 
 
Cette collection se fait au fur et à mesure des besoins et s'enrichit à chaque nouvelle création.  
 
De façon à pouvoir changer la nuance, la direction et la taille, voici la manière de procéder : 
- Charger la texture sans couture dans le logiciel 2D. 
- Verrouiller et ajouter un calque. 
- Sauvegarder dans le format du logiciel 2D. 
 
À ce stade, vous n'avez pas modifié la taille de votre texture. 

Figure 104 - Collection de Motifs/Patterns Collection. 

http://www.museumtextures.com/
http://soundimage.org/
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
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Pour changer de coloration : 
- Remplir le calque d'une couleur de base. 
- Jouer sur la transparence du calque pour obtenir l'effet souhaité. Après plusieurs essais, en 
changeant de couleur de base, vous arriverez au résultat souhaité. 
- Sauvegardez votre travail. 
- Exportez la texture au format souhaité (PNG, de préférence). 
- Adapter la taille (128x 128, 256 x 256, 512 x 512, 1024 x 1024 pixels ou toute autre valeur carrée). 
- Créer le motif. Pour la plupart des logiciels 2D, ce nouveau motif sera directement accessible pour 
tous les nouveaux fichiers, sinon il faut créer et sauvegarder une bibliothèque de motifs que l'on 
chargera pour chaque nouveau fichier. 
 
Il est possible aussi d'ajouter des calques de réglages au lieu de simplement jouer sur la couleur et la 
transparence. 
 
Pour changer le sens du motif, et passer d'une orientation verticale à une orientation horizontale, en 
partant de la dernière sauvegarde: 
- Déverrouiller la texture de base. 
- Créer une copie sur un nouveau calque 
- Faites-la pivoter de 90°. 
- Verrouiller la texture de base et la copie. 
- Sauvegarder votre fichier. 
Appliquer la suite du procédé : exporter, adapter la taille et créer un nouveau motif. 
 
Pour les fenêtres, portes, etc., afin de ne pas avoir à refaire chaque fois la même chose, il faut créer 
un tracé standard de tous les éléments fondamentaux d'une façade d'immeuble. 
Ce tracé sera dupliqué dans chaque nouveau fichier, puis mis à l'échelle appropriée et légèrement 
retouché pour que les tracés correspondent aux pixels. 

Figure 105 - Création des Motifs à partir des Textures/Creating Patterns from Textures. 
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Les éléments de ce tracé pourront alors être dupliqués autant de fois que nécessaire, pour créer les 
façades. Enfin, l'application de couleurs ou de textures sur les tracés et les fonds donnera l'aspect 
désiré. 

Figure 106 - Standard pour les Façades/Frontage Standard. 

 
 
 
l'échelle de référence est fixée à 1 pixel pour 5 cm et le standard des hauteurs est le suivant : 
 
Hauteur entre étages : 3.0 m. 
Sommets de portes, baies vitrées, et fenêtres : 2.30 m. 
Hauteurs sous les fenêtres : 0.90 m 
Largeur de fenêtre à deux battants : 1.5 m. 
Largeur de porte : 1 m. 
Portes de garage : 3.5 x 2.25 m. 
 
Ce sont des standards courant en Europe. Vous avez le choix d'utiliser vos propres mesures. 
Tous ces éléments doivent être des tracés rectangulaires fermés. 
 
 
Sauvegarder ce fichier sous le nom de "MesuresStd" 
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Les Motifs et Tracés fondamentaux ayant été créés, ils vont pouvoir être utilisés pour la texturation 
de HLn10, en s'aidant des photos disponibles.  
 

 

 
Transfert et mise à l'échelle des tracés standards 

Les fenêtres de "HLn10" et "MesuresStd" 
sont alors arrangées verticalement. Par 
un simple L/G maintenu sur le tracé 
"Standard" et son déplacement sur 
"HLn10", une copie du tracé est 
effectuée sur "Hln10.psd". Revenir à 
l'affichage de "HLn10" et sélectionner 
tous les tracés de "Standard". Déplacez-
les avec la souris sur le coin inférieur 
gauche de la façade horizontale se 
trouvant en haut, puis Crtl+T. En 
maintenant la touche MAJ enfoncée, 
régler l'homothétie en déplaçant la 

souris avec un L/G maintenu en partant du coin 
supérieur droit. 
Il faut ensuite adapter les tracés de façon à ce qu'ils 
correspondent à un nombre entier de pixels. 
 
Revenons à la texturation de base en créant ou 
choisissant les textures appropriées pour les murs et la 
toiture du hangar. 
Puis, il faut créer les tracés pour le bardage en bois 
tout autour du hangar et l'ajuster de façon que cela 
soit cohérent avec les photos. 
Pour cela, il faut faire des aller-retour entre le dessin 
2D et AeroLienz dans Wings 3D, jusqu'à ce que les 

Figure 107 - Mise à l'échelle des Tracés Standards/Standard Paths Scaling.  

Figure 108 - HLn10 : Textures de base/Basic Textures. 

Figure 109 - 1er Essai avec les bardages en bois/1st 
test with wooden cladding. 
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bradages soient correctement alignés 
aux angles du bâtiment. 
Sauvegarder HLn10 au format PNG 
dans le dossier "Textures" en 
remplaçant la Carte de Texture 
originale. Puis dans la fenêtre 
"Outliner" de Wings 3D : R/D sur Hln10 
dans le dossier "Image" -> L/G sur 
"Refresh". La nouvelle texture est 
appliquée sur le hangar HLn10.  
 
Ensuite il faut créer le portail du 

hangar, disposer les portes et fenêtres 
sur chaque façade en s'aidant des 

photos. Grâce aux tracés standards créés et mis à l'échelle cela se fait rapidement. 
 
Par des copier/coller on duplique les tracés standards dans de nouveaux tracés pour créer les 
portails, les fenêtres et les portes du bâtiment. Certaines adaptations sont évidemment nécessaires. 
 
 

 
 

Il ne reste plus qu'à appliquer les mêmes procédés aux 16 autres bâtiments de Lienz-Nikolsdorf, pour 
terminer la modélisation de l'aéroport avec Wings 3D. Verrouillez tout et sauvegardez votre travail ! 

6/Exporter en Wavefront (.obj). 

Le format "Wavefront" est un format de fichier générique et standard qui décrit sous une forme 
simple et ouverte un objet 3D. Les fichiers "Wavefront", avec la terminaison ".obj" et le fichier ".mtl", 
peuvent être ouverts avec le Bloc-Notes, car ce sont des fichiers ASCII. Beaucoup de modeleurs 3D 
permettent d'exporter leurs fichiers d'objets 3D dans ce format et vice versa, par les commandes 
"Export" (Exporter) et "Import" (Importer). En l'occurrence, Wavefront sert de relais entre Wings 3D, 
Blender, 3DS max, etc., pour la conversion dans le format C3D. Le format C3D est un format 
propriétaire utilisé par Condor afin d'éviter la copie ou le pillage des objets utilisés dans la simulation, 
par des tiers. 

Figure 110 - HLn10 terminé dans Photoshop/HLn10 finished with 
Photoshop. 

 

 

Figure 111 - HLn10 Terminé dans Wings 3D/Hln10 Finished in Wings 3D. 
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Paramétrage de l'exportation 

Il y a deux boîtes de Dialogue "Wavefront Export Option" (Option d'Exportation Wavefront) à 
paramétrer. L'une, pour 
exporter toute la scène, 
l'autre pour exporter 
seulement les éléments 
sélectionnés. 
L'accès à ces boîtes de 
dialogue se fait de la 
manier suivante : 
"File -> Export -> 
Wavefront" 
(Fichier -> Exporter -> 
Wavefront) 
et 
"File -> Export Selected -> 
Wavefront" 
(Fichier -> Exporter la 
sélection -> Wavefront). 
 
Il suffit de cliquer sur OK 
pour rendre ses options 
permanentes. Ensuite 
comme rien n'est prêt il 

suffit d'annuler le choix 
du nom du fichier 
d'exportation. Ce double 

paramétrage vous permettra ensuite, si vous créez des objets standards ou de scène, de ne plus vous 
poser de questions suivant le type d'Exportation que vous voulez réaliser. En effet, les deux boîtes de 
dialogue, bien que différentes pour chaque type d'exportation, portent le même nom. 
 
Le paramétrage doit être conforme à la figure 112, pour les deux types d'exportation. 

Préparation du fichier de l'aéroport pour l'exportation 

Après avoir terminé la modélisation et la texturation des objets de "AeroLienz" sous une forme 
détaillée, nous allons garder ce fichier "AeroLienz", après l'avoir sauvegardé, comme source 
potentielle de modifications futures. Pour continuer, nous allons effectuer une copie avec 
l'appellation du nom de l'aéroport enregistré dans Landscape Editor. 

 
File -> Save As -> Accès à la boîte de dialogue 
permettant de donner un nouveau nom a 
"AeroLienz", soit : "Lienz-Nikolsdorf" conforme 
à ce qui a été enregistré pour AA2 dans 
Landscape Editor. 
 
La préparation va consister à regrouper les 
différents éléments constituant la Piste de 
l'aéroport sous les 4 éléments génériques 
"Asphalt", "Grass", "Asphaltpaint" 

Figure 112 - Wavefront Export Options. 

Figure 113 - "Geometry Graph" après nettoyage/"Geometry 
Graph" after cleaning. 
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et"Grasspaint" dans la fenêtre "Geometry Graph", et au nettoyage de tous les éléments inutiles de la 
fenêtre "Outliner". 
 

Créez un répertoire "Piste" dans "Geometry Graph" 
R/D dans "Geometry Graph" -> L/G sur "Create Folder" -> Nommer le répertoire 
"Piste" -> L/G sur OK 
 
L/G sur le répertoire Asphalt -> R/D sur un cadenas -> Tous les objets sont 
déverrouiller. 
Passez en mode Objet -> R/D sur l'Icône cube -> Tous les objets du répertoire 
sont sélectionnés. 
R/D dans la fenêtre "Geometry" -> L/G sur "Combine" -> Renommer le seul objet 
restant en "Asphalt" -> Sélectionner-le par un L/G -> R/D sur le répertoire Piste -> 
L/G sur "Move to Folder" 
L'objet "Asphalt" est transféré dans le répertoire "Piste" -> L/G sur le cadenas de 
"Asphalt"  
 
Réitérer ce mode opératoire avec le répertoire "Grass" ou transférer le fichier 
"Grass" dans le répertoire "Piste" si vous avez utilisé la méthode booléenne.  
 
De la même manière, en suivant le même processus, les éléments du répertoire 
"Asphaltpaint" vont être combiné en un seul objet renommé "Asphaltpaint" qui 
sera transféré et verrouillé dans le répertoire "Piste". 
 
De la même manière, en suivant le même processus, les éléments du répertoire 
"Grasspaint" vont être combiné en un seul objet renommé "Grasspaint" qui sera 
transféré et verrouillé dans le répertoire "Piste". 
 

Dans "Geometry Graph", éliminer tous les répertoires vides : 
R/D sur le nom du répertoire vide -> L/G sur "Delete Folder". 
 
Vérifiez "Geometry Graph" et sauvegardez "Lienz-Nikolsdorf". 
 
Passez à la fenêtre "Outliner". 
Dans le répertoire "Materials" 
Éliminez tous les éléments de type Episte1 ou Episte1_auv, Episte2 ou 
Episte2_auv, etc., et les matériaux par défaut Default1 à Default2, etc.. 
R/D sur l'élément à éliminer -> L/G sur "Delete". 
 
Vérifier "Materials" dans "Outliner" et sauvegarder "Lienz-Nikolsdorf". 
 
Dans le répertoire "Images" 
Éliminez toutes les Images superflues. Seules les images non liées à un 
matériau peuvent être éliminées. et une confirmation vous sera demandée 
 
R/D sur l'image à éliminer -> L/G sur "Delete" -> L/G sur "Yes" à la demande de 
confirmation : "Are you sure you want to delete the image (NOT undoable)?" 
(Etes-vous certain de vouloir éliminer cette image (Aucun retour en arrière 
possible) ?). 
 
Ce sont principalement les Images "EPiste.." qui doivent être éliminées. 
 

Figure 114 - 
"Materials" après 
nettoyage/ 
"Materials" after 
cleaning. 

Figure 115 - "Images" 
après nettoyage/ 
"Images" after 
cleaning. 
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Notez que les éléments "Grass" de "Materials" et "Images" auraient pu être aussi éliminés, sauf que 
la couleur verte de l'herbe mise pour la création de ce Guide disparaîtrait dans Wings 3D, ce qui 
serait dommageable pour la bonne lisibilité de ce tutoriel. 
 
Toutefois, comme il l'est signalé dans le "Landscape Guide" (Guide de construction des Scènes) la 
hauteur et la densité des herbes dans "Grass" et "Grasspaint" et des craquelures dans "Asphalt" et 
"Asphaltpaint" sont consécutives à l'échelle adoptée dans les Cartes du Patron respectives. Pour 
anticiper et prérégler ce phénomène qui nécessitera probablement plusieurs essais, il faut effectuer 
un dépliage standard sur tous les éléments du répertoire "Piste". 

 
Successivement, pour chaque objet du 
répertoire "Piste": 
 
Déverrouiller l'élément -> Passer en 
Mode Objet -> R/D dans la fenêtre 
"Geometry" -> L/G sur "UV mapping" -> 
R/D dans "AutoUV Segmenting" -> L/G 
sur "Segment by" -> L/G sur "Projection" 
-> Nouveau R/D dans "AutoUV 
Segmenting" -> L/G sur "Continue" -> 
L/G sur "Projection Normal" -> La fenêtre 
AutUV apparaît -> R/D dans la fenêtre 
Auto UV -> L/G "Scale" -> L/G "Uniform"-
> Déplacer la souris pour mettre à 
l'échelle -> L/G pour fixer la taille.  
 
Pour une piste de 630 m, il faut diminuer 
la taille pour obtenir une taille conforme 
à la figure 114 pour "Asphalt" avant de 
créer la texture. Obtenez la même 

échelle pour "Grass". Par contre pour "Asphaltpaint" et "Grasspaint" la réduction de l'échelle doit 
être bien plus importante. 
Sauvegarder Lienz-Nikolsdorf. 

Exécution de l'Exportation 

Nous allons créer les deux fichiers G et O au format "Wavefront" à partir du fichier Wings 3D de 
l'aéroport de "Lienz-Nikolsdorf. 
 
Passer en Mode Objet -> Sélectionner le répertoire "Piste" -> R/D sur un cadenas pour tout 
déverrouiller -> R/D sur l'icône cube à gauche pour sélectionner les 4 éléments de "Piste" -> L/G sur 
"File" -> L/G sur "Export Selected" -> L/G sur "Wavefront" -> L/G sur "OK" de "Wavefront Export 
Options" -> Ajouter le suffixe G au nom du fichier Lienz-Nikolsdorf -> L/G sur OK. 
 
Deux fichiers sont créés : "Lienz-NikolsdorfG.obj" et "Lienz-NikolsdorfG.mtl". 
 
Verrouillez les 4 éléments du répertoire "Piste" et Sauvegardez "Lienz-Nikolsdorf". 
 
Passer en Mode Objet -> Sélectionner le répertoire "Hangar" -> R/D sur un cadenas pour tout 
déverrouiller -> R/D sur l'icône cube à gauche pour sélectionner tous les éléments de "Hangar" -> L/G 

Figure 116 - Mise à l'échelle approximative pour une piste de 620 m/ 
Approximative Scaled size for a runway length of 620 m. 
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sur "File" -> L/G sur "Export Selected" -> L/G sur "Wavefront" -> L/G sur "OK" de "Wavefront Export 
Options" -> Ajouter le suffixe O au nom du fichier Lienz-Nikolsdorf -> L/G sur OK 
 
Deux nouveaux fichiers sont créés : "Lienz-NikolsdorfO.obj" et "Lienz-NikolsdorfO.mtl". 
 
Verrouillez tous les éléments du répertoire "Hangar" et Sauvegardez "Lienz-Nikolsdorf". 

7/Transformer les fichiers G et O en fichiers C3d et lier les textures. 

Copie des Textures des bâtiments dans la scène. 

Avec l'explorateur de Windows, ouvrir le répertoire "Airports" ou "Airports/Textures" de la scène, en 
l'occurrence.  
C'est un choix particulier de regrouper toutes les textures des aéroports dans un répertoire 
"Textures" et dans des sous-répertoires dédiés à chaque aéroport. Compte tenu du nombre 
d'aéroports dans AA2, c'est le meilleur choix possible. 
Créer un répertoire nommé "Lienz" pour regrouper toutes les textures de Lienz-Nikolsdorf. 
 
Aller dans le répertoire "Textures" de l'aéroport où vous avez regroupé toutes les textures des 
bâtiments. 
 
Sélectionnez tous les fichiers PNG et copiez ces fichiers dans 
"Condor2/Landscapes/AA2/Airports/Textures/Lienz" 
 
Dans ce cas, il ne manque que la texture du Mât, nommé "Pole" qui est commun à plusieurs 
aéroports et qui doit se trouver dans le répertoire "Com". 

Création des fichiers C3D, G et O de Lienz-Nikolsdorf 

Création du fichier C3D "Lienz-NikolsdorfG" 

Ouvrir Object Editor. 
 
Ouvrir le fichier "Lienz-NikoldorfG.obj" se trouvant dans le répertoire de travail de Lienz. 
 
Voici ce que l'on obtient : voir la figure suivante. 
 
Il faut éliminer les 4 textures : LL/GG sur la première texture -> Touche "Suppr". 
Réitérer pour les 3 autres textures. 
 
Toutefois, les objets du fichier G peuvent avoir leurs propres textures. Le chapitre "Muck" vous 
permettra d'aborder ces techniques. 
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Figure 117- Lienz-NikosldorfG Brut/Raw. 

 
 
Puis après élimination des textures, vous obtenez ceci : 
 

 
Figure 118 - Lienz-NikoldorfG. 

Il ne reste plus qu'à sauvegarder en C3D 
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"File -> Save to C3D" dans le répertoire de travail puis dans le répertoire de "Airports" de la scène en 
ayant le soin de renommer les fichiers anciens Lienz-NikolsdorfG et O en leur ajoutant le suffixe 
"old", pour ne pas les perdre en cas de problèmes. 
 
Vérifier votre travail en chargeant le fichier C3D nouvellement créé dans le répertoire "Airports" de la 
scène. 
Vous ne devez obtenir aucune différenciation des éléments de piste, sauf à passer en mode fil de fer 
par : Tools -> Wireframe. 
 

 
Figure 119 - Lienz-NikolsdorfG.c3d de "Airports", en mode fil de fer/wireframe mode. 

Vous noterez que la triangulation, lors du processus de génération des fichiers "Wavefront" à 
rajouter la plupart des Arêtes éliminées à la fin du processus de création de "Grass" par la méthode 
booléenne. Il est difficile de se passer de cette élimination des Arêtes, sauf pour des cas très simples.  

Création du fichier C3D "Lienz-NikolsdorfO" 

Ouvrir Object Editor. 
 
Ouvrir le fichier "Lienz-NikolsdorfO.obj" se trouvant dans le répertoire de travail de Lienz. 
 
voici ce que l'on obtient :  
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Figure 120 - Lienz-NikolsdorfO.obj Brut/Raw. 

 
C'est normal, car les textures ne sont pas liées et des textures existantes ne sont pas répertoriées. 
 
Tout d'abord mettre à la valeur 1, sauf pour les 3 manches à air Windsack1 à3 les paramètres 
suivants de chaque texture : 
"Spec" (Spéculaire), "Shiny" (Brillance), "Red" (Rouge), "Green" (Vert), "Blue" (Bleu) et "Alpha" 
(Transparence). 
Et garder à la valeur 0 "Env" (Ambiante). Ces valeurs standards ne sont pas réellement impératives et 
vous pouvez apprendre, par des essais successifs, à vous en servir pour améliorer l'aspect de vos 

textures. 
Puis écrire le nom des textures manquantes, en 
l'occurrence HLn04.png. 
Enfin, il faut écrire le chemin d'accès aux textures : Il faut 
utiliser l'outil "Replace texture path" (Remplacer le chemin 
des Textures) accessible par : "Tools -> Replace textures 
path", puis compléter la zone "With" par 
"Landscapes/AA2/Airports/Textures/Lienz/".  
 
N'oubliez pas le dernier slash "/". 
 
Puis comme l'objet "Pole" est commun à plusieurs 

aéroports, il faut dans le chemin d'accès à la texture "Pole.png" remplacer "Lienz" par "Com". 
 
Le chemin d'accès aux textures peut être relatif, ce qui évitera des redites et facilitera le portage. 
Dans ce qui suit : "Landscapes/AA2/Airports/" peut être supprimé pour les textures de l'aéroport. 
 
Voici le résultat de l'édition des options de chaque objet du fichier O : 

Figure 121 - Fenêtre d'édition des chemins de 
textures/"Replace textures paths" window. 
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Figure 122 - Finalisation des options des objets du fichier O/Finishing the edition of file O objects options.  

Il ne reste plus qu'à sauvegarder en C3D et vérifier que tous les objets sont correctement texturés 
dans le fichier "Lienz-NikolsdorfO.c3d" du dossier Airports de AA2. 
 
Si aucune erreur n'a été commise dans la création de l'aéroport, voici le résultat obtenu avec tous les 
objets "hangar", correctement texturés en ouvrant le fichier O du dossier "Airports" de AA2 : 
 

Figure 123 - Lienz-NikolsdorfO.c3d du répertoire "Airports" de AA2. 
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8/Intégrer l'aéroport dans la scène avec Lanscape Editor 

Fermez tout, et sauvegardez si nécessaire. Il est temps de démarrer Condor 2, et de créer un circuit 
au départ de Lienz-Nikolsdorf, avec une activité thermique nulle et sans vent et de tenter de réaliser 
un premier vol à partir de ce nouvel aéroport, dont le départ est soit tracté, ou treuillé ou en vol. 
 

Figure 124 - Vue générale de Lienz-Nikolsdorf dans Condor 2/General View. 

 
Le premier vol réalisé autour de Lienz-Nikolsdorf, montre qu'il n'y a que peu de retouches à faire sur 
l'altimétrie et la position. Ce n'est pas étonnant, car Lienz-Nikolsdorf existait avec un aérodrome 
standard dans AA2 0.5. 
Bien que l'intégration de l'aéroport soit toujours effectuée par le concepteur de la scène voici la 
batterie de tests qu'il faut effectuer et dont une partie peut être effectuée par des bénévoles de 
Condor. 
 
Toutefois, vous devez, avant de mener ces tests, préalablement à toutes modifications, effectuer, 
dans Landscape Editor et au facteur de zoom de 10.67, des captures d'écran de la carte des hauteurs, 
couvrant largement la zone aéroportuaire. 
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Figure 125 -- Lienz-Nikolsdorf dans Landscape Editor - Zoom 10.67 -> Toutes les élévations sont visibles au pas de30 m/All 
heights are displayed to standard mesh of 30 m. 

Le but de ce chapitre c'est de fixer définitivement la position, la direction et l'altitude de l'aéroport, 
en partant des données inscrites dans Landscape Editor au moment de la création, et qui se 
rapportent généralement aux données OACI ou au standard 400 x 25 m pour la piste. 

Test de chargement de l'aéroport à 25-24 km 

C'est de fait un test important qui pourrait avoir des conséquences sur la viabilité finale de l'aéroport, 
car le seul paramètre, sur lequel on peut jouer, sans simplifier une partie de la géométrie des 
bâtiments de l'aéroport ou éliminer une partie de "Asphaltpaint", ou de "Grasspaint" c'est la 
diminution de la taille des textures des bâtiments qui le compose. 
 
Dans Condor 2, créer un circuit d'un aéroport situé à plus de 28 km qui se termine sur Lienz-
Nikolsdorf, départ en vol 1500 m, toutes les options disponibles et plus particulièrement "Allow 
height recovery". En approchant à 26 km ralentir et surveiller les FPS, guetter aussi l'apparition du 
triangle des travaux. Vers 24 km, vous devez au moins entrevoir une baisse des FPS. 
 
Pour ce premier test pour Lienz-Nikolsdorf, les résultats sont très bons en vol libre, les FPS sont 
autour de 320 et l'on descend à 315 au moment du chargement des fichiers de l'aéroport. Il y a donc 
une marge importante à vérifier au fur et à mesure de l'augmentation de la complexité de la scène. 
Un test a été effectué en multijoueurs avec 44 participants. Les FPS indiqués sont alors de 103. Là 
encore, la marge est importante pour un minimum de 60 avec une carte graphique GTX 750 Ti. 
 
En effet dans cette zone il n'y a pas de zone forestière définie avec la Forest Map ni Water Alpha qui 
double le poids des tuilettes de 2731 ko à 5432 ko, ni d'autres objets autour ou dans la définition de 
l'aéroport. 
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À chaque augmentation notable de la complexité de la scène ou de l'aéroport, il faudra refaire ce test 
pour s'assurer que les FPS ne descendent pas en dessous de 60 en vol multijoueurs et que le temps 
de chargement ne dépasse pas les deux dixièmes de seconde. Dans le pire des cas, si l'on dépasse un 
temps de chargement de plus de 2 secondes un écran bleu peut apparaître, cela s'est déjà produit 
sur des scènes de Condor 1 et de Condor 2 ! 

Tests primaires de décollage 

Sans avoir fait aucun aplanissement de la zone aéroportuaire, il faut tenter bien que cela soit parfois 
très chaotique, voire impossible, des décollages dans les deux sens, pour savoir s'il existe ou non des 
difficultés de remorquage, principalement pour les aéroports situés en montagne. 
 
En effet, il faut fixer l'orientation de l'aéroport, et sa position le plus rapidement possible. 
 
Comme nous l'avons déjà expliqué dans le chapitre concernant le ballet des remorqueurs, on peut 
jouer sur plusieurs paramètres dans Landscape Editor pour que le décollage du planeur le plus lourd 
tracté par le remorqueur le moins puissant s'effectue sans difficulté. 
 
Si des modifications sont nécessaires pour rendre possible le remorquage, il faut les envisager dans 
cet ordre en modifiant les paramètres correspondant dans Landscape Editor : 
- la longueur de la piste, 
- la position de la piste,  
- l'altitude de la piste.  
- l'orientation de la piste,  
 
Mais cela aura chaque fois des conséquences sur l'aspect de la scène et augmentera le travail à 
effectuer. 
 
Toutefois, il est préférable comme indiqué plus loin d'optimiser avant le début des tests de décollage 
remorqué, la longueur de l'aéroport dans Landscape Editor, pour éviter d'avoir à recommencer les 
tests, sauf si vous utilisez le standard de 400 x 25 m pour la piste. 

Orientation et Positionnement et de l'aéroport. 

Il s'agit de commencer l'intégration de l'aéroport dans la scène, une fois les premiers tests 
préliminaires réalisés. 
 
Ouvrir Landscape Editor et charger la scène, et cocher la case "Airports" et "Height Map". Trouver 
Lienz-Nikolsdorf, puis R/D sur cet aéroport. Les coordonnées du centre de la piste ont pour Latitude 
46.798199, et Longitude 12.878100. 
 
La position finale sera donnée par le créateur de la scène, mais voici les chiffres clefs, déduits de 
l'usage d'un convertisseur UTM/WGS 84, permettant une correction rapide pour une latitude de 46° 
sur le méridien de référence de 9° pour la zone UTM 32N. 
Un pixel sur la tuilette, ou la tuile, au format standard de Condor 2 représente 2.8125 m,  
soit une variation de Latitude de 0.0000253° et de Longitude de 0.0000363°. 
 
Le même calcul à partir des coordonnées de l'aéroport de Lienz-Nikolsdorf donne une variation de  
0.0000239° pour la Latitude et 0.0000383° pour la Longitude pour un écart Nord/Sud ou Ouest/Est 
de 1 pixel. 
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Normalement, les déplacements et rotations pour positionner et orienter l'aéroport se réalisent 
uniquement dans Landscape Editor, en s'aidant des textures de la scène et de l'affichage des 
élévations au zoom de 10.67, pour que la trame de 30 m soit affichée. Et 30 mètres font 11 pixels. Le 

bon réglage s'évalue donc 
facilement et en 3 itérations 
le positionnement doit être 
parfait. Quant à 
l'orientation, il faut choisir le 
meilleur compromis à 1 
degré près. N'oubliez pas de 
sauvegarder vos réglages 
successifs par "File -> Save 
Landscape". Attention avec 
la perte de compatibilité 
lorsque vous changez le 
fichier "Apt" ou la 
"Heightmap", sans oublier 
les fichiers HTA contre la 
triche. 
 
Pour AA2, où les textures ne 
peuvent pas être affichées, il 
faut procéder de façon 

légèrement différente, c'est 
un peu plus long. 
Tout en gardant Landscape 

Editor ouvert au zoom de 10.67 sur Lienz-Nikolsdord, il faut ouvrir Condor 2, et créer un circuit au 
départ de Lienz-Nikolsdorf avec un départ en vol à 1500 m. F2 pour avoir une vue hors du planeur. 
Placez-vous au-dessus du planeur et éloignez-vous du planeur et zoomez pour minimiser la taille du 
planeur et prenez une photo. 

Visualisez la photo, optimiser d'abord 
l'orientation en changeant la valeur dans 
Landscape Editor, jusqu'à obtenir une valeur 
satisfaisante. Réitérer le vol dans Condor 2, 
et prendre une photo dans la même 
position. 
 
Ouvrez la photo dans Photoshop, ou votre 
logiciel 2D préféré. Tracez l'axe de la piste. 
Positionnez cet axe sur un point 
remarquable, en l'occurrence le centre du 
cercle où se trouve la manche à air. Ce 
cercle fait très exactement 15 m de 
diamètre. Faites une copie de l'axe. Faites 
tourner un axe de : -121° (+121° est la valeur 
retenue pour l'orientation de la piste dans 
Landscape Editor). Faites tourner le 
deuxième axe de : -(121°-90°), soit 

 -31°. Les deux axes sont alors orientés 
Nord-Sud et Est-Ouest. 

Figure 127 - Estimation des corrections/Estimated corrections. 

Figure 126 - Réglage de la position de Lienz-Nikolsdorf/Adjusting the position of 
Lienz-Nikolsdorf. 
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Zoomer pour agrandir le cercle. Repositionner éventuellement les axes. En déduire la correction à 
faire. 
 
 
Il faut donc diminuer la Latitude de : 
2.24 x 0.0000239 = 0.0000535° 
 
et augmenter la Longitude de : 
2.0 x 0.0000383 = 0.0000766° 
 
Une fois les corrections effectuées, il faut vérifier sur l'ensemble de la zone aéroportuaire que l'on a 
trouvé le bon compromis, par un nouveau vol dans la scène, car des arrondis dans les valeurs sont 
introduits par Landscape Editor. 
 
Sinon, il faut reprendre les réglages de positionnement. 
Le meilleur compromis devrait être trouvé en 3 itérations, car, outre les arrondis sur les valeurs 
calculées, il ya toujours des petites erreurs dans la modélisation. 

Réglage de l'altimétrie 

Le réglage de l'altimétrie suppose de choisir une valeur adaptée au décollage du planeur le plus lourd 
pour le maximum de remorqueurs. Or, à ce stade de l'intégration de l'aéroport, aucun remorqueur 
n'a été validé comme pouvant être utilisé en toute sécurité et sans restriction.  
 
De plus, l'intelligence artificielle qui prend le contrôle du remorqueur dès qu'il a atteint 100 m AGL 
suit deux buts successifs précis. Le premier, c'est de vous amener le plus directement possible sur le 
TP de départ, puis une fois que ce TP est atteint de vous emmener sous le cumulus le plus proche se 
trouvant au vent. C'est la pratique standard en plaine pour des pilotes débutants, qui, s'ils n'arrivent 
pas à accrocher une ascendance, sont ramenés par le vent au TP de départ qui est très souvent 
proche de l'aéroport. Mais ce processus n'est pas très bien adapté aux aéroports se trouvant en zone 
montagneuse. Ce point devra être intégré dans le processus de qualification en créant des circuits de 
test avec des TP de départ sur la montagne la plus proche de la piste, pour vérifier que le remorqueur 
ne se trouve pas trop prés de la paroi rocheuse au moment où il atteint 100 m AGL et que 
l'évitement se fait normalement par l'Intelligence artificielle. 
 
Normalement, le réglage adopté pour l'orientation sur la base des données OSM ou des photo-
satellites projetés en UTM est le bon réglage, car l'orientation donnée à l'aéroport résulte de 
l'expérience de la vie réelle.  
 
Pour un premier choix de l'altimétrie, nous avons 4 options primaires : 
- Utiliser l'altitude officielle répertoriée par l'OACI et qui devrait être celle entrée dans les propriétés 
de l'aéroport dans Landscape Editor. 
- Utiliser la moyenne, entre le point le plus élevé et le point le plus bas de la piste dans Landscape 
Editor. 
- Choisir l'altimétrie du point de départ du planeur à 200 m de l'extrémité de la piste dans Landscape 
Editor. 
- Utiliser le point le plus élevé de la piste. 
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Toutes ces options ont leurs avantages et leurs inconvénients. Le choix de l'altimétrie du départ du 
planeur est le moins destructif pour l'altimétrie environnante pour un premier aplatissement limité 
au décollage du planeur et éventuellement au stationnement du remorqueur. 
 
Les schémas 13 et 14 avec leurs tableaux de résultats dans la première partie du Guide vont pouvoir 
vous aider à décider de l'altitude du premier aplatissement limité. 
 
La surface concernée par le premier aplatissement au vu des tableaux, si l'on ne teint pas compte du 
Piper Super Cub, est de l'ordre de 270 x 60 m autour de l'axe de la piste en partant du départ du 
planeur, et sa réciproque dans l'autre sens de décollage (figure 128). 
 
Le but de ce premier aplanissement, c'est d'avoir une longueur suffisante pour décoller le Duo Discus 
à pleine charge (750 kg) avec la plupart des remorqueurs. 

Méthode pour l'Aplanissement des surfaces dans Landscape Editor 

- Ouvrir Landscape Editor. 
- Cocher "HeightMap". 
- Avec l'outil "Main", déplacez la carte vers l'endroit désiré. 
- S'il s'agit d'aplanir un aéroport, cochez "Airports", et les 3 cases du bas, "Draw Name" (Afficher les 
Noms), "Draw Surfaces" (Dessiner les zones de surfaces du fichier G), "Draw objects" (Dessiner les 
bâtiments du fichier O). Par un L/G sur le nom de l'aéroport dans la fenêtre d'affichage des aéroports 
celui-ci apparaît en surbrillance. Alors il est dessiné en fil de fer dans Landscape Editor. Notez qu'il 
s'agit toujours de la même représentation des fichiers G et O que vous obtiendrez dans Object Editor 
avec l'option "Wireframe" (Fil de fer). 

Figure 128 - Premiers aplanissements/First flattening. 
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- Zoomer jusqu'au facteur de zoom 10.67, afin que le maillage original de 30 m soit affiché. Dans 
Landscape Editor, l'altimétrie en mètres est affichée sur, ou tout près, de l'intersection de la trame 
verticale et horizontale du maillage. Avec l'outil Main sélectionné, un L/G sur la carte augmente le 
facteur de zoom, et un R/D le diminue. 
- Par précaution, faites des captures d'écran pour couvrir la zone à modifier en gardant le facteur de 
zoom de 10.67. 
- Mettre "Height map" en surbrillance par un L/G. L'outil d'aplanissement apparaît. L/G sur le bouton 
"Flatten" fait apparaître les 3 options disponibles : 

- "Radius" (Rayon) : Réglage du rayon du cercle autour du réticule par le curseur entre 1 et 100 
points. Au zoom de 10.67, adopter 30 pts pour changer individuellement chaque hauteur. 

- "Altitude" : Valeur en mètres de l'altitude finale de l'aplanissement. 
- "Edge slope" (Pente d'adaptation) : Réglage d'adaptation des altitudes entre l'altitude finale 

et la topographie initiale. Six réglages sont disponibles : 1:0, 1:1, 1:2, 1:3, 1:4, 1:5. Avec 1:0 il 
n'y a pas d'adaptation et, au fur et à mesure que l'on passe à un réglage plus fort, le rayon du 
deuxième cercle entourant le cercle autour du réticule augmente. Le logiciel étage les 
altitudes entre le cercle autour du réticule et le cercle extérieur. Adoptez 1:0 lorsque vous 
commencez à aplanir le terrain. Il sera toujours temps après visualisation dans la simulation 
d'utiliser cette forme d'intégration dans le paysage par adoucissement des pentes. 

 
- Régler votre outil sur l'altitude que vous souhaitez obtenir. 
- Utiliser l'outil "Flatten" : dès que vous êtes sur la carte, le réticule et les deux cercles apparaissent. 
Un L/G maintenu permet de modifier l'altimétrie lors du déplacement de la souris. Tous les sommets 
du maillage se trouvant à l'intérieur du premier cercle qui sont survolés par l'outil sont modifiés et 
adoptent l'altitude réglée et tous les sommets se trouvant entre les deux cercles sont adaptés pour 
adoucir la pente avec la topographie environnante. 
 

Figure 129 - L'outil "Flatten"/"Flatten" Tool. 

 
- Une fois les modifications d'altitudes effectuées, Landscape Editor affiche les nouvelles valeurs, 
mais le fichier "Heightmap" n'est toujours pas modifié. 
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Il est encore temps de renoncer aux modifications si vous quittez Landscape Editor sans sauvegarder 
la scène. Les modifications d'altitudes risquent de rendre incompatible le vol multijoueurs, si les 
nouveaux réglages ne sont pas adoptés par les autres participants du vol et le serveur. 
- Pour rendre les modifications d'altitudes définitives voici comment il faut procéder : 
"File -> Save Landscape", et L/G sur "OK" dans la boîte de dialogue "Info : Landscape saved". 
Mais il faut aussi mettre à jour le fichier "THA" anti triche par : 
"File -> Export terrain hash (THA)" puis, L/G sur "OK" dans la boîte de dialogue "Info : THA exported", 
à la fin du processus lorsque la barre de progression se ferme. Si nécessaire, ajuster l'altitude de 
l'aéroport dans ces propriétés, à celle choisie pour l'aplatissement et sauvegarder à nouveau la 
scène.  

Tests de validation des remorqueurs  

Contrairement à ce qui s'est déjà écrit, il faut utiliser indifféremment tous les remorqueurs dans les 
tests de validation. 
 
Le but de ces opérations est de fournir un NOTAM "Notice To AirMen" (Notes aux Aviateurs) précis 
pour chaque aéroport, afin que les organisateurs de vols puissent créer des circuits fiables au départ 
de l'aéroport. 
 
En plaine, il y a très rarement des problèmes pour qualifier tous les remorqueurs. 
 
En montagne du point de vue statistique après l'adaptation de l'aéroport on obtient les résultats 
suivant : 
Wilga : 100 % 
Zlin : 90% 
DR400 :70% 
Pour les autres remorqueurs, les résultats sont variables et parfois aléatoires. Il est même plus facile, 
pour un aéroport alpin, de qualifier le Super Cub que le DR400. 
 
La zone minimale qui recouvre les deux secteurs de 270 x 60 m étant aplanie à l'altitude choisie et 
enregistrée dans Landscape Editor, ouvrir Condor 2 et créer un circuit au départ de l'aéroport avec 
un TP de départ dans la montagne la plus proche de la piste, pour tester la bonne réaction de 
l'intelligence artificielle après le passage des 100 m AGL. Le réglage météo est le suivant : vent nul, 
activité thermique nulle, tous les autres paramètres sur "None" (nul) ou "weak" (faible). Inversion 
basse en dessous de la formation des cumulus. Tous les paramètres pour l'onde sont mis à zéro. 
Choisir le planeur dont le "Max weight" (Poids Maximum) est le plus élevé, c'est le Duo Discus avec 
ces 750 kg les ballasts pleins et le deuxième pilote. Le Notam avec toutes les cases cochées, et le 
remorquage à 700 m avec une corde de 50 m de longueur. 
Sauvegarder ce plan de vol, sous un nom approprié. 
Lancez le vol dans Condor 2. 
Normalement, vous devez vous trouver au début de la partie de la piste aplatie avec un remorqueur 
presque à la même altitude.  
Lancez le démarrage du vol. Le remorqueur se déplace à l'horizontale à partir de l'altitude de son 
point de stationnement. Vérifier que le remorqueur se trouve bien à la même altitude que la piste. 
Normalement vous devez avoir décollé le planeur dans la zone aplanie. Ne rentrez pas le train 
d'atterrissage. Ne vous inquiétez pas si le remorqueur s'enfonce dans la piste ou la survole. Après le 
décollage, le remorqueur émergera à un moment ou à un autre, ou vous le rejoindrez son altitude à 
un moment ou à un autre en l'air. 
Ensuite, si le remorqueur en vol s'enfonce à nouveau dans la montagne avant d'atteindre les 100 m 
AGL et qu'aucune manœuvre d'évitement ne permet d'éviter le crash du planeur, il faut seulement 



Version 1.0 fr - 2019-09-16  Page 111/134 

Aéroports pour Condor 2 - Guide de Construction  Xavier Delaborde © 2019 

changer de remorqueur et observez ce qui se passe avec chaque nouveau remorqueur jusqu'à ce que 
le Wilga soit sélectionné. 
 
Dans ce cas, observez avec plus d'attention, ce qui se passe soit l'on passe les 100 m AGL, soit on 
reste dans une situation d'échec similaire.  
 
Si l'on ne passe pas avec le Wilga les 100 m AGL, il faut analyser la situation avec les résultats 
précédents pour trouver la solution la moins pénalisante, qui, de fait, est très souvent l'allongement 
de la piste dans Landscape Editor. En effet si vous allongez la piste de 200 m le départ du planeur va 
reculer de 100 m, mais le toucher des roues du remorqueur à l'atterrissage va aussi reculer de 100 m 
ainsi que la zone de stockage des planeurs en attente sur la piste avec le mode multijoueurs. 
L'allongement de la longueur de la Piste dans Landscape Editor peut facilement être porté jusqu'à 
400 m. Dans ce cas, le départ du planeur se fait sur le seuil de la piste du fichier G, ou plus loin s'il y a 
des prolongations de piste. De manière plus radicale, si la difficulté ne concerne qu'un sens de 
décollage, il faut décaler dans Wings 3D le centre de la scène, tout en restant dans l'axe de la piste. 
Cela obligera à refaire les fichiers G et O de l'aéroport. En ce qui concerne les autres possibilités, ne 
dépassez pas 30 m en décalage latéral, 20 m en altitude, et 3° en orientation de la piste. Tout cela 
vous obligera certainement à compléter l'aplatissement de base. Une fois l'obstacle des 100 m AGL 
passé, il faut continuer pour savoir si la réponse de l'intelligence artificielle est correcte, et appliquer 
éventuellement les mêmes recettes que précédemment pour franchir ce deuxième obstacle de la 
qualification. 
 
Pour les tests de décollage dans le sens opposé de la piste, éviter de mettre du vent et changer plutôt 
l'option "Primary dir Reversed" dans Landscape Editor. Corriger jusqu'à obtenir la qualification d'un 
remorqueur, en appliquant éventuellement les mêmes recettes, pour les deux sens de la Piste. 
 
Un test équivalent existe en ajoutant un vent de travers de 20 km/h en direction de la paroi de la 
montagne la plus proche, car le remorqueur dérive avec le vent, mais sa montée est accélérée par les 
ascendances de pente. L'un et l'autre des tests proposés avec ou sans vent de travers sont valables. 
 
Même si le tableau qui vient d'être dressé peut paraître complexe, une solution pour un ou plusieurs 
remorqueurs sera vite trouvée si l'on suit l'ordre logique de la manière de corriger les difficultés 
rencontrées. Dans plus de 80% des cas, il n'y aura rien à modifier pour qualifier au moins deux 
remorqueurs. 
 
Pour Lienz-Nikolsdorf, aucune modification n'a été apportée aux réglages initiaux pour qualifier tous 
les remorqueurs à l'altitude de référence de 640 m. 

Optimisation de la longueur de la piste dans Landcape Editor 

Si, comme pour Lienz-Nikolsdorf, tous les remorqueurs sont qualifiés, il faut envisager très 
sérieusement de réduire la longueur de la piste dans Landscape Editor, car il faut tenir compte de la 
zone de stockage des planeurs lors des vols multijoueurs. De plus, et pour n'importe quel autre 
aéroport, pour éviter de refaire les tests de décollage il est préférable de partir de cette valeur, quitte 
à l'allonger ensuite en cas de difficultés. 
 
Les surfaces d'aplanissement les plus faibles dans l'axe de la piste sont obtenues avec une piste de 
400 m de longueur dans Landscape Editor. Dans ce cas, quel que soit le sens de décollage, le planeur 
en instance de départ se trouve au centre de la piste, et il aura devant lui toute la zone aplanie de 
stockage des planeurs prévue pour le décollage dans l'autre sens. 
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L'évaluation de la zone de stockage peut se faire de la manière suivante, pour un "joint time" (Durée 
d'accès au vol multijoueurs) de 10 minutes. Un décollage est initié toutes les 30/35 secondes, mais 
cette durée est variable. Elle peut dépasser la minute pour les remorqueurs éloignés du départ. En 10 
minutes, 20 planeurs peuvent être mis en l'air, et il en reste 44 à faire décoller qui doivent donc être 
stocké au sol au moment de la fermeture du "Joint -time". Sachant que les planeurs occupent 10 m 
linéaires dans la queue de stockage, il faut au moins 440 m de zone de stockage. 
 
Pour un "joint time", de 15 minutes, 30 planeurs auront décollé et les 34 planeurs restants devront 
être stockés sur 340 m. Pour un "joint time" de 20 minutes 40 planeurs auront décollé et les 24 
planeurs restants vont occuper une ligne de stockage de 240 m. 
 
Comme il peut y avoir des instants pendant lesquels la queue de décollage est vide, et qu'il n'y a pas 
toujours 64 planeurs dans chaque vol multijoueurs, il nous semble raisonnable d'adopter une zone 
de stockage de 360 m (12 x 30 m pour l'aplanissement), avec un "joint time" de 15 minutes pour les 
vols journaliers et 20 minutes en compétition, soit aplanir sur 720 m dans l'axe de la piste, sur une 
largeur minimale de 60 m (2 x 30 m). 
 
En se référant aux expérimentations de la figure 13, sur les 360 m le planeur le plus lourd aura 
décollé avec tous les remorqueurs sauf le Super Cub. Mais seul le Wilga pourra décoller sur cette 
distance. 
 
Donc pour les pistes les plus courtes en montagne un choix standard possible est de fixer à 400 m la 
longueur de la piste avec un aplanissement minimum de 720 m (2 x 360 m) pour le stockage des 
planeurs. Si ce n'est pas possible, il faudra indiquer les restrictions correspondantes dans le Notam. 
 
Mais même avec une piste courte, si l'on peut étendre l'aplanissement dans l'axe de la piste sans 
trop déformer la topographie environnante on a tout intérêt à augmenter la longueur de la piste 
dans Landscape Editor. 
 
Au contraire, si la piste dessinée avec le fichier G est longue on a tout intérêt à confiner les 
aplanissements dans cet espace, si bien évidemment cela ne réduit pas le nombre de remorqueurs 
qualifiés. 
 
Ou, si la piste présente une particularité qui impose le départ du planeur sur une surface bétonnée il 
faut adapter la longueur de la piste de façon à ce que le départ se fasse au bon endroit. 
 
De façon très générale, voici les équations linéaires simples qui régissent les paramètres d'une piste : 
sachant que le planeur se trouve au départ à 200 m du seuil de piste (400 = 2*200 dans les équations 
ci-dessous). 
 
O, centre de la piste. 
S, point de stationnement du planeur au départ à 200 m du seuil de piste. 
 
L, longueur de la piste dans Landscape Editor. 
Z, longueur de la zone de stockage des planeurs. 
H, longueur de piste devant le planeur : H = L-200. 
U, (longueur totale à aplanir) : U = L + 2*Z - 400. 
F, longueur aplanie devant le planeur au décollage : F = L+ Z - 400. 
 
 
Qui correspond au schéma suivant. 
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Et au tableau de résultat suivant pour une longueur de stockage des planeurs de 360 m. 
 

L 0 100 200 300 400 500 600 700 800 900 1000 

Z 360 360 360 360 360 360 360 360 360 360 360 

H -20 80 180 280 380 480 580 680 780 880 980 

U 320 420 520 620 720 820 920 1020 1120 1220 1320 

F -40 60 160 260 360 460 560 660 760 860 960 

Toutes les valeurs sont exprimées en mètres. 
 
À comparer avec le tableau de la première expérimentation :  
 

Remorqueur/TowPlane OA OB OC 

DR400 190 390 1600 

Dynamic 260 450 1690 

Super Cub 370 670 2000 

Wilga 150 330 1450 

Z226 250 390 1500 

 
À partir de ces données, il est alors facile de déterminer quelle valeur optimale à donner pour la 
longueur L de la piste dans Landscape Editor. 
 
Pour Lienz-Nikolsdorf, afin de minimiser les zones à aplanir il suffirait de calculer L avec U égal au 
dessin de la piste en dur dans le fichier G, soit 630 m. 

Figure 130 - Schéma pour l'optimisation de la longueur de la piste/Diagram for optimization of the runway length. 



Version 1.0 fr - 2019-09-16  Page 114/134 

Aéroports pour Condor 2 - Guide de Construction  Xavier Delaborde © 2019 

630 = L +720-400 -> L = 630 - 720 +400 = 310 m. Cette valeur est un peu faible, et pour s'assurer que 
le Super Cub décolle avant la fin de la piste il faut une valeur de L de 700 m. Le choix initial de 660 m 
est donc validé, il suffit alors de s'assurer que la longueur de l'aplanissement U est supérieure ou 
égale à 980 m en appliquant la formule. Si, du côté de la piste NO il n'ya pas de problèmes, il faudra 
allonger l'aplanissement du côté SE d'environ d'une centaine de mètres, suivant le schéma (figure 
131). 

Figure 131 - Aplanissement à réaliser/Flattening to make. 

Finalisation de l'Aéroport 

Aplanissement final 

À ce stade de l'élaboration de l'aéroport, la position, la direction et l'altitude de l'aéroport sont 
définitivement fixées et il existe au moins un remorqueur de qualifié. 
 
Il est temps d'aplanir le sol à l'altitude fixée sur toute la zone aéroportuaire, c'est-à-dire la surface 
délimitée par les fichiers G et O et les surfaces de stockage des planeurs si elles sortent de la zone 
précédente. 
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Sachez qu'il faut considérer que tout point du maillage altimétrique à 30 m appartient aux 4 carrés 
de 30 m qui l'entourent. Si l'un de ces carrés contient une partie de la zone aéroportuaire en rouge 
lorsque l'aéroport est sélectionné dans Landscape Editor, le point de ce maillage doit être mis à 
l'altitude de l'aéroport. Pour éviter que des sommets de maillage soient oubliés, travaillez toujours 
avec un zoom de 10.67. 
 
Une fois cet aplanissement effectué, il faut vérifier dans un vol statique au sol et immobile en 
utilisant la touche F2 et en utilisant le zoom, que toutes les extrémités de l'aéroport sont bien à la 
bonne altitude et que chacun des bâtiments soit effectivement sur le sol. Pour les aéroports très 
étendus, parce que le maillage à 90 m est sous-jacent, il faudra probablement étendre 
l'aplatissement à des carrés sur une logique de 90 m au lieu de 30 m pour être certain que les 
bâtiments éloignés sont bien au sol, et que la piste en béton ne présente aucun défaut latéral ou en 
extrémité. Ses anomalies se signalent au ras du sol par des artefacts visuels, comme la disparition 
momentanée de la piste ou de l'herbe, ou l'impression de flottement d'un bâtiment vu sous un angle 
particulier, alors que, dans Landscape Editor, l'altitude requise est bien fixée à la bonne altitude. 
 
Cela demande une grande attention et doit être finalisé par un test de roulage pour la piste 
complétée de la zone de stockage si elle déborde. 
 
Pour effectuer ce test de roulage, lancez le remorquage, sortez les aérofreins et freinez à outrance 
pour que le remorqueur n'atteigne pas sa vitesse de décollage, afin de parcourir toute la piste et les 
espaces de stockage des planeurs. 
Si votre attention est attirée par un artefact pendant ce test, larguez le remorqueur, arrêtez-vous sur 
la piste et passez en vue externe et examinez les environs avec attention pour savoir ou vous devez 
aplanir ou élargir l'aplanissement en périphérie. 
 
Recommencez le test de roulage pour valider le reste de la piste et la zone de stockage des planeurs, 
autant de fois qu'il y aura des interruptions à cause de la découverte d'un artefact.  
 
Recommencez ces tests de roulage dans l'autre sens de décollage pour valider l'extrémité de la piste 
et de la zone de stockage non encore contrôlée.  

Définir les derniers paramètres de la piste 

Certaines propriétés de l'aéroport doivent être définitivement fixées dans Landscape Editor. Ce sont 
les 4 paramètres fixant le roulage du remorqueur sur la zone aéroportuaire: la largeur de la piste et 
les 3 cases à cocher. 
 
Commencez par choisir l’axe de la piste sans vent sur la base des résultats de la validation des 
remorqueurs. 
 
Pour les autres paramètres, seule l'expérimentation vous apportera une réponse adéquate: 
 
Utilisez un circuit à partir de Lienz-Nikolsdorf. Lancez le vol et larguez le remorqueur par R. Puis F5 
pour suivre le remorqueur dans ses évolutions. Il faut faire attention à la fin du vol du remorqueur 
lorsqu'il atterrit, puis déterminer quels sont les meilleurs choix en ce qui concerne la largeur de la 
piste et le stationnement du remorqueur à droite ou à gauche du planeur. 
 
N'oubliez pas de sauvegarder la scène. 
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Le contrôle des craquelures sur "Asphalt" et "Asphaltpaint" et la taille des touffes d'herbes 

sur "Grass" et "Grasspaint" 

Lorsque le fichier G a été créé, un UV Map et une première réduction de la Carte des Patrons a été 
réalisée sur les 4 textures de base. Maintenant, il s'agit de savoir s'il elles conviennent à la 
modélisation effectuée. Seul un vol statique vous permettra d'avoir une idée concrète de ce qu'il faut 
faire. A priori, il faudrait augmenter toutes les tailles de chaque texture, c'est dire diminuer l'échelle 
de la Carte du Patron. 
Ouvrir Wings 3D, et charger le fichier Lienz-Nikolsdorf. Dans "Geometry Graph" L/G sur Piste ou se 
trouve les 4 objets, "Asphalt", Asphaltpaint", "Grass" et "Grasspaint". 
Déverrouillez un premier objet et sélectionnez-le en mode Objet. 
Puis par le menu : "L/G sur Window -> L/G sur UV Editor ". La carte du patron de l'objet apparaît dans 
la fenêtre AutoUV. "R/D dans la fenêtre AutoUV-> L/G sur Scale -> L/G sur Scale Uniform". Déplacer 
la souris et diminuer l'échelle de 60% environ. R/D dans la fenêtre AutoUV -> L/G sur "Create 
Texture" -> L/G sur OK de la fenêtre "Draw Options" si rien n'a été changé. Fermez la fenêtre, 
verrouiller l'objet. 
Réitérer 3 fois pour les 3 autres objets. Sauvegarder le fichier Lienz-Nikolsdorf. 
 
Ensuite, déverrouiller les 4 éléments de Piste, sélectionnez-les en mode Objet, et par "File -> Export 
selected -> Wavefront, etc. Recréer un fichier Lienz-NikolsdorfG.c3d. Puis faire un vol statique pour 
vérifier votre travail. Les herbes "Grass" sont plus fournies,  
"Asphalt" est parfait, les craquelures sur "Asphaltpaint" sont peut-être un peu trop grosses. Le 
Grasspaint est manifestement plus fourni. 
 

 
Figure 132 - Asphalt & Asphaltpaint corrigés/corrected. 
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Figure 133 - Grass & Grasspaint corrigés/corrected. 

Si vous estimez, après une première correction, qu'un ou plusieurs éléments de la Piste ne sont pas 
encore corrects, il suffit pour les éléments concernés de changer à nouveau l'échelle de la carte de 
texture, et de refaire un fichier G, comme indiqué ci-dessus. Cela ne prend que quelques minutes. 

La sous-couche de l'aéroport 

Inévitablement, compte tenu de la résolution de 2.815 m/pixel de la tuilette t4570, il y aura des 
bavures autour de "Asphalt", des décalages entre la silhouette de l'aéroport sur la tuilette, et 
"Asphalt", car l'orientation de l'aéroport dans Condor n'a qu'une précision de 1°, sans compter les 
erreurs que nous produisons du fait même de la modélisation. Il y a même parfois des objets comme 
des avions sur le parking qui sont souvent indésirables. Ou même pour Lienz Nikolsdorf des 
aménagements autour de la piste en cours de réfection qui ont disparu. Tous ces éléments doivent 
être effacés. De plus, l'élément "Grass" n'est plus visible dès qu'on prend de l'altitude. Il faut donc 
s'assurer qu'il y a une sous-couche sous l'emprise de l'aéroport et ses abords qui règlent 
définitivement tous ces petits défauts. Des problèmes similaires s'observent aussi avec des textures 
synthétiques. 
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Figure 134 - Lienz-Nikolsdorf avant transformation de la tuilette t4570/Before changing the background of t4570 patch. 

 
Voici donc une technique, parmi beaucoup d'autres, pour remédier à ces petites imperfections : 
 

Figure 135 - Méthode de correction dans Photoshop/Photoshop correction Method. 

Faites d'abord une copie de la tuilette. Ouvrir la tuilette dans Photoshop, où nous allons effacer tout 
ce qui nous semble inutile. Créer un calque sur lequel nous allons appliquer les corrections. Ceci est 
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uniquement un exemple, car nous n'avons pas effectué le déplacement de l'aéroport dans sa 
position requise et calculée dans un des précédents chapitres, pour des raisons évidentes de 
compatibilité aux serveurs. 
 
Comme nous voulons éliminer toutes traces sur l'aéroport, nous créons un tracé fermé qui suit au 
plus près les contours des zones correspondants aux "Asphalt", "Asphaltpaint" et "Grasspaint" de 
l'aéroport et des parties que l'on souhaite changer. Ensuite, nous créons un motif avec une texture 
prise sur la tuilette d'un champ proche de l'aéroport et représentatif de la zone que nous venons de 
délimiter. Enfin, nous appliquons ce motif sur la surface du tracé sur le calque créé précédemment. 
Sauvegarde du fichier en PSD dans le dossier de création de l'aéroport et en DDS dans le dossier 
Textures de AA2. 
 
Un vol de contrôle statique nous montre le résultat obtenu. 
 

 
Figure 136 - Résultat de la transformation de la tuilette t4570/Result of the patch t4570 transformation. 

En une dizaine de minutes de travail, on obtient un résultat correct. 

Les forêts et les haies d'arbres et le WaterAlpha 

Dans ce paragraphe, nous allons rester plus théoriques que pratiques, car, le Maître des Forêts, des 
Objets et du WalterAlpa, c'est le concepteur de la scène. 
 
Pour rendre le niveau d'intégration de l'aéroport dans la scène encore plus vraisemblable, il faut 
effectivement créer la zone des forêts, les haies à proximité de l'aéroport, et, si besoin, les lacs, voire 
les fleuves et les rivières et torrents. 
 
Comme le WaterAlpha se travaille sur le même format que les tuiles Terragen au standard de 8192 x 
8192 pixels, il est facile de dessiner des torrents de 1 pixel de largeur en noir sur fond blanc. De plus, 
cela crée un effet argenté superbe dans les talwegs des montagnes, lorsque le planeur se trouve à 
une altitude inférieure au torrent. 
Toutefois, ces modifications vont augmenter la taille de chaque tuilette de 2731 ko à 5472 ko, ce qui 
aura une conséquence sur les FPS. Donc un test complémentaire sur le chargement de l'aéroport à 
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24 km doit être effectué pour valider ces transformations. La modification d'une tuile Terragen avec 
WaterAlpha se fait avec l'utilitaire de Jiri Brozek, comme expliqué sur les forums de Condor en 5 
minutes. 
 
Pour les haies d'arbres, qui sont des objets qui doivent rester aussi simples que possible, il faut 
n'utiliser que des arbres construits sur des dièdres transparents. À partir de ces arbres simples, à 
mettre dans le dossier World de la scène. On peut utiliser ces objets de façon unitaires, ou même 
créer des haies mixtes linéaires comme un objet, ou même des haies, par répétition le long de la 
courbe de la haie en déplaçant le pointeur de création avec un L/G maintenu directement dans 
Landscape Editor. Normalement, ces types d'objets qui se chargent à 5 km ne devraient pas trop 
modifier les FPS. 
 
Voici à titre d'exemple ce que l'on peut créer comme arbre-dièdre dans Wings 3D et dans Object 
Editor. 

Comme le montre la figure 137, les fichiers C3D doivent avoir le suffixe "_ns", pour que l'ombre des 
dièdres ne soit pas projetée dans la simulation. Le nom du fichier de cet exemple est : 
"A_He1_ns.c3d". 
 
 
Pour les forêts, le contexte est plus délicat à mettre en œuvre. On peut effectivement dans 
Landscape Editor, faire des corrections des 2 "Forest maps" et les sauvegarder. Pour des raisons 
difficilement explicables, nous avons rencontré des difficultés quant à la pérennité de ces 
modifications, à la suite d'une nouvelle modification. 
La tuilette correspondante autour de l'aérodrome a disparu et nous nous retrouvons avec un carré 
de 5.76 x 5.76 km vide de toute forêt. De plus, ce type de correction pour les textures synthétiques 
ne donne pas entière satisfaction, car la texture sous-jacente des forêts lorsque les arbres des forêts 
ne sont plus chargés dans la simulation n'existe pas. 
Pour toutes ces raisons, il est préférable de travailler directement sur les tuiles des "Forest maps" au 
format 8192 x 8192 pixels en utilisant une grille de 4 pixels, car ce format devra être réduit à 2048 x 
2048 pixels pour être transformé en carte des forêts. 
 
La grille avec un pas de 4 pixels permet de rectifier très précisément les tracés de la Carte des Forêts 
afin qu'ils n'empiètent pas sur les bâtiments, les pistes et taxiway de l'aéroport. 
De plus pour les textures synthétiques cela permet d'harmoniser la texture sous-jacente des forêts 
avec les autres composant de la scène. 
 

Figure 137 - Arbre-dièdre/Dihedral Tree. 
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Quoi qu'il en soit, après la recréation des cartes de forêts, il faudra pour valider l'ensemble de ces 
modifications effectuer à nouveau des tests de qualification des remorqueurs et un test de 
chargement de l'aéroport à 24 km. 

9/Améliorations. 

Nous avons enfin créé un aéroport dont toutes les caractéristiques sont au niveau requis pour 
Condor 2. Il s'agit maintenant d'améliorer l'aspect de celui-ci pour le rendre encore plus vivant et 
plus réaliste, si on le souhaite. 

Plus d'objets dans le fichier O ou dans le Dossier "World 

Nous avons au début de ce Guide examiné les avantages et les inconvénients de mettre des objets 
complémentaires dans le fichier O, ou de les garder comme des objets unitaires dans le dossier 
World de la scène. Notre préférence va évidemment pour cette dernière solution qui nous semble 
plus souple, et plus versatile. Ces objets doivent avoir été créés dans un modeleur 3D sous la forme 
de fichiers prêts à être fusionnés dans le format du modeleur, ou disponible sous le format 
Wavefront avec les fichiers ".obj" et ".mtl" de l'objet et accompagné de toutes leurs textures que 
vous pouvez facilement importer dans le modeleur. Dans ce cas, vous pouvez toujours modifier 
améliorer ces objets et créé à l'envie de nouvelles petites scènes et de nouvelles textures. 
Certains objets ne sont disponibles que sous le format C3d avec leurs textures et ne peuvent donc 
être utilisés que sous la forme d'objets unitaires dans le fichier World de la scène. Dans ce cas, vous 
pouvez seulement créer de nouvelles textures même si vous n'avez pas la Carte du Patron. 
Notez que vous pouvez toujours changer la taille en pixels et le format des fichiers de textures d'un 
objet. 

Plus d'objets dans le fichier O 

Dans le cas où vous opteriez pour cette solution totalement ou partiellement, voici comment 
procéder : 
 
Ouvrir Wings 3D et charger l'aéroport "Lienz-Nikolsdorf". Puis fusionner ces objets dans Wings 3D, 
avec leurs textures. Ensuite vous devez les positionner correctement en les déplaçant et en les 
faisant tourner (attention aux Objets de Scène). Dans "Geometry graph", déplacez ces objets dans le 
dossier "Hangar". 
Une fois que tout vous semble correct, et après avoir sauvegardé votre travail, il vous faut créer un 
nouveau fichier O en suivant le processus décrit précédemment. N'oubliez pas de placer une copie 
des textures de ces objets dans le répertoire "Airports/Textures/Lienz" de la scène. Un vol de 
vérification s'impose pour s'assurer que tout est correct. 

Comment utiliser Landscape Editor pour insérer des objets dans la scène. 

Comme la position, la direction et l'altitude de l'aéroport sont fixées, la probabilité est faible de 
devoir déplacer à nouveau les objets de l'aéroport provenant du répertoire "World/Object",. De 
toute façon on peut les déplacer tous ensemble à la suite à une sélection rectangulaire avec la souris 
dans Landscape Editor. 
Les fichiers des objets sont sous le format "c3d" et se trouvent dans le répertoire "World/Objects" de 
et leurs textures dans le répertoire "World/Textures" de la scène.  
Avec Object Editor, charger le fichier C3d de chaque objet du répertoire et vérifier, ou créer le 
chemin liant l'objet à ces textures. 
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Ouvrir Landscape Editor et charger la Scène. Tous les objets, y compris les instances d'un même objet 
sont répertoriés dans le fichier de la scène : "Nom_Scene.obj". 
 
Les objets sont toujours posés sur le sol, lorsqu'il est plat cela ne pose aucun problème. Lorsque le sol 
est pentu, vérifier qu'il n'y a pas de parties flottant dans l'air, si c'est le cas il faut lui adjoindre des 
fondations, et utiliser le suffixe "-ns", pour "no shadows" (pas d'ombrage) afin d'éviter des artefacts 
sur les ombres construites à la volée lors de la simulation. Même pour les scènes photo satellites il 
faut toujours utiliser le suffixe "_ns". 
Cochez "Airports" et "Ground Objects" 
Mettez "Airport" en surbrillance,et avec l'outil "Main" allez vers l'aéroport où vous voulez ajouter des 
objets (pour l'exemple Reichenbach dans WildAlps2). Mettez Reichenbach en surbrillance et cochez 
"Reichenbach" et les 3 cases à cocher "Draw" en bas du cadre. Reichenbach est dessiné en fil de fer 
rouge sur la carte. Mettez ensuite "Ground objects" en surbrillance. Le bouton "View" ne fonctionne 
pas, car Object Editor fait cela beaucoup mieux. Dans la liste déroulante "Objects", vous trouverez 
tous les objets ayant été placés dans le dossier "World" de la scène.  
 

Figure 138 - Insertion d'objets avec Landscape Editor/Inserting objects with Landscape Editor 

Choisissez un objet, par exemple le Grob103ID3PCO, un objet dérivé et totalement restructuré du 
Grob 103 disponible sur le site de Condor2. L/G sur le bouton point [.] et avec un L/G insérez l'objet à 
l'endroit désiré avec le curseur "en croix" sur l'herbe de l'aéroport. Changez la position avec l'Outil 
"croix", Changez la direction avec le grand curseur de "Dir" en bas. La taille peut être changée avec le 
grand curseur en bas. La molette de la souris permet d'ajuster l'angle à ± 1° lorsque le curseur est 
surligné par un cadre. Les petits curseurs "size" et "dir" accolés au bouton permettent de paramétrer 
la direction et la taille des objets que l'on insère avec des L/G successifs dans la scène, le même 
objet. 
Les autres boutons sont évidents à paramétrer et à utiliser. 
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Figure 139 - L'objet Grob 103 dans Condor 2/Grob 103 object in Condor2 

Lorsqu’un objet n'est pas sélectionné, il apparaît sous la forme d'un cadre noir englobant au lieu de la 
silhouette en fil de fer. 
Sauvegardez la scène par "File -> Save Landscape -> OK" et faites un vol de contrôle. 
 
De nouveaux tests de chargement à 24 km doivent être entrepris après chaque modification du 
fichier O, ou après avoir complété l'aéroport avec des objets du répertoire "World". 

Le mot magique "Muck" 

Si la texture de la piste standard avec la texture "Asphalt" ne vous plaît pas, ou vous paraît trop 
uniforme, d'une seule couleur, sans traces de fissures profondes ou de réparations, ou de traces de 
pneumatiques, si vous voulez changer la couleur d'une partie des "Asphaltpaint", le "Muck" (La 
Fange) est fait pour vous. Et votre créativité n'aura plus de limites avec un peu d'imagination. 
 
On peut créer ses propres textures pour les éléments "Asphalt", "Asphapaint", "Grass" et 
"Grasspaint", mais il faut alors remplacer les textures initiales en gardant les mêmes noms par des 
textures de votre cru dans le répertoire "World/Object" de Condor 2. Cela fonctionne, mais c'est ce 
priver des toute la souplesse et la versatilité de "Muck".  
 
D'autres créateurs de scène ont essayé, en utilisant des techniques issues de Condor 1, d'indiquer 
des emplacements de textures pour des textures pistes sans utiliser le suffixe "_muck" et cela n'a pas 
fonctionné. Leurs textures ont été ignorées et remplacées par les textures standards. 
 
Comme sur les forums de Condor tous ceux qui ont utilisé cette technique n'ont donné que des 
renseignements succincts et partiels, nous nous sommes livrés à quelques petites expérimentations 
afin de cadrer l'utilisation de cet excellent artifice. 
 
Condor 2 prend en compte, avec le suffixe "_muck", tous les formats de textures BMP, TGA, PNG et 
DDS, supportés par Condor 2. Les formats PNG et DDS sont à privilégier. Quelles que soient les 
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modifications de couleurs ou de textures apportées, "Muck" garde en surimpression les craquelures 
sur les objets "Asphalt" et "Asphaltpaint" et les touffes d'herbe sur les objets "Grass" et "Grasspaint". 
 
 
 

Figure 140 - Asphalt Texture. 

La meilleure solution, pour avoir différentes teintes ou textures sur les éléments du fichier G, c'est de 
créer pour chaque teinte ou textures un îlot à l'échelle voulue, lors du dépliage et de l'arrangement 
de la Carte du Patron (UV Map). Cela vous évitera des effets de bord lors de la simulation. 
 
Si vous êtes amené, pour certains éléments "Aspahlt" ou "Asphaltpaint", etc., à changer la taille d’un 
ou plusieurs îlots, ou à les découper sur vos Cartes du Patron il faut recréer les Cartes de Textures 
dans Wings 3D et rendre externes les nouvelles Cartes de Textures, en repassant en "Internal" si 
nécessaire. Il faut aussi recréer un nouveau fichier G. 
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Figure 141 - Création des traces sur Asphalt/Creating Traces. 

 
Une fois que vous avez accès aux nouvelles textures "Asphalt" et "Asphaltpaint" en PNG ou DDS, 
ouvrez celles-ci dans Photoshop. 
 
Ensuite sur la piste et sur les aires de stationnement où nous voulons créer des différences il faut 
réaliser des tracés puis les peindre dans les couleurs que vous souhaitez sur un calque ou 
directement au pinceau, ou appliquer des textures de votre choix.  

 
 
 
Pour éviter des effets de bord noirs 
indésirables comme ceux de la figure 142 :  
 
Il faut aussi ajouter une sous-couche 
intermédiaire pour donner une couleur de fond 
à notre nouvelle texture dont voici les 
paramètres. 
 
Une sous-couche blanche restitue exactement 
la couleur d'origine de la texture "Asphalt". 

Plus on assombrit la couleur de la sous-couche, plus les éléments "Asphalt" deviendront sombres. 
Bien évidemment on peut mettre n'importe quelle couleur ou une texture pour faire des pistes sur 
sable ou sur cendrée. 
 

Figure 142 - Effets de bord/Side effects. 



Version 1.0 fr - 2019-09-16  Page 126/134 

Aéroports pour Condor 2 - Guide de Construction  Xavier Delaborde © 2019 

Voilà à quoi doit ressembler la texture finalisée pour "Asphalt", en conservant la teinte initiale, pour 
la piste 

Figure 143 - Asphalt Texture Finale/Final Asphalt texture. 

 
que nous sauvegardons en PSD, puis en PNG dans le répertoire et sous le nom 
AA2/Airports/Textures/Lienz/Asphalt_muck.PNG. Mais tout autre nom conviendrait si le suffixe 
"_muck" est présent. 
 
Ensuite, nous opérons exactement de la même manière pour "Asphaltpaint" après avoir repéré les 
deux bandes de délimitation de l'entrée sur la piste que nous souhaitons peindre en jaune.  
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Figure 144 - Texture pour Asphaltpaint/Asphaltpaint Texture. 

Cette nouvelle texture sera sauvegardée en PSD, puis en PNG dans le répertoire et sous le nom 
AA2/Airports/Textures/Lienz/Marques_muck.PNG. Mais tout autre nom conviendrait si le suffixe 
"_muck" est présent. 
 
Avec Object Editor, ouvrez le fichier c3d : "Lienz_NikolsdorfG.c3d" et nommez avec leurs chemins 
d'accès les nouvelles textures créées pour "Asphalt" et "Asphaltpaint". 
 
Comprenez que vous pouvez faire tout ce que vous voulez si vous suivez les conseils ci-dessus pour 
tous les éléments au sol du fichier G. Pourquoi pas des fleurs sur "Grass" ou des rayures bleues sur 
"Grasspaint" ou des taches d'huile comme élément "Asphaltpaint" etc.! 
 

 
Figure 145 - Lienz-Nikolsdorf modifié/changed. 
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Sauvegarder le fichier dans le dossier "Airport", mais n'oublier pas de rajouter manuellement le 
suffixe ".c3d" et de vérifier ensuite que tout est correct en rechargeant "Lienz-NikolsdorfG.c3d" dans 
Object Editor. Non seulement vous devez voir les modifications de teinte de "Asphalt", mais aussi les 
bandes jaunes ajoutées sur "Asphaltpaint". 
 
Voici le résultat dans Condor 2 : 

Figure 146 - Lienz-Nikolsdorf terminé/finished. 
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Figure 147 - Lienz-Nikolsdorf terminé/finished 2. 

Lienz-Nikolsdorf est terminé. 
 
Pour terminer, voici ce que donnent des pistes plus sombres dans la simulation : 
 

 
Figure 148 - Lienz-Nikolsdord avec des pistes plus sombres/with darker runways.  

 
Dans ce livret, nous avons abordé toutes les techniques principales de base permettant de créer un 
aéroport dans Condor 2. Votre créativité et votre imagination, à partir de ces techniques, vous 
permettront d'aller encore plus loin dans l'amélioration du rendu visuel des aéroports dans Condor 2. 
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Annexes 

Notes aux correcteurs, traducteurs et lecteurs 

Ce document a été conçu, dès le départ, pour faciliter sa traduction dans toutes les langues. La version anglaise 
a été écrite en même temps que la version française. Toutefois, seul le texte français fait foi. L'anglais n'est pas 
notre langue maternelle, et des erreurs ont pu être laissées malgré le soin apporté à la traduction et toutes les 
corrections sont bienvenues. 
Toutes les légendes des figures sont bilingues, Français/Anglais, lors de la traduction il faut traduire la partie 
française et conserver la partie anglaise. 
 
Beaucoup de mots sont écrits en majuscule dans le corps du texte. Il faut garder ces majuscules, car elles 
correspondent à chaque fois à un élément de l'aéroport, ou à un élément du logiciel qui subit une 
transformation ou encore à une commande d'un des logiciels utilisés. Dans le cas contraire, le mot est 
généralement en minuscule, sauf si la typographie ou la grammaire l'exige. 
 
Toutes les séquences de construction sont écrites avec des abréviations conventionnelles qu'il faut respecter, 
particulièrement pour les clics et mouvements de la souris L/G, R/D, etc., et le signe "->". Les séquences 
utilisent les notations (mots, sigles, abréviations, etc..) de la version anglaise des logiciels, sauf exception. Il faut 
donc impérativement garder ces séquences en l'état lors de la traduction. La plupart de temps, elles sont 
placées entre guillemets. Lorsqu'elles sont rencontrées les premières fois ou lorsqu'on a considéré qu'elles ont 
été oubliées, une traduction en français adapté au contexte est indiquée entre parenthèses, à la suite ou en 
dessous de la séquence. Cette traduction doit être adaptée dans la langue où est traduit le document, comme 
les commentaires ou compléments d'information en français dans les séquences. Pour éviter des confusions 
lors de la traduction, utilisez en parallèle les deux versions, française et anglaise, ouvertes simultanément. 
 
Dans le chapitre "Avertissement", seul le texte français doit être conservé, accompagné de la traduction dans la 
langue où sera écrit ce guide. 
 
Les noms des traducteurs, correcteurs, etc. doivent être ajoutés au bas de la page sous la rubrique 
"Remerciements". 
 
Si lors de la lecture ou lors de la traduction de ce guide vous trouvez des erreurs, anomalies, etc., veuillez nous 
les signaler dans le forum international. 
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